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1 Help Videos on YouTube

Y ou can view webinars and how-to videos on many of the functions within
ICM on YouTube.

e Li nk to our YouTube Channel.
e Li nk to our Webinar Archives on YouTube.

1 Help Videos on YouTube



1 Help Videos on YouTube



2 Reference Guide

Chapter Contents:
| CM Browser Reference CGuide
| CM Browser - Pro Reference CGui de

Activel CM Ref erence Guide - Create 3D Mol ecul ar Docunents for the Wb
and Power Poi nt

Menu and Tab Reference Guide:
Menu Option CGuide
Tab CGui de

2.1 Graphics Reference Guide

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
|I CM Chemi st || CM Pro

For instructions on how to use ICM-Browser to make fully-interactive
3D slides and publish them in PowerPoint and the web please see the
Acti vel CM User Cui de. ActivelCM isafree plugin for Windows
PowerPoint and web browsers. Other related tutorialsinclude:

e Graphical Display: Mlecule Representation, Coloring, Labeling
and Annot ati on

e Graphical Selections Tutori al

e Creating Fully Interactive Slides for PowerPoint and the Wb
Tut ori al

2.1.1 Download and Install ICM-Browser

Getting Started: Download and Install
ICM-Browser and Activel CM.

Download ICM-Browser Distribution. Downl oad vi deo
Install ICM-Browser Instructions. V'v\ggdows Li nux

Download Activel CM Distribution. Downl oad vi deo

W ndows Li nux

Install Activel CM. VEC

2.1.2 How to use the Graphical Display

"; winRef.document.write(str); }

How to use the Graphical Display

2 Reference Guide



How to search the PDB. g%aleu vi deo
How to Move a Structure in the Graphical HTML GUI vi deo
Display. Manual

How to use the Graphics window controls. g'r\]/t a|GU|

How to use the ICM Workspace Panel @m}alGUI vi deo
How to Display aMolecule. g%alGUI vi deo
How to Change Protein Representation. g% a|GUI vi deo
How to Change Ribbon Representation. g% alGUI vi deo
How to color wire or xstick carbon atoms. E% a|GUI vi deo
How to Display the Residues Surrounding the HTML GUI vi deo
Ligand Binding Pocket. Manual

How to remove chain breaks (dotted lines). g% alGUI vi deo
How to Color. @%alcu vi deo
How to Change the Color of Molecule HTM. GUI vi deo
Representations. Manual

How to Change the Background Color. mm] alGUI vi deo
How to Display a Binding Pocket Surface g%alcu vi deo
How to (Un)Display Hydrogens. Q%m&” vi deo
How to Save an ICM Object. @%alcu vi deo
How to Save an ICM Project File. HN.I%aFU' vi deo
How to Drag and Drop. w%alGJl

How to: Right Click Options. w% alGUI

How to Move Windows. w%aIGUI vi deo

2.1.2 How to use the Graphical Display




HTML GUI

How to Arrange Windows Manual vi deo
2.1.3 How to make Graphical Selections
How to M ake Selections. HTML GUI Manual
How to Select an Object HTML GUI Manual vi deo
How to Select aMolecule HTML GUI  Manual vi deo
How to Select Residues HTML GUl Manual vi deo
How to Select Atoms HTML GUI Manual vi deo
How to Make a Spherical Selection. HTML GUI Manual vi deo
How to Invert a Selection. HTML. GUI Manual vi deo
How to Remove a Selection. HTML. GUI Manual vi deo
How to Change the Selection Level and Mode. HTML GUI  Manual vi deo
How to Check What is Selected. HTML GUI Manual
2.1.4 How to Convert Proteins, Display Hydrogens
and Ligand Binding Pocket.
Convert Protein, Display Hydrogens and Ligand
Binding Pocket.
How to Convert a PDB Structure into an ICM HTM. GUI .
Object. Manual vi deo
How to Display Ligand Binding Pocket. wrl\{talcu vi deo
How to Display Hydrogen Bonds. grl\]/t alGUI vi deo
2.1.5 How to change Graphics Effects
How to change Graphics Effects
How to display the FOG effect. HTML GUJ Manual vi deo
How to display side-by-side stereo. HTML GU  Manual
How to display Anaglyph stereo. HTML GU  Manual
How to toggle full screen mode. HTML GUI  Manual vi deo
How to adjust perspective. HTML GUI  Manual

2.1.3 How to make Graphical Selections




How to change the lighting. HTML GUI Manual vi deo

How to display sketch accents. HTML GUJ  Manual vi deo
How to display elegant ribbon and ligand HTML QUI Manual vi deo
sketch.

2.1.6 How to add Labels and Annotations

How to add L abels and Annotations

How to Label Residues. HTML QU Manual vi deo
How to Label Atoms. HTML QU Manual vi deo
How to Label Variables. HTML QU Manual vi deo
How to Display and Undisplay Sites. HTML GUI Manual
wmé?at'\i"o"’;]ks_a”d Display Sites HTM. GU Manual

How to Make and Display 2D and 3D Labels. HTML GUJ Manual vi deo

2.1.7 How to Make High Quality Publication

Images

How to Make High Quality Publication mages

How to Toggle High Quality Display HTML GUI Manual vi deo
How to Toggle Antialiasing. HTML GUI Manual vi deo
How to Copy Image to ClipBoard HTML GUI Manual vi deo
How to Write an Image. HTML GUI Manual vi deo
(ISIB\t/ivotr?s.UsetheAdvanced Write Image HTM. QU Manual vi deo
How to Add an Image to the ICM Photo Album. HTML GUI Manual vi deo

2.1.8 How to Superimpose Protein Structures.

How to Superimpose Protein Structures.

How to Superimpose Two or More Protein HTM. QU Manual

Structures. video

2.1.9 How to Measure Distances and Angles.

How to Measure Distances and Angles.

8 2.1.5 How to change Graphics Effects



HTML GU

How to Measure Distances Between Two Atoms. Manual vi deo
How to Measure Distances From One Atom to HTM. GUI vi deo
Many. Manual
How to Show Corresponding Distancesin Two HTML GUI vi deo
Objects. Manual

. HTML GUI :
How to Display the Ruler Bar. Manual vi deo

2.2 ICM-Browser-Pro Reference Guide

NOTE: ICM-Browser-Pro contains all the featuresin ICM-Browser. Click

her e for the ICM-Browser Reference Guide.

2.2.1 Download and Install ICM-Browser-Pro

Getting Started: Download and Install
ICM-Browser-Pro

Download |CM-Browser-Pro Distribution.

Downl oad

Install ICM-Browser-Pro.

W ndows Li nux

Mac
2.2.2 Graphics
Graphicsand Movie Making
HTM. GUI
How to generate the shadow effect. Vanual
. HTM. GUI
How to make a screenshot movie. Vanual
. . HTM. GUI
How to make a movie from a set of slides. Manual
How to move a molecule independently of the other HTM. GUI
display objects (Connect). Manual
2.2.3 Protein Structure Analysis
Protein Structure Analysis
How to calculate contact areas between molecul es. HTML GUI Manual
How to identify closed cavities. HTML GUI  Manual
How to calculate surface area HTML GUI Manual

2.1.9 How to Measure Distances and Angles.




How to generate interactive Ramachandran plots.

HTML GUI Manual

2.2.4 Surfaces

Surfaces
How to generate el ectrostatic and binding property HTM. GUI
surfaces. Manual
HTML GUI
How to connect and rotate/trand ate surface (mesh). Manual
HTML GUI
How to crop a mesh/surface. Manual
HTML GUI
How to save a mesh/surface. Manual
2.2.5 Superimpose Proteins
Superimpose Proteins
How to superimpose proteins based on 3D by visible HTML GUI
atoms, C-alpha, backbone or heavy atoms. Manual
How to superimpose multiple proteins based on aligned HTML GUI
residues.. Manual
2.2.6 Crystallographic Tools
Crystallographic Tools
How to contour electron density. HTML GUI Manual
How to display crystallographic cell. HTML GUI Manual
How to display crystallographic symmetry. HTML GUI Manual
How to convert x-ray density to agrid. HTML GUI Manual
2.2.7 Sequence Analysis
Sequence Analysis
- HTM. GUI
How to annotate an alignment - box and shade. Manual
- - HTM. GUI
How to annotate an alignment with text. Manual
. . . HTM. GUI
How to display secondary structure in an alignment. Manual
How to extract sequences from pdb files.

10

2.2.3 Protein Sructure Analysis




HTM. GUI
Manual
; HTML GUI
How to assign secondary structure. Manual
. . HTM. GUI
How to link sequence, alignments, and structures. Manual
How to save asimage, print, and delete sequences and HTML GUI
alignments. Manual
2.2.8 Plotting Tools
Plotting Tools
Make fully interactive colorful X-Y plots and HTML GUI
histograms with up to 4 dimensions. Manual
. . HTML GUI
Save plot and histogram as image. Manual

2.3 ActivelCM Reference Guide - Create
3D Molecular Documents for the Web and
PowerPoint

This guide is focused on how to make fully interactive 3D documents
for Windows PowerPoint and the Web. For more information on the other
featuresin ICM-Browser please seethe | CM Br owser User Gui de.

Creating 3D Documents Is Straightforward

Creating fully interactive 3D documents for PowerPoint, the web, and
standalone browser is straightforward.

1. Downl oad ICM-Browser and the Activel CM plugin. They are completely
free! [vi deo]

2. Open the ICM-Browser and make a series of animated
fully-interactive slides showing different colored and rendered
views of your molecules. [vi deo]

3. Add hyperlinked HTML t ext to annotate and link to your slides.

[vi deo]

4. Saveyour filein ICM-Browser and then insert into Power Poi nt or
theweb using the Activel CM plugin. Y ou can also share your
documentsin the standalone ICM-Browser. [vi deo - power poi nt ]
[vi deo -web browser]

"; winRef.document.write(str); }

2.3.1 Getting Started

Getting Started: Download and Install
ICM-Browser and Activel CM.

Download |ICM-Browser Distribution. Downl oad

vi deo

2.2.7 Sequence Analysis

11




Install ICM-Browser Instructions.

W ndows Li nux
Mac

Download Activel CM Distribution. Downl oad vi deo
- W ndows Li nux
Install ActivelCM. VBC
2.3.2 How to Create a Series of
Fully-Interactive 3D Slides.
Creating Slides How to Create a Series of vi deo
Fully-Interactive 3D Slides.
. . HTM. GUI
How to Make Fully Interactive 3D Slides Manual
. . HTM. GUI
How to Animate Slides Manual
. . L HTM. GUI
How to View and Navigate Slidesin the ICM-Browser. Manual
I HTM. GUI
How to Edit Slides. Manual
How to Add Smooth Blending and Transition Effects HTM. GUI
Between Slides. Manual
2.3.3 How to Create Molecular Documents
How to Create Molecular Documents:. Linking Slides to vi deo
HTML Text.
HTM. GUI
How to Create an HTML Document. Manual
' HTM. GUI
How to Edit an HTML Document. Manual
How to Make a Hyperlink Between HTML Text and a HTML GUI
Slide. Manual
2.3.4 How to Display Molecular Documents in
PowerPoint
How to Display Molecular Documentsin Power Point vi deo
N : HTM. GUI
How to Embed in Microsoft PowerPoint 2003 Manual
P - HTM. GUI
How to Embed in Microsoft PowerPoint 2007 Manual
. : . HTM. GUI
How to Use Activel CM in PowerPoint Manual
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How to Change Activel CM Component Propertiesin HTM. GUI
PowerPoint Manual
Advanced use of Activel CM: Macrosto direct HTML GUI
visualisation changes. Manual
2.3.5 How to Display Molecular Documents on the
Web
How to Display Molecular Documentsin Web Browsers vi deo
How to Display Molecular Documentsin Web Browsers HTML GUI Manual
2.4 ICM-Chemist Reference Guide
2.4.1 How to Import, Sketch, and Edit Chemicals
How to Import, Sketch, and Edit Chemicals
How to load the ICM Molecular Editor. II\-g%alClJl vi deo
How to sketch chemicals in the ICM Molecular HTM. GUI vi deo
Editor. Manual
How to save a 2D sketch into a chemical HTML GUI vi deo
spreadsheet. Manual
: HTML GUI :
How to save a 2D sketch in mol format. Manual vi deo
How to use SMILES strings to sketch a chemical. HTML GUI vi deo
Manual
. HTML GUI :
How to load a mol, sdf or mol2 file. Manual vi deo
How to extract a 2D sketch of aligand in HTML GUI vi deo
complex with a PDB structure. Manual
2.4.2 How to Work with Chemical Spreadsheets
Working with Chemical Spreadsheets
How to add columns into a chemical HTML GUI vi deo
Spreadsheet. Manual
How to sort acolumn(s) in achemical HTM. GUI vi deo
Spreadsheet. Manual
How to change the view of achemical HTML GUI vi deo
spreadsheet - form, table and grid. Manual
2.3.4 How to Display Molecular Documents inPower Point 13




How to copy, cut and paste columns and rowsin

HTM. GUI

achemical spreadsheet. Manual video
How to show and hide columns and rowsin a HTML GUI vi deo
chemical spreadshest. Manual
How to save achemical spreadsheet in sdf HTML GUI vi deo
format. Manual
How to export your chemical spreadsheet into HTML GUI vi deo
Excel. Manual
How to print a chemical spreadshest. ur,\{t aIGUI vi deo
How to filter columnsin a chemical HTML GUI vi deo
Spreadsheet. Manual
How to use find and replace in a chemical HTM. GUI vi deo
Spreadsheet. Manual
How to mark and label rowsin achemical HTML GUI vi deo
Spreadsheet. Manual
How to insert hyperlinksto the PDB, PubMed, HTML GUI vi deo
and Uniprot. Manual
How to copy and paste 2D chemicals. g% aIGUI vi deo
How to edit data inside a chemical HTML GUI vi deo
spreadshest. Manual
How to remove salts, explicit hydrogens and HTML GUI vi deo
standardize chemical groups. Manual
How to calculate chemical propertiesin a HTML GUI vi deo
chemical spreadshest. Manual
How to identify duplicate chemicalsin a HTM. GUI vi deo
chemical spreadshest. Manual
How to compare two chemical spreadsheets. grl\l/t alGUI vi deo
; HTML GUI :
How to merge two chemical spreadsheets. Manual vi deo
2.4.3 How to Undertake a Chemical Search
How to Perform Chemical Searching
. HTM. GUI :
How to setup a chemical search. Vanual vi deo
; HTM. GUI :
How to draw a chemical search query. Manual vi deo
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HTML GUI

How to add conditions to your chemical search. Vanual vi deo
How to search chemical spreadsheets, local HTML GUI vi deo
databases and Mol Cart. Manual
How to send a chemical search query. g%alc’l‘" Vi deo
2.4.4 How to Work with Pharmacophores
How to Work with Phar macophores
How to draw 2D pharmacophore. |\H/|Lp1/|u|;| Gul vi deo
How to search a 2D pharmacophore. H-Iz—anMulél Gul vi deo
How to draw 3D pharmacophore. H-I;]Au;' Gul vi deo
How to extract a 3D pharmacophore from a HTML GUI vi deo
ligand. Manua
How to edit a 3D pharmacophore. W;nMut\l Gul vi deo
How to send a 3D pharmacophore search query. ngmﬂulél GUl vi deo
How to color a 2D chemical sketch by HTML GUI vi deo
pharmacophore feature. Manual
2.4.5 How to Perform Chemical Clustering
How to Perform Chemical Clustering
How to perform chemical clustering. :\—g% alGUI vi deo
How to select representative centers from a HTM. GUI vi deo
tree. Manual
How to reorder branches and change the HTML GUI vi deo
distance of trees. Manual
How to edit the tree - labels, spacing and HTM. GUI vi deo
coloring. Manual

2.4.6 How to Generate Stereoisomers and
Tautomers

2.4.3 How to Undertake a Chemical Search
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How to Generate Stereocisomersand Tautomers

How to generate stereoisomers. HTML GUI Manual vi deo

How to generate tautomers. HTML GUI Manual vi deo

2.4.7 How to Generate Combinatorial Libraries

How to Generate Combinatorial Libraries

. HTM. GUI :
How to enumerate a Markush library. Manual vi deo
How to decompose alibrary based on a Markush HTML GUI vi deo
structure. Manual

HTM. GUI ;
How to create a Markush structure. Manual vi deo
How to enumerate a chemical library by HTML GUI vi deo
reaction. Manual
2.4.8 How to Generate Plots and Histograms

How to Generate Plots and Histograms
How to make a histogram. HTML GUI Manua vi deo
How to make an X-Y scatter plot. HTML GUI Manua vi deo

2.5 Menu Option Guide

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the |eft hand side (web version) or
by clicking the Contents button on the |eft-hand-side of the help
window in the graphical user interface.

Here we describe al the options in the drop down graphical user
interface menus.

€3 pep Molsoft irm 3 7 7= Mhi—.nooiooedn id Leooad
i Tools Homology Chemistry Docking MolMechanics  Windows  Hale

I mﬁwEﬁAb%& TE&i
M |22 @lEL R [E ) ()€ | erren@) |

Workspace Panel Menu Options 5 x
|no selection

. F:E&['-(E

2.5.1 File Menu
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2.5.1.1 New

This option alows you to create new peptides, dna, sequences etc... and
isdescribed inthe Cr eat e New Obj ect s chapter.

2.5.1.2 New ICM Session

File/New ICM Session

This option allows you to generate a new clear ICM session or clone the
current one.

2.5.1.3 Open

File/Open
Thisoption is described inthe Open and Read chapter.
2.5.1.4 Open with Password

File/Open with Password
Thisoption is described in the Open and Read chapter.
2.5.1.5 Extract from ICB

File/Extract from ICB

Thisoption is described inthe Open and Read chapter.

2.5.1.6 Convert to Local Database

Please see the Local Databases chapter for more information about this
option.

2.5.1.7 Load

Options contained within the menu File/Load
PDB - read PDB from FTP, http, and local PDB

From Multiple Object File- A multiple object file will have afile
extension *.ob and you can select which member of the multiple object is

displayed.

PFam Alignment - PFam is a collection of multiple sequence alignments -
enter FASTA ID

SwissProt - Download SwissProt sequence.
All Images from Dir - Read into ICM multiple image files png or jpg.

Electron Density Map - Download electron density map from Uppsaa
electron density server htt p: / / eds. bnt. uu. se/ eds/

3D Meshin KMZ or COLLADA Format from Google - see
htt p: // sket chup. googl e. com 3dwar ehouse/ to download KMZ or COLLADA.

2.5.1 File Menu



2.5.1.8 Save Project

Thisisdescribed inthe Save Fi | e chapter.
2.5.1.9 Save Project As

Thisisdescribed inthe Save Fi | e chapter.
2.5.1.10 Save Project Compatible with ICM 3 5

File/Save Project Compatiblewith ICM 3 5

Use this option to save a version of your ICM project compatible with an
older version of ICM. Version 3.5 or older. If you have an ICM license
you can update your version of ICM by visiting our support site at
www.molsft.com/support

2.5.1.11 Save with Password

To save aproject which is protected by a password:

File/Save with Password

Enter afile name or browse for a previously saved project.

Enter a password

Determine whether you want the file to be Fully Protected, read
only or Read Only and Allow Comments.

2.5.1.12 Export as ActivelCM Html

To embed in aweb browser.

1. Download ActivelCM from here

htt p: //ww. nol soft. conl get browser. cgi ?product =acti vei cn&act =l i st
(itisfreel).

Creat e anHTML pagein ICM (File/New/Html).

Add aseriesof sl i des.

File/Export As ActivelCM Html..

PwWN

2.5.1.13 Close Project

To close a project:
File/Close Project
2.5.1.14 Quick Image

SeetheHi gh Qual ity Publication | nage chapter.
2.5.1.15 Write Image

SeetheH gh Qual ity Publication | nage chapter.
2.5.1.16 Preferences

Preferences are described in the Pr ef er ences chapter.
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2.5.1.17 Recent Files
Recently viewed projects and files can be easily downloaded from the
"Recent Files' option. To accessthis:

» Select File/Recent Files.
» Select the desired project by clicking on it once.

2.5.1.18 Recent PDB Codes
Quickly retrieve and display PDB structures that have recently been
viewed.
» Select File/Recent PDB Codes
e Select desired PDB code by clicking on it once and it will be
loaded into the graphical display.

2.5.1.19 Quit

Need to close down ICM - no problem. Y ou do one of the following:
1. Select File/Quit. ICM will quit without saving files.

2. Saveand Click X at the upper right corner of the ICM window.
3. Typequi t inthetermina window.

NOTE: You may want to savetheicm sessionasan| CM Proj ect file
before quiting.

2.5.2 Edit Menu

2.5.2.1 Delete

This option will delete anything that issel ect ed.

2.5.2.2 Delete All

This option will delete everything e.g. sequences, structures, tables
... Use with carel

2.5.2.3 Select All

This option will select everything e.g. sequences, structures, tables...

2.5.2.4 Search in Workspace

This option alow you to search for a particular text in the workspace

2.5.2.5 Selection

This option alows you to make a precise selection either by neighbors
or specifying a particular atom or neighbor. Click on the tabsto jump
between selection levels.

2.5.2.6 Invert Selection

This option will select everything that is not currently selected.

2.5.1 File Menu
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2.5.2.7 Clear Selection
This option will remove all selections. For more information on
selections seethe Maki ng Sel ecti ons Chapter.

2.5.2.8 Neighbor Selection

This option will allow you to select neighboring atoms. For more

information seethe Sel ect Nei ghbor s section in the Selections Chapter.

2.5.2.9Undo

Due to the complexities of working in an internal coordinates
environment not everything can be undone or redone. Certain things like
coloring and representations can be undone or redone.

2.5.2.10 Redo

Due to the complexities of working in an internal coordinates
environment not everything can be undone or redone. Certain things like
coloring and representations can be undone or redone.

2.5.2.11 Restore Recent Backup

ICM periodically makes a backup of your ICM project. If for whatever
reason you lose an ICM session and you want to load the backup for the
fileuse:

Edit/Restor e Recent Backup

2.5.2.12 PDB Search

See PDB Search Tab
2.5.2.13 PDB Search by Field

SeePDB Search Tab
2.5.2.14 PDB Search by Identity

See PDB Search Tab
2.5.2.15 PDB Search by Homology

See PDB Search Tab
2.5.2.16 PDB Search with External Segeuence

See PDB Search Tab
2.5.2.17 Ligand Tools

See the ligand editor section of the manual.

20

2.5.2 Edit Menu



2.5.2.18 Ligand Editor Preferences

See the ligand editor section of the manual.

2.5.3 View Menu

View Menu

Wiew Bioinfo Toolz Homology Chemistiy

-
=
=

Progrb0l @

Undisplay Al

Clear Dizplay and Flanes

Selection Level »
Selection Mode 3
Fog Cirl+D
Side-by-Side Steren Chl+5
Hardware Steren Alt+5
Full-screen A+
Perspective Chrl+a&k+P

Full Scene Antialias Chrl-+ale+,
High Quality

EasyRotate

Shadows

Anirnate WView 3
Drag Res Labels [MdME]
Antislias Lines

Calar Background

Save Viewpoint...

Center

Electrostatic Potential...

tacro Shape...

Select by Purple 30 Box

2.5.3.1 Undisplay All

View Buttons

.
B aEHODA@s & =

o+ Clipping tools

e (] |

Clip meshes —#%&
(% Lock mesh clipping

Toundisplay everything currently displayed in the graphical display

* View/Undisplay All

Note For more details on displaying structures please see the GUI
Over vi ew chapter.

2.5.3.2 Clear Display & Planes

Toclear thedisplay and planes

* View/Clear Display and Planes

NOTE: For more details on planes please see the sectionson cl i ppi ng
t ool s and mesh cl i ppi ng.

2.5.2 Edit Menu
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2.5.3.3 Selection Level
There are four levels of selection - atom, residue, molecule and object.
For more details on selections please see the Maki ng Sel ect i ons section.
2.5.3.4 Selection Mode
There are four different ways to make selections - new, add, remove and
toggle. For more details on selections please seethe Maki ng Sel ecti ons
section.
2.5.3.5 Fog
Fog Toggle(Ctrl + D) : this feature creates afog-like environment for
your object, so that the part of your structure that is closer appears
clear and the distant parts are faded asif they arein fog. The
cli ppi ng pl anes control the point at which the fog begins.
* View/Fog
2.5.3.6 Side-by-Side Stereo
Side-by-side stereo toggle(Ctrl + S) : this feature allows you to view
your structure in 3D form without any 3D goggles.
* View/Side-by-Side Stereo
2.5.3.7 Hardware Stereo
Hardwar e ster eo toggle(Alt + S) - if you have 3D goggles and you wish to
view your structure in 3D form, this feature will allow you to do so.
* View/Hardware Stereo
2.5.3.8 Full Screen
Full screen toggleAlt F - this makes your graphical display fill the
entire screen. If you wish to exit this mode, press escape.
» View/Full Screen
2.5.3.9 Perspective
Toggle perspective Ctrl_P thiswill add perspective to your structure,
enhancing depth in the graphical display.
* View/Perspective
2.5.3.10 Full Scene Antialias
Anti-aliasing is the technique of minimizing the distortion artifacts
known as aliasing when representing a high-resolution signal at alower
resolution. Always use this option before making hi gh resol uti on i nmages.

* View/Full Scene Antialias
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2.5.3.11 High Quality

Toggle High Quality: this option will give your ICM object better
resolution and higher quality. The change in quality is most visible at
a high magnification. However, if your object isvery large, this
feature could slow down your program.

Always use this option before making hi gh resol uti on i mages.

* View/High Quality
2.5.3.12 Easy Rotate
Toggle easy rotation: thisfeature is necessary if your structureis
very large or perhaps your computer cannot quickly r ot at e it. It will
prevent your structure from fully loading each time you rotate it,
therefore speeding up the process.

* View/Easy Rotate

2.5.3.13 Shadows

* View/Shadows
See Gr aphi cs Ef f ect s chapter.
2.5.3.14 Sketch Accents
To make images as shown below use:
» View/Sketch Accents
See G- aphi cs Ef f ect s chapter.
2.5.3.15 Animate View

Thistool is described in more detail inthe Mbl ecul ar Ani nati ons and

Transi ti ons section.

2.5.3.16 Drag Res Labels

To changethelocation of your residue label:

» Select View/Drag reslabels.

« If your mouse has a middle mouse button, then click on handle (as
shown) of the label you wish to move, and drag it to your desired

area.
Click on q
this area — -~
to drag

your

label.

* If your mouse does not have a middle mouse button, then click on

the Tranglation icon on the toolbar, and click on the handle (as

shown) of the label you wish to move, and drag it to your desired

area

The +/- buttons on the side of the Residue and Atom buttons will shift
the label. There are also other residue label move options available

2.5.3 View Menu
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when you click and hold the residue label button. These options include
Shift to Sidechain Tips, Shift to Calphas, and Restor e Positions

2.5.3.17 Antialias Lines
Use this option to activate antialias lines. It is recommended to leave
this option selected.

* View/AntidiasLines

2.5.3.18 Color Background

To change the background color

» View/Color Background
» Select acolor from the panel and press OK.

Thisoption is also in the more convenient di spl ay t ab.

2.5.3.19 Save Viewpoint

It is possible to store a current view using the button shown below.

B e EHDO K| =

Store Current View

Click on the button and the current view will be stored so that you can
view it later. A data entry box will be displayed asking you to name the

view. All stored views can be found in the ICM workspace as shown below.

=@ views (5 items)
¢ wiew_ligand_docked
~iew_hinding_site

~iew_hinding_patch

» Double click on the view in the ICM Workspace to display it.

A number of view display options are available by right clicking on the
view in the ICM workspace as shown below.

@ views (G items)
¢ ewview_ligand_docked

P e . Select
fview_binding_site e

Lview Set View
E----ViEWE Set View Smoath

: Leigw_binding_patch % Delat
[l abjects (1 items) =EE
- oBlicm  Ray 150 Aename |

Store current view right click menu

The option in the right click menu called "set view smooth" returns to
the view slowly showing the trajectory between the original view and the
current one.
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2.5.3.20 Center

To center on an object displayed in the graphical display

* Make a selection on the region on which you wish to center on.
» Tools/Center (or usethe cent er button on the right hand-side of

the graphical display).
2.5.3.21 Electrostatic potential

This option generates the skin representation of the molecular surface
colored according to the electrostatic potential calculated by the REBEL
method (hydrogen atoms are ignored). REBEL is a method to solve the
Poisson equation for amolecule. REBEL is a powerful implementation of
the boundary element method with analytical molecular surface as
dielectric boundary. This method is fast (takes seconds for a protein)

and accurate. REBEL stands for Rapid Exact-Boundary EL ectrostatics. The
energy calculated by this method consists of the Coulomb energy and the
solvation energy

In order to color the skin of your molecule by electrostatic potential:

» Select View/Electrostatic potential.

» Enter the potential scale value. Thisisthelocal electrostatic
potential in kcal/e.u.charge units at which the surface element is
colored by extreme red or extreme blue. All higher values will
have the same color. This absolute scaling is convenient to
develop afeeling of electrostatic properties of molecular
surfaces.

 Areas colored blue represent positive areas and red represents
negative areas.

2.5.3.22 Macro Shape

A macroshape allows easy viewing and manipulation of a structure. A
macroshape representation isideal for large structures which allows the
user to easily identify important regions of the structure and

facilitate the return to the ' standard’ view of a particular molecule.

The level of detail displayed in the macroshape can be controled by
changing the number of harmonics, gridStep, and, contour level.

2.5.3 View Menu
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* View/Macro Shape
2.5.3.23 Select by Purple 3D Box
An dternative way to make a make-selection{ selection} isto use the
purple 3D box. To do this:

» Select the display tab and the purple box button

» View/ Select by Purple 3D Box
e The atoms contained within the purple box will be selected.

2.5.4 Bioinfo Menu

Thetoolsin thismenu are described in the Bi oi nf o Menu chapter.

2.5.5 Tools Menu - Xray

The optionsin the menu are described inthe Cr yst al | ogr aphi ¢ Anal ysi s
chapter.

2.5.6 Tools Menu - 3D Predict

The optionsin this menu are described in the 3D Predict chapter.

2.5.7 Tools Menu - Analysis

The optionsin this menu are described inthe Prot ei n St ructure Anal ysi s
chapter.

2.5.8 Tools Menu - Superimpose

The optionsin this menu are described in the Pr ot ei n Super posi ti on
chapter.

2.5.9 Tools Menu - Extras
2.5.9.1 Plot Function

Toplot afunction:

Tools/Extras/Plot Function

Enter the Function(x) eg Sin(x)

Enter the starting value of x (From).

Enter the end point of x (To).

Enter the number of points (N points).

Click OK and your plot will be displayed next to atable of values
for your function.

2.5.10 Tools Menu - Table

2.5.10.1 Build Prediction Model

Learn and Predict tools are described here.
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2.5.10.2 Predict

Learn and Predict tools are described here.

2.5.10.3 Cluster Set

Thisisdescribed in the cluster section of the Working with Tables
Chapter.

2.5.10.4 Sort Table

There are a couple of waysto sort achemical table. Y ou can right click

on the a column header and select sort or you can use the option in the
menu Chemistry/Sort Table.

* Read achemical tableinto ICM.

» Select the columns by which you wish to sort by as shown below.

» Select Ascending or Descending and for each sort by option and
then click OK

9 Sort Table

T able _groups

Sart By |rnu:u| ﬂ v Aszcending i~ Dezcending
Then By |ID>< j ¥ Azcending i~ Dezcending
Then By |h-10|Weight j {* Aszcending i~ Descending

Ok | Cancel

2.5.10.5 Merge Two Sets

To mergetwo tables:

* Read thetwo tablesinto ICM.

* Tools/Table/Merge Two Sets

» Select thefirst table from the drop down list (Table A) and the
column you wish to use to merge the table by.

» Select merge method 1. inner - only molecules present in BOTH A
and B tables are kept; or 2. left ALL rows of A arekept ; or 3.
right ALL rows of B are kept.

» Select the second table from the drop down list (Table B) and the
column you wish to use to mergethe table by.

» Enter aname for the output table.

» Click OK and a new table will be displayed.

2.5.10 Tools Menu - Table



e Merge Two Sets @

Table & ricinligands20_tauto 1 _tauto Ji by Colurnn ral -
o inner " left " nght
Table B | nicinLigandsz2D_tauto j by Calumn mol -
Reszult Mame |T_i0in j
Hint

inner - only molecules present in EOTH & and B tables are kept
left - ALL rows of & are kept
night - ALL rows of B are kept

Ok | Cancel Help

2.5.10.6 Add External Columns

To add external columnsto a table (e.g. based on a merging key):

» Read at least two tablesinto ICM - the table you want to add to
and the table you want to add the column from.

» Toolsg/Table/Add External Columns

» Enter the target table name and the column you wish to match each
table by.

» Enter the source of the new column (Other table and column name)

» Chooseto add "all the columns' from the source or "overwrite
matching columns' or select the columns you want to add by
selecting the "choose column™ option.

» Select the columns you wish to add.

2.5.10.7 Append Rows

To append rows from one table to another one:

* Read at least two tablesinto ICM - the table you want to add to

and the table you want to add the column from.

Tools/Table/Append Rows

Enter the name of the Target Table (where you will append).

Enter the name of the Source Table (where you will append from).
Select whether to Merge Columns

Check whether you would like to Select New Rows. If you do this
you can easily highlight the new rows using the mark row option.

e Check whether you would like to Calculate Columnswith Formulas.

2.5.11 Tools Menu - Chemical Search

Chemical searching is described in the Chemistry chapter here.
2.5.12 Tools Menu - Molecular Editor

The molecular editor is described in the Chemistry chapter here.
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2.5.13 Homology Menu

The optionsin this menu are described in the Homology Modeling Chapter.
2.5.14 Chemistry Menu

Thetoolsin the Chemistry menu are described here.

2.5.15 Docking Menu

Thetools in the Docking menu are described in the Docking chapter.

2.5.16 MolMechanics Menu

The optionsin this menu are described in the Molecular Mechanics
chapter.
2.5.17 Windows Menu

This menu allows you to choose the windows you wish to display. The
windows which open automatically when you first open GUI are shown in

theGetti ng Start ed section. Other windows can be displayed by selecting

the windows menu. For example, if you have loaded atable but cannot see
it in the GUI it may be because the Tables option in the window menu
hasnt been selected.

To add or remove windows from the GUI display select the 'window menu’.

Other windows not included in the default display such as tables and
alignments can be added.

2.5.13 Homology Menu
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| have windows open everywhere - Please bring some order.

thics | wWindowlz Help
i Drefault Layout I
D Slide Layout
ﬂ i HE Tables->Main
— & dignmentsoan - = \what do you want in the main window?
S‘S 30 Graphics-xMain
v Dizplay Parel
Terrmninal
v Alignments
Where is my Table? ——v Tables
v 3D Graphics
Htrnl Documents
Background jobs
v Workspace Panel
File Operations
Selection Tools
Check and Uncheck —v View Tooks
Graphic Layers — All the buttons

towe Tools

LY

Clip Taols

LIRS %

Misc Tools

To return to the default display option select the ' Default layout’
option in the windows menu.

OR
Click the default layout icon.

EBH Tables->Main
t = Alignments-»Main

$& 2D Graphics->Main Some options can be accessed at the
g Default Layout bottom of the GUI.

D Slide Layout
e—— B
L

oE0 &

2.6 Tab Guide

In this section we describe the contents of the tabs in the graphical
user interface.
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€3 pep Molsoft icm 3.7-2a [NewProject *] (1 object)

File Edit Wi i begpist Docking  MolMechanics  Windows  Help

B EBD AWK TFF1

e [ | m =) |

Workspace Panel 8 x

no selection

“Mowecs| 1ab Options

—[‘IF'[‘I T
“Bm

2.6.1 Display Tab

The display tab containstools for avariety of functionsincluding -
structural r epr esent ati ons, col ori ng, | abel i ng and super posi ti on. This
tab is shown below.

T’T\FB'_‘ "mﬁ(a—rv?r\/—\

H| 221 @l @ff aferdstd | BT 7Y G | WIS Q | A |2 X #fgs | G| S8

2.6.2 Light Tab

Iigh|t tab Save light seftings

S display Yy Tight %y labels "y pdb search " meshes Y movie ™, l

Shine Arnbignt Diffuze Spec Alpha A-Bright * Y o
e oo s ) g

Drag to Change 5etting$ Set default I|ght Settings

The optionsin thistab are described inthe Li ght i ng Secti on.
2.6.3 Labels Tab

Labels Tab

Jeplay " Taght Y Tabek Y pdb search Y meshes Y movie
ol5isols) | ot ]|

Text Labels Distance Labels

The optionsin thistab are described in the | abel s section of this
manual.

2.6.4 PDB Search Tab

Instructions on how to use this tab can be found in the Sear ch PDB
secti on.

2.6.5Ligedit Tab

Instructions on how to use the optionsin this tab can be found in the
How to use the 3D Interactive Ligand Editor section.
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2.6.6 Meshes Tab

Click on the tab button entitled 'meshes’ and three different graphical
display tools are available for you to use. The three displays are
surface, meshes and macroshape and are collectively referred to as
meshes.

§odisplay Y labels Y analysis ¥ pdb zearch ¥ meshes W movie

4’9 ‘ -all - | FF Ma El: step (00 *| W color MacioShape

surfaces meshes macroshape

W wire |

The benefits and applications of each display are described in the
section.
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3 Getting Started

Chapter Contents:

e The Basics of the Graphical User Interface

* How to search and Downl oad Protein Structure, Sequences, and
Chemi cal s

How to create new Objects

How to open files

How to save files

How t o Make Sel ecti ons

Changi ng Preferences

3.1 The Basics of the Graphical User
Interface

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro |l CM Chem st

3.1.1 The Components of the GUI

The Graphical User I nterface (GUI) has many components. When you first
use the GUI the default window layout is displayed as shown below.

ol @ W g¥EdEL

B L de | ST U ] sarEre | A o B i | T3] nlgEg”

“Terminal

B B e

3.1.2 How to load a PDB Structure

There are three main waysto read in a PDB file.
1. Using the command line.
2. Using File/Open button
3. Using the PDB Search tab

Other PDB search options are described in more detail inthe PDB Sear ch
section of this manual.
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= Three different ways to load a PDB file. |

O oo BT TR i NGB GEAFe s TTELELL
i\ \ b \/ hes \/ 3o \/ i \

posaanch  »! kb £« [ | odtneadinmodes [ w locapancytispisy [nane =il
s < O T ——

Ineriapane Parel
no selection l Click on the search tab ]

Lo Elebens o] and enter the PDB code

¢ = fxbb 17

LIl s a 2684 5s2

sPasti M d(dme
43 tyrosine-profein ki

e JW (357 water rs

-----

megl P oG o

s W

: icm/ lxbb}undti,spi
i |icm/1lxbb>display Sl
i [icm/lxbb>undisplay residues label Res{a_*.//DD)
i icm/lxbbrread pdp "1xbb"g§ :

J e

Use the command line 7!

BBENR L Db ]

(2@ B0 = 0@ a8 v

3.1.3 How to Move a Structure in the Graphical
Display

Available buttons and options for moving molecules around the graphical
display window. Thisis described in more detail in the section entitled
Move Buttons.
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How to use the Graphics window controls

In the graphics window you can use varioust ool s described elsewhere but
it is helpful to know the following things:

e Picking atool: the left mouse button will function according to
the selected tool

» Popup menus: right click on an atom gives a pop-up menu

e Sdlecting in therotation mode: the right mouse button will select
atoms

» Trandatingin the rotation mode: the middle mouse button will
trans ate the scene

» Zooming and moving clipping planesin therotation mode: the | eft,
top and right margins of the graphics window are reserved for
other actions, zoom, z-rotation, and clipping plains,
respectively. That means that even if you are picking atoms, by
pressing control you can still rotate your molecule with the
left-mouse-button.

* Rotating in any non-rotation mode: if you press Control in any
mouse mode, e.g. zoom, pick etc., it will temporarily switch to
rotation

» Escaping from the connect and continuous movement modes: pressing
Escape helpsto get out of certain modes, such as Full Screen,
Continuous rotation or rocking, the Connect mode.

» Global rotation in the Connected mode: pressing Shift will
temporarily switch to the global rotation/translation mode.

3.1.4 How to Display Molecules using the ICM
Workspace Panel

The workspace panel (located on the left hand side panel of the gui) is

an important place within the graphical user interface because it

displays which sequences, structures, objects, tables and alignments are
currently loaded into ICM. From the ICM Workspace panel you can make
graphical selections and display and undisplay molecules.

3.1.3 How to Move a Srructure in the Graphical Display



548 106 Atoms 23 Res.1 Mol 4=

SR ® Jobjects (1 itemns)

]

Selected atoms and

residues
J==sgquences (2 items)
+-cfihd  len=77 Amino
R [en=86 Amino
Workspace ¥ alignments (1 items) |
anel |D=23% pP=27
P LEE fgbles R iterpns) Expand here for more
_ i PDBSearchResults 13 | information.

| |
1% | =+ | 8@ ||

Al
Display all J \— Tables

Objects —— Alignments

Sequences

Once a structure has been loaded into ICM the individual components of
that structure (i.e. amino acids, metal ions, binding sites etc) are
listed in the ICM workspace.

To display every component of the object except for binding sites and
water atoms:

 Click on the white box next to the word object at the top of the
ICM workspace. This box will be colored blue once the structureis

displayed
no selection

Click to display —— -=+-§0 objects (1 items)
or undisplay o w-Fiay: 280
Double click a0 J38Amina
to select an g b 305 Aming
object .4 cnag 1 Hete
or a molecule O =t 1 Het
g dnag 1 Heta
Click hereto . ls g dnag? 1 Het
unselect all B dman 1 Hete
£ enag 1 Heta
-84 enag? 1 Het
-fd Tnag 1 Hetah

To display the whole structure in wire, ribbon, cpk, skin, surface and
xstick representations:

* Right click on the blue box next to the word object. A menu will
be displayed.
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» Select which representation you desire for your structure by
clicking on the appropriate word. A check mark indicates the
representation currently displayed. To un-display a particular
representation click on the word again.

In order to clear your graphical display:
» Select View/Undisplay All

If you only wish to display part of the structure then click in the
boxes further down the tree in the ICM workspace.

To display selected regions of the molecule in wire, ribbon, cpk, skin,
surface and xstick representations:

» Right click on the appropriate box in the |ICM workspace. A menu
will be displayed and select the representation you would like to
use (e.g. wire, ribbon etc...)

3.1.5 How to Make Selections

Making selectionsin ICM is an important skill to master (e.g. you may
want to select a binding pocket for docking or aregion of amolecule
for coloring). The four levels of selection are:

1. Atoms

2. Residues

3. Molecules

4. Objects (multiple molecules comprising a PDB entry)

There are several ways of making selectionin ICM. The smplest isto
interact directly with the graphics window - right-click, hold and drag
around the area of the screen you want to select. Alternatively, in the
workspace window, expand the tree of molecules and chains until the
relevant protein sequences is displayed. Then left click and drag to
mark residuesto form a selection.

See the chapter entitled Maki ng Sel ect i ons for more information.

3.1.5 How to Make Selections
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3.1.6 How to Change Protein Representation

To change the representation of the protein, makeasel ect i on and then
usethetoolsinthedi spl ay t ab.

There are 6 main types of representation:

» Wire: Wires connecting covalently bound atoms of a molecule. This
representation has no defined thickness as such will not make
shadows. Useful for showing the chemical structure of a small
molecule.

» Xstick: Covaent bonds are represented as cylinders whilst atoms
are represented as small spheres.

» CPK: Atoms are represented as spheres with their respective van
der Waals radius and coloured according to a standard defined by
Corey, Pauling and Kultun.

» Surface: Solvent accessible surface. Thisisthe center of water
sphere as awater probe rolls over the molecule.

e Skin: A Connolly molecular surface over the selection. Thisisa
smooth envel ope touching the van der Waals surface of atomsasa
water probe rolls over the molecule.

» Ribbons. Cartoon representation of protein and DNA secondary
structure. Protein residues marked as alpha-helices (H’) are
shown as aflat, helical ribbon, those marked as beta-sheets ('E’)
are shown as aflat ribbon with an arrow-head, and the rest are
shown as acylindrical "worm". If secondary elements are not
defined everything will be shown as a cylindrical worm. ICM can
automatically assign secondary structure: Tools/3D predict /Assign
Helices and Strands
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Mote: The representation buttons are shade he molecule selectedis in that

particular representation, Click and hold on any button for more display options.
3.1.7 How to Color

To change the color of the representation you need to use the buttonsin
thedi spl ay tab.

Changing the colour of a representation works in much the same way as
displaying the representation itself. The selection rationaeis the

same followed by clicking on acolour in the paletteinthe di spl ay t ab.
Itisalso possible to colour different representations of the same

selection independently by clicking and holding on the representation
buttonsinthedi spl ay tab.

3.1.7 How to Color

meoh Bo+h o
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3.1.8 How to Display a Binding Pocket Surface

To display the surface of asmall molecule ligand or peptide binding
pocket:

¢ Load the PDB of interest.

e Convert PDB toICM object. If you do not convert you will not get
the properties of the pocket displayed on the surface.

¢ Right click on the small molecule or peptide in the ICM Workspace
and select Ligand Pocket.
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Mote: The surface {meshes) and h-bonds can be toggled on and off in the ICM workspace.

3.1.9 How to Save an ICM Object

Any ICM object such as a structure, sequence, or alignment, can be saved
for use at alater time.

To save an object:

¢ Right click on the object name in the ICM workspace or ICM
alignment editor and a menu will be displayed.

¢ Click on the Save As... option.

¢ Enter the unique name you wish to call your object in the box
labeled File name:

¢ Choose which folder or directory you wish to save your object by
clicking scrolling down in the box labeled Savein:

¢ Choose which file type you would like to save your object as by
scrolling down in the box labeled Save astype . ICM structure
objects should have the file ending yourfilename.ob and alignments
yourfilename.ali

« Once the appropriate information has been entered click on the
Save button in the bottom right hand section of the window.

¢ The object is how saved.

3.1.9 How to Save an ICM Object
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To save an ICM object or PDB
file right click and select
SaveAs..

3.1.10 How to Save an ICM Project File

All objects contained within an ICM session can be saved in asingle
file with the extension .ich. The file can then be read into ICM and the
exact layout of the file will be preserved. To save aproject filego to
the File menu and select Save Project.

3.1.11 How to Drag and Drop

NOTE: "Drag and Drop" is a useful way of moving objects and sequences
around the graphical user interface.

Sequences and objects can be moved around the graphical user interface
by dragging and dropping them. All loaded sequences and objects are
always displayed in the workspace panel. Select the desired object or
seguence from the workspace panel by clicking and holding, move the
selection to the desired location and release.

Thisisauseful application in the graphical user interface. For

example, you may have an alignment displayed and you wish to add another
seguence to the alignment. This can simply be accomplished by dragging a
loaded sequence from the workspace panel into the alignment display

panel. Or, you can quickly view an object by dragging and dropping it

from the workspace panel into the 3D graphics window.

3.1.12 How to: Right Click Options

NOTE: If you right click on any object you will see a new menu of
options related to that object.

Theright click mouse option can be used throughout the graphical user
interface. It is avery useful means of opening up awhole new world of
menus and options. Most of these options are described in this book.
However, when using the graphical user interfaceit is always a good
ideato try right clicking the mouse on an object and seeing which extra
options that are available for you to use.

3.1.13 How to Move Windows

Isyour graphical user interface looking a bit messy? Do you have
tables, alignments, plots all over the place? Here we show you how to
arrange everything to make a clearer GUI environment.
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2. Click and drag on awindow title bar to moveit.
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7. You can aso move awindow to any part of your screen.

NOTE: To return to the default display option select the ' Default
layout’ option in the windows menu.

OR
Click the default layout icon.

EE Tables->Main

t; Alignments-x M ain

5‘5 30 Graphics-xMain

[ Default Layout
N D Slide Layout |

®||=0 s @

OR

Some options can be accessed at the
bottom of the GUI.

Double click on the window header.

3.1.13.1 How to Arrange Windows

Sometimes when using ICM you may have many items displayed such as
structures, alignments and tables. As a default the graphical display is

the largest and centered in the middle of the ICM graphical user
interface. However if you wish to work on an alignment or table you can
place the alignment or table as the main display by clicking on the
buttons shown below. The larger display generally makesit easier to
manipul ate the alignment or table. There are of course other waysto

alter the layout such ast i er the windows but this optionisjust a
simple click and can sometimes come in useful.
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3.1.14 How to Make a Picture

There are severa ways of taking a picture of the contents of the 3D

graphical display window see the wite inmage secti on. However the
easiest way isto simply click on the button in the view tools panel

(seeimage below).

quick high quality image
|

DEESG 90 TGO
[ display "\ light \/" labels \/ meshes /" s=ar

FDE Search = | text or smiles

Or select /File/Quick Image

The picture will be automatically saved as a PNG file in the directory

from which you loaded ICM. The default picture nameisicm[n].png, where

n is the number of pictures taken in one ICM session. To savein other

picture formats and to change the filenamesee the wite i nage section.

3.2 How to search and download Protein
Structure, Sequences, and Chemicals

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ICM Pro |l CM Chem st

The Sear ch tab allows you to search and download content from the
following databases:

» The Protein Databank www.wwpdb.org - search for protein and
chemical

The Pocketome Database ht t p: / / pocket one. or g/

BLAST search the NCBI sequence database

The UniProt Sequence database ht t p: / / www. uni pr ot . or g/
Search the PDB by ligand code.

Search Drug Bank ht t p: / / www. dr ugbank. ca/

Search PubChem ht t ps: // pubchem ncbi . nl m ni h. gov/
Search ChEMBL ht t ps: // www. ebi . ac. uk/ chenbl /
Search SureChEMBL ht t ps: / / www. sur echenbl . or g/ sear ch/
Search the Crystallography Open Database

http://ww. crystall ography. net/

3.1.14 How to Make a Picture
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i F) POBSsarchRopals Mobedt iom 1.7-3; {Moabngect 44 To see all the available search options

| Fig  Eda Wiew _w Cmmrmy Dﬁ-thm_] BAoihdsctanicy Wi i:"l:k on the llsearchhr tﬂb a“d use IhE

drop down menu.

7 y * acoapancyciay |nong =l :‘

© ~ |dh ok, 3

..... — v

# =

S

By SeqPattern &b
Close Match i
By Homolagy )
Ligand Code -
Dirug Bank -
ICE Index # ]
i

i

&5

R D | e al

d Staltupf Loading modules. macro bicinfo rebel ligedit dockime ¥
LICM startup file EchutEd.,, :
lfmfdef:generalbearuh~rcmGUI " 1 - s jclocoes " e
Info> using C:/Users/Andrew/. 1cmf:nxfﬂﬂH mulr daranaﬁp 2

Info> Searched 13561 rows. 8370 elements (i _out) stored in table '
iemfdef>delete PDBSearchResults
3 [icm/def>f
LI_! 4

s =M E G &8s %

Click on the search tab and then use the drop down menu to identify the
database you would like to search and download from.

3.2.1 Search the PDB

How to Search the Protein Databank and Download

The PDB sear ch tab provides easy access to the PDB database. Y ou can use
keyword searching or typein the PDB code you areinterested in. An

asterisk (*) wildcard can be used to list all the pdb files currently

available in the protein databank. Different fields can be searched by

using the drop down arrow as shown below. More advanced PDB search tools
and how to use the PDB search result table are described in the section
entititled Sear chi ng t he PDB.

Once a search is complete a table of PDB files relating to your search

query will be displayed. To view the PDB filein 3D in the graphical
display double click on arow in the PDBSearchResults table.
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| Tosearch the Protein Data Bank.

mgmwmmmww,mmmn e
DEES 90 TR HB:gilE EcHDASE TEF 44888

= |ocapancybislay [rone 3 ‘|4.

date
1. Enter search string 2. Click here or press pummon :L_»:; :fj;::
or PDB code z enter key 20660123
231 oot TRAKSFERASE HGT-01-23
22 313 Tanshemse 20100125
233 206 TRANSFERASE HA1-61-25
234 Jybn TRANSFERASE H11-01-25
235 Jopw TRANSPERASEITRANSFERASE INHIBITOR 2011-401-23
236 ddgg TRANSFERAZE H1201-23
237 Qv TRAKSFERASE 2003-01-26
238 sy Transferse 2005-01-26
239 Zhty TRANSFERASE 2OE5-0] 26
40 TRANSFERASE F00501-28
41 ﬂ]a‘mﬁhﬁ %, HET-01-28
243 Zepy TRANSFERASE \\ 676128
243 2pgy Transferase N HCE-01-26
244 3fip  TRANSFERASE . a1y B ]
M5 dapr TRANSFERASE . 20126
3486  dagd TRANSFERASE 3. DOHblE Cll{:k to 121 -2
47 133w TRANSFERASE load structure 15801265
248 133 TRAWSFERASE FUGE-31-25
249 v KIMASE 19580126
B0 1y TRANSFERASE HG5-01-27
251 Qys) TRAMSFERASE HGS-01-27
1o TRANSFERASE HE5-01-27

=

 Click on the search tab and enter a search string or PDB code.

A table containing the results will be displayed.

» Doubleclick on arow to load the PDB file. Read more about PDB
search her e.

NOTE: If you have a PDB structure already saved you can read it into
ICM by going to the File Menu and selecting Open. PDB files that have
been viewed previously can be loaded using File/ Recent PDB Codes.

3.2.1.1 How to Search the Protein Databank by Chemical
Substructure

How to Search the Protein Databank and Download

LERT

=
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s38ddddJ987eddd

[ B mEn s
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g
w2

o B X}

To Search the PDB and Download a Structure
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r@ PlESsarchResults Moot iom 3.7-3c [MewProject *]

To search the Protein Data Bank by

chemical substructure,

DFEG O TGO EH:pfifpE HMEaH e ————

T A A o ) ®
PoBSewch v mwmlmm[n-i;-w -4 * |ty [pes =
wiarksgace Panel +
1 Selection e § v B
1. Click on the 4. Click here or press @ ¢ :
molecule editor enter key I -
button : B
& |2 -
" i
4
[ . X
c ? % i
M [ b3
o o i kS
1)
L
& 1
E2
8 “ - ;E;
ol 155 e
2. Sketch the o o
substructure - L]
B [
H :
¢ 0 W0/= Clasms
Step 1: Click on the molecule editor button inside the search tab.
Sketch the substructure you are interested in.
& PoBSeanchfients Molsoft i 3.7-3¢ fewPicgect ] {2 tabde) | Double click on the table to load the
SRR S R e e e R e E g DB structure.
DEEe oo TR0 HWM e NS FEH B e mrrr—————
(RN sV \ T\ ; e
PBSearch = besctccciee(C0Ne0 0 v EW @ = Jocapancytie [pane "lg."_"; &
Vioriemace Sarel #x {FieSeandhResits Y o
ra selection : HETID mal o e e W |2
L tables (1 #ern) ) 7, Zihe 20050727 LYASE @ k2
-POBSearchResults  © rows 13 cofs § he ) " &
. . i O
o i E’
_ B
o
& i
WL o lzi  ZDO-09-30 LYASE @ b 5
¥
s
2 N i
&
8 - 13 HYDROLASE 'y
1. Double click to P!
! load PDB structure Py
i <f \> -
I & - £ :
G = TENCYCTENEN

Step 2: A table containing the results will be displayed. Double click

on arow to load the PDB file.
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3.2.1.2 How to Query the PDB by Sequence

There are a number of ways to search the PDB by sequences.

1. BLAST search the NCBI datase using the option " Sequences from
PDB".

2. Search by Sequence Pattern using the option in the Edit menu.

3. Search by I dentity using the option in the Edit menu.

4. Search by Homology using the option in the Edit menu.

3.2.1.3 How to Query PDB by PDB Field

Toquery the PDB by field (Author, Compound, PDB Header, Experiment
Type, Resolution or Ligand Code

» Select Edit/PDB search by field.

» Enter the search string or value

e Click OK and alist of related PDB entries based on your search
will be displayed in the PDBSearchResults table of the graphical
user interface.

Authars |i ﬂ Experiment Type |" ﬂ
Compound |’c j Resolution Eetter Than |9_9 j
Fdb Header |" ﬂ Ligand code |“ j

|Jpdate PDE Index
Ok | Cancel | Help |

3.2.1.4 Load and Display NMR Structures

Use the PDB Search tab to load NMR structures from the PDB. Y ou can use
the drop down button shown below to determine how you want to display
your NMR structure. Y ou can choose to display and download the first NMR
model, all modelsin the PDB file or all modelsin the PDB in a stack.

If you choose the stack option the the stack will be stored in the

object as described here.

" display \/ light \/ labels \/ meshes "Ur search U ligand /" maovie

PDE Search || Zkdz w pdbReaderMadeIs all skack, * |occupancyDisplay [none

First
all

Workspace Panel g X

Click for drop down m

3.2.1.5 Occupancy Display

Y ou can use the options in the PDB Search tab to control if and how the
partia or zero atom occupancies are displayed. Y ou can choose to circle
or label the poor occupancy atoms.
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[ display \/ light \/ labels \/ meshes V search "Ur ligand %/ movie \

PDE Search || 1xbb w pdbReaderModels all stack, | occupancyDisplay |circle

>>| oad-pdb-hyperlinks{ pdb search hyperlinks} h4-- Hyperlinksto PDB
Website and UniProt { Hyperlinks to Databases}

In the PDB Search Results Table you will see blue hyperlinks that will
take you directly to the PDB website or Uniprot website.

3.2.1.6 Display PDB Header

To display the PDB Header for aPDB file.

» Firstload aPDB fileinto ICM (see Sear ch PDB)
» Double click on the word header in the ICM Workspace.

/’ ki ICM wDrkglpatg """\5
g objects {1
SE fom
8« JOF

3 n:ran"l/bl%cham a; engineered

e datools

\i Double click here J

S

» The PDB Header information will be displayed.
¢ Click on the blue hyperlinked text to link to external web pages
for additional information if needed.

3.2.1.7 Direct link to PubMed

When you search for aPDB fileand load it into ICM you will see anicon
(shown below) next to your protein namein the ICM Workspace. Click the
icon and you will be taken directly to the PubMed primary reference
relating to the structure.

Direct access to PubMed

= ubjel:ts (1 iterm)
SR 1xbb  [1]XR; 1.6A
wfflla  Z6BA 1 site KSYK_HUMAN
el asti H 4-(d-methyl-piperazin-1-yim

----- &3 tyrosine-protein kinase syk; chain: a;

3.2.2 Search Pocketome
The Pocketome (www.pocketome.org) is an encyclopedia of conformational

ensembles of all druggable binding sites that can be identified
experimentally from co-crystal structuresin the Protein Data Bank.
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R — To search the Pocketome database.
File  Edit 2. Enter a search iy Docking  Melblechinics Winl o g0 org

b & string 0 AE e B

gy

4. Click here or press
enter key

1. Click on the
Pocketome option

3. Select search
category

Se 0= 0aas)

Step 1: Click on the search tab and choose the Pocketome option. Check
afield you would like to search e.g. Protein Name, Family, domain...

neol P Wo+d e

e A

& 2rows Molsoliiom 3.7-3c (awProject " i sbikcts 1 tabied |Tu ioad a pocketome entry,

Bﬂ-ﬂuﬂf&"ﬁ\f} HQRJ!JH @-ﬁ:ﬂ!iﬁtt TEEs8kl

o chatvy N bt VS labety \ mankan Y sserch \ hgedt )

Poceinee - BEERIg L] [ﬁﬂn-ﬂ—: - ﬁ]
. uasn_; H 2-hydmpmativd-B.ocivis

ierispncs el #%
&belai adrenergic receptor, chan: a,

no selection
A L

=i shdes (1 iem)

= shdeshoe
|9 Shide 1

ﬂ&w '?’{3 1 1. Double click to

50 RaL A load pocketome

x ;m\ entry

L2 Shde 2
=f obgects (B dems)
S 2ada (1) KR 274
+-E!-a 214 A 3 sles ADRBY_MELG:
w8 ap32 H A-fi(25-3-den-Dutyiaming
Fillana W sodum +

usodd Bo+dE o

et oe DBEMEH

& 7 = . o
Entry ] peuthiamad it I
ADQB]._HEIGI_E'L% A 2 ” Beza-1 sdrénarge receptar :;|ﬁ

g 1@

| | ADRBZ_HUBAN_26_357_cholestenc r Beta-2 adrenesgic recaptor [ %

2 FoE
i 4 " L
o8 E0x 0@aw a o [l 25 8 nen- KM Ot

Step 2: A table of pocketome hits will be displayed. Browse the results
and double click to load a pocketome entry.

3.2.2 Search Pocketome




3.2.3 ChEMBL Search

ChEMBL (https://www.ebi.ac.uk/chembl/) is a manually curated chemical
database of bioactive molecules with drug-like properties. It is

maintained by the European Bioinformatics Institute (EBI), of the
European Molecular Biology Laboratory (EMBL), based at the Wellcome
Trust Genome Campus, Hinxton, UK.

To search and download datafrom ChEMBL:

» Click on the Sear ch tab.

e Choose ChEMBL from the drop down button.

» Enter asearch string or search by chemical sketch by clicking on
the editor button in the panel.

e Select afield to search e.g. Protein Name.

» Select whether you wish to return just activity dataor al data.

» Click the search button.

A table will be displayed as shown below.

 chemBLSearch |

{.i.ﬁear{:hTabehEMBL} <2 {3 Choose Field )

...1E--u‘vu- LR AS® K| TFT &+ 84 %
i mard ¥ igeda 4 l
:_r.'-ewn. w] | enaz G« Bl ln Prosniiame o[ B Recuna, vd, D0%D, BC30, N0, ACE, snd Putsncy (ITE) duta andy -
f chantd s | :i 5. Click to search . +
ol 2. Enter String e ST e = | & (e \ P V[ Aok | 2
]\4\ " - I CHEE1 501 208 BLH2 HUMAH Prosty _. Gt Bt Activity £
= ke &
- 4 U_” % Gl Ligarsd Tummary
3 # Ei t pe?
= 4, Click here for :
P 4E
additional data
CHEMBLE25247 BGMa HUMAN P .

-t [~
rl 3 N, aar
. [

& S o,

{ \ CHEMBLA93063 BGHE HIMAN Prosta -
- ! - £ ]
@ 7 U e be

7 Y

—

)

PRI 501 08 BIHT M MAN Prasiy
|

1 |

E..F;.‘J Ej i_ DJ_J ﬂ_l £ | 1 Juble. 15292 rowrs, 20 codurnny

The table contains the original activity data without merging or
aggregation. For instance,

Chemical 1, Protein 1, Activity 1

Chemical 1, Protein 1, Activity 2

Chemical 1, Protein 2, Activity 1

Chemical 2, Protein 1, Activity 1

Click on the button Get Best Activity to display the best activity for
each chemical, protein pair. For instance,

Chemica 1, Protein 1, Best(Activity 1, 2, 3, ...)

Chemical 1, Protein 2, Best(Activity 1, 2, 3, ...)

Chemical 2, Protein 1, Best(Activity 1, 2, 3, ...)

Click on the button Get Ligand Summary to display alist of chemicals
with all activities found in ChREMBL. For instance,
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Chemical 1, Protein 1, Activity 1

Protein 1, Activity 2
Protein 2, Activity 1
Protein 3, Activity 1

Chemical 2 Protein 1, Activity 1
Protein 2, Activity 1
Protein 2, Activity 2

3.2.4 Search SureChEMBL

SureChEMBL (https://www.surechembl.org/search/) provides free access to
chemical data extracted from the patent literature. To search
SureChEMBL:

» Click on the Sear ch tab.

e Choose SureChEMBL from the drop down button.

» Enter asearch string or search by chemical sketch by clicking on
the editor button in the panel.

e Select afield to search e.g. Protein Name.

» Select whether you wish to return just activity dataor al data.

» Click the search button.

3.2.5 BLAST Search

To BLAST search the NCBI sequence database:

viogy Chemistry Dockieg  Moidechanscs o)
OB R 5 B - roi (B o B8 G

bbb LT T | BLAST Search NCB! database. Read in a
sequence or load from UniProt,

' 1. Select BLAST
FrrTaal Y

BLA5T = | Chad Mpan

4. Select database to
BLAST

Warkspaos Paral
it Selechion
% SOGUENCES
= CHK2_HURAN

3. Select sequence or

i — drag and drop from
2. Load sequences to ICM Workspace
BLAST

A =1

o8 B ca=

e o &

B ®

Step 1: Load asequence into ICM. Select the Search tab and choose the
BLAST option. Drag and drop the sequence into the search field, use the
drop down menu or type the sequence name.

3.2.4 Search SureChEMBL
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@- blast_hits Molsol ko 3.7-3¢ [Mewdroject ] {1 table}

= B T p——

4
- 2. Double click to
load sequence

Chan A, Wm om»ed'mm: '
Complex with inhibior PviS31

&
\Chan A, Crystal Structure OF Checkoint b
Complex With Ishiblor Pvi7e

7

Chan A, Fha Domain From Huren Chid 16
Complex With & Synthetic Phesphopeptid

" 21730364 | pdb | LGXCID Thain D, Fua Dom
Hufrgr ChiZ Kindse In Cofpita YWEh A Sy
Phowl!mp'hdt ag-:mmanm;mnt
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1. Click to select &

B
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i
! &

' 2
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X

Step 2: A fully interactive table and plot of sequence conservation
will be displayed. Double click to load a sequence.

3.2.6 Search UniProt

£ Hew lioksod icm L1-3: [lwbrciect*j 0 Search the UniProt Database and load
1. Select Uniprot T ™ sequence.
P LR F T 'L S
. | &
Urigant = | oz huaman o
eiorinace Parel o
no selechon £
b soqUanCEs (1 tern) 2. Enter Uniprot code %
i s ’*“”‘ij or search string -
I 23 HEGBOGT Y 5
| 431 Q.s*ma:asyrz. B
| 841 LYSIFEDQEF o
| 81 Prgfrwrrr APWMARLMALS
| 101 poFRLECYN aF
121
| 141 1
161 Y
i1 LALARNRYEY : A
| 201 YYPEALRDEY 1
221 ELAFER s
| 242 ISEREEAIGE s
| 262 ETEIEILEEL ﬂ
| 281 WHPCIIRIEN TFDAEDYYLV
| 301 LELMPGSPLF DEVYGNRRLE
| 321 EATCELYEVG MLIAVEYIHE G
| 341 HSIIMANIEE EMVILSSOEE i |
| 361 DCLIRITURG MSEILGETSL ot
| 382  METICOTETY LAPENLYSVG -
| 401 TASYNHAVDC WSLGVILFIC =
| 421 L8sYPPFIER RTOVSLEDDT &
| 441 2ASEYNPIPE VHAEVSEEAL
| 461 [LVEELLVVD PEARFTIEER
| 481 LREPHLGOED MEREFQDLLS .
Al ==
08 B0z c@a=
. #
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Step 1: Click on the search tab and select Uniprot from the drop down
menu. Enter the UniProt code. The sequence will be loaded directly into
ICM and you will seeit in the ICM workspace.

3.2.7 Search PDB by Ligand Code

To find structures containing a particular ligand in the PDB.

{# POBSearchBesults Molsoft iomm 3.7-3¢ [NewPregect *] (1 table)

1. Select Ligand Code

o8 MOz @

| Search by PD3 ligand code.

ERe i fE mBwdBbD09% 8 TE§&2414

i search
lgwitode =] ap - H
IHZeREDa0E, [ .r’“m CTRY
o seled 2. Enter code e N PO Sanrch remts for ‘ADVARCED SEARCH'
2 §H tabwes EEFTTT date
POBSsarehRmefs 3. Click here or press e
z enter key 20050103
3 F008-01-04
4 b H'fDﬁWSE 2009-01-05
S Qo STRUCTURAL PROTEM 2003-01-67
6 1322 STRUCTURAL PROTER 2004-01-07
P A0 STRUCTURAL PROTED 2003-01-08
8 13ip TRANSFERASE(PHOSOHOTRANSFERASE) 15930104
] 1nmd STRUCTURLL PROTEN 20030109
10 Zoax HETAL BBMDING PROTEM 2007-01-0%
11 ghS STRUCTURAL PROTERM, RMA BIDING PROTEM 2007-51-09
12 ZohiE Structural Proten, RIA bindeg seoten 2007-31-09
13 Zgh7 Structusal Proten, R28 fyding peoten 2007-01-09
14 foby TRAWSPORY 2006-01-10
13 Qi LIGASE 2005-01-11
16 Zogh CELL CYOLE 2008-01-16
17 | (CELL CYOLE -01-16
|| gL AL 4. Double clickte [ "
a8 ] load structure
: LICM startup file executed.. - - - -
J.rmfde}aneralSearchFromGUI "L.L gand Cod "atp" "proteinname
Info>» PDB index loaded from /Users!hndrew! icmfinx/PDB.tab
E icm/def>H

>

[ e

e D siodn &

o
s

 [od e ud fuu

eHRLS B

Step 1: Click on the search tab and select Ligand Code from the drop
down menu. Enter the Ligand code and a table of hits will be displayed.

3.2.8 Search Drug Bank

To search Drug Bank ( htt p: // www. dr ugbank. ca/)

3.2.6 Search UniProt
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el 17 3 MiewPreioct 1 0 e Search Drug Bank by key word.
1.SelectDrugBank | oo, sy pm mmam@I00s TESE8EL2
epch £y Fu
Loy Bards » | o - B =
H‘armmm_/’/\\ TN o
nosuiel 2, Enter search text ; o . O P
= tabwrs " T o - b
druy hits ; . 3. Click here or press s g .
enter key =) % |
1 P i -
h__'/ = -
3 a .
; g | B
FET 30 Clobenpeopit [
; < 3
\b .
N &
4 1 :
4. Double click to e
load structure -4
. K -
)
Al IE]
oB 5Boe caswu

Step 1: Click on the search tab and select Drug Bank from the drop down
menu. Enter a search string and atable of results will be displayed.

The table contains the original activity data without merging or
aggregation. For instance,

Chemical 1, Protein 1, Activity 1

Chemical 1, Protein 1, Activity 2

Chemical 1, Protein 2, Activity 1

Chemical 2, Protein 1, Activity 1

Click on the button Get Ligand Summary to display alist of chemicals
with all activities found in Drug Bank. The button islocated in the
extrapanel (click on hammer - top right of table panel). For instance,
Chemical 1, Protein 1, Activity 1

Protein 1, Activity 2
Protein 2, Activity 1
Protein 3, Activity 1
Chemical 2 Protein 1, Activity 1
Protein 2, Activity 1
Protein 2, Activity 2

3.2.9 Search PubChem

To search PubChem (https://pubchem.nchi.nim.nih.gov/):
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b, Search PubChem by keyword and
= wyg 2 Keywordsearch. ™ = o 1 Chemical substructure.,

3 2 L
search 4 gt
Pt %] selbutarmol Ei. * £ Appand To Remdt "‘4——{ 4. Click here to run search. ]

Workspace P. # =

3a. Substructure \’

Lﬂhuﬂstj search. J-;ce.ua o @ 8|
PubCham in
the Search b @ EERE S e By & Dﬁ%l_ﬁ
\ tab. C12H10 -
& 3b. Sketch and
# then close
window,
LA
O

2

e

o
4

0l (EHME S 6 e

Do 2

&%

ke w g |

* Click on the search tab and select PubChem from the drop down
menul.

» Enter asearch string and atable of resultswill be displayed or
click on the chemical sketch button and sketch a substructure.
When you close the chemical sketch window the smiles string will
be added to the keyword search panel.

* Click on the "binocular" button and run the search.

« A tableof hitswill be displayed.

3.3 Create New Objects

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro |l CM Chem st

In the File menu there is an option called New. This option can be used
to create new objects of the following types:

Peptide

Unusual Peptide
Compound
DNA and RNA
Sequence

Script

HTML

Table

Arrow

Box
Sphere/Ellipsoid

3.2.9 Search PubChem
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2= 0. Use the option File/New to create new |

eay Chemsty Docking MeMlachanis Hin phlects such as peptides, sequences,
L% o P G P [ o B DNA

.File/New |-
? o Dk &

=
- L
PO Samch = | i‘ = i il Fadds - H pdofieadtarriipoel | af = | proupancylaplay | Done * || gl
Werkspacs Parel @ M 4
| 2.Selectthetab | +
no selechion e b
i
{ Papade ™/ hususl Pepide \/ Conpeurd |/ TRAENA 1 Sequence 1/ Saipt 3 Himl \f Tebie A/ Amow A/ Box \f Sphere Plipacd | 4
-
Ora Lether Code EACARVALKCEAAARD - -
)
HSmrrenis Fangal HHT w  C-srminus [a's's s -
" Display Mdpody o Ay & Halie .

3. Enter details
about new object

; icm/def>y r :
icm/def>d 4. Click OK ' = i

E icm/def>R . d

im

N BRI

3.4 Open and Read Files

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro |l CM Chemi st

Any filethat ICM can understand can be opened by:
» Selecting File/Open.
A file with an extension .ich isan ICM binary file and can be viewed in

the GUI. A .icb file can contain many objects such as sequences, meshes,
protein objects, alignments, tables etc...

3.4.1 Open with Password

To open afilethat is password pr ot ect ed:

 File/Open with Password
3.4.2 Extract from icb file

Anicb fileisani cm proj ect fil e,insomeinstancesyou may want to
take objects saved in an icb file and load it in your current ICM

session. This option allows you to view atabulated list of what aich

file contains and load individual object files from it.

File/ Extract from ICB.

Locate the saved icb file.

A table as shown below will be displayed

Double-click on any of the entry to extract that object from the
icbfile.
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x|/ exarnple_alignment_.

nare | tupe zize
2 openFilePRJMAME | zhing 9
3 [1TKLA 4 | sequence 431
4 10194 17 sequence ]
5 TwWFC_5 sequence h3s
B TIaM__23 sequence 415
7 T0LE_A_4 ZEOUENCE 413
3 TqlE_a EgUENCE 07
9 2phk_a EqUEnCeE T8E
10 |alig alignment 10927
11 |1qg6E ohject 231820
12 | Z2phk ohiject 235471

3.5 Saving Files

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro || CM Chem st

Anything you have displayed in an ICM graphics session can be
conveniently stored in asinglefile called an .icb file. To do this:
» File/Save Project
or
» File/Save Project As
A .icb file can be password protected by:
File/Save with Password
Enter afile name or browse for a previously saved project.
Enter a password

Determine whether you want the file to be Fully Protected, read
only or Read Only and Allow Comments .

Any object (e.g. protein,table, alignment...) insidethe ICM GUI can be
saved by:

* Right click on the name of the object in the ICM Workspace.

+ Select"Save As’
» Choosethefile format from the "Save as Type" drop down dialog.

3.4.2 Extract fromicb file
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3.6 Making Selections

Availablein the following product(s): | CM Br owser || CM Br owser - Pro

[ CM Pro |l CM Chem st

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the |eft hand side (web version) or
by clicking the Contents button on the |eft-hand-side of the help
window in the graphical user interface.

There will be many occasions when you will have to make selections. For
example, if you want to display a particular region or molecule

contained within your protein structure or if you want to select

residues around a binding pocket. If you have a molecule displayed in

the graphics window, then selections will be displayed as green crosses.
The selection you have made is also displayed at the top of the ICM
Workspace. It is aways a good ideato keep an eye on what is selected
and what isnt.

There are four basic levels of selection

1. Object (eg aPDB structure or ICM object)

2. Molecule
3. Residue
4. Atom

Y ou can make selectionsin:

The Graphics Display

The ICM Workspace (Selections are highlighted in blue)
Tables

Sequences

Plots
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» Alignments

3.6.1 Graphical Selection Tools

The following buttons can be used to make a selection once a structure
is displayed.

Rectangular FPropagate selection to all
ﬁL atoms in residue
& |
T E ! , Te— Lasso R ef 0 W
""""" He—Pick atom
A5

Residue label

’ 2 Residues
_g_ Molecules

ﬁ. Objects

NOTE: All selection tool buttons are colored green. Graphical
selections are represented as green Crosses.

3.6.2 Quick Selection

To make a quick selection the following buttons can be used.

4 ™
Rectangular Selection = 3

| | O — Lasso Selection
Select Atom = =

=T
Al

Select Residue
\. J

To select partsof your structure:

» Click on the Rectangular selection icon and click and drag around
the part of the structure you wish to select.

OR
» Click on the Lasso selection icon and click and drag your mouse
around the area of the structure you wish to select, forming a
lasso around it.
To pick individual atoms:

» Click onthe’pick atom’ button
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3.6.3 How to Change the Selection Level and Mode

It is possible to change the level of selection before or during the
building of a selection. The selection level drop-down button can be
used to do this (see image below).

For example, a C-apha of aresidueis selected but one would like to
select all atomsin the residue. Y ou can change the level to Residues.
This selection can then be changed into all atoms of the residue by then
selecting the Atoms level again. Or you can use the Propagate Selection
to all Atoms button (see image below).

» Click on the Select objects, Select molecules, Select residues,
or Select atomsicon, depending on which part of the structure you
wish to be highlighted.

. < (i object S
| Change e Prepz?gate
. gl selection level f"@pi «% g| selectionto
“display \[ight \/ labels \/ meshes \/"seart i Atoms all atoms in
M| 4 2@ @B rese residue
ﬁ Molecules
- ﬁ Olbjects l & X

Change
selection Rl 8w

mﬂde ikl New k
LA r’ﬂﬂf_ﬁ_’ﬁ Add i

It is also important to observe the selection mode that is being used.
There are four modes:

» New: new selection replaces everything selected before

* Add: new selection is added to previous selection(s), if any

» Remove: previoudly selection (part or whole of it), if included in
the new selection will be unsel ected.

» Toggle: within the new selection, everything that has been
selected is unselected and everything that hasn ¢%ot been selected,
wilbe selected

3.6.4 How to check what is selected.
All selections are displayed as green crosses in the graphical display

and blue in the ICM Workspace. All green selections are returned to a
variable called as_graph.
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iem/lxbb>display wire a lxb All green graphical
icm/ 1xbb}und15play StDIE a selections are returned

icm/1xbhedisplay.x atick to a variable called £
as_graph

Selecﬁon are
highlighted in blue in
the ICM workspace

b"‘.. i

GHREE [

3.6.5 Orange Selection

Sometimesit is necesary to have two different selections. The Orange
selection allows you to do thisit is useful for such operations as
superposition and more technical procedures such as designing a protein
loop. The orange selection isreturned to avariable called as2_graph.

3.6.4 How to check what is selected.
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3.6.6 Clear Selection

To unselect everything you have previously selected:

e Simply click on the Clear Selection button on the selection
toolbar.

OR
¢ Right click and drag away from the displayed structure.
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3.6.7 Changing a Selection

Once you have made a selection you may wish to add or remove parts of
the selection. The buttons shown below allow you to accomplish this.

Propagate selection to all
atoms in residue

Click and o l
o LE XL

arch

e

L B
][+
=

Toadd or remove from your current selection:
» Click on the Selection mode: add or Selection mode: remove icon on
the toolbar.
 Click and drag around the part of your structure you wish to add
or remove.

You may also wish toinvert your selection in a specific part of the
structure.

The parts that are currently selected will become unselected, and the
unselected parts will become selected.

In order to invert a selection:

» Click onthelnvert icon on the toolbar.
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If you wish to select and unselect certain regions of a selection the
toggle selection button is very useful.

» Click on the Toggle selection button.
» Right click around the selections you wish to select or unselect.

NOTE: The selection you have made is recorded at the top of the ICM
workplace. Any selection is stored in the variable as_graph.

3.6.8 Filter Selection

Y ou may want to be very specific about a selection you want to make. For
example you may only want to select protein backbone atoms or you might
want to just select the charged residues.

The button shown below enables you to filter your selection:

o
Filter

Selection

Or

Right click on a selection and a menu as shown below will be displayed.

Advanced

Connect ko Malecule
Disconnect

Extract Sequencels)
Center

Six Frame Translation

“a Meighbors

Select 3

¥ Delete atom seleckion

» Select the Filter Selection option.
» A dialog box will be displayed as shown below.
» Select what level of selection you want e.g. atom or residue.
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3.6.9 Workspace Selections

e b Sigh [ od e o =

In the default GUI layout the workspace panel islocated to the | eft of
the 3D graphics display. It isagreat tool for keeping track of al

your sequences, pdb structures, objects, tables and alignments. Asyou
will seein this section it also provides away of making selections.

B

Selected atoms and
residues

g3 106 Atoms 23 Res,1 Mol 42
E| . ||h|E'|:t 1 items)

[+ cdsg

E]:I E;Equences (2 items)

w-cffBd  |en=77 Amino
HcEE len=88 Amino
Workspace E] t alignments {1 itams) |

panel P lesx ID=23% pP=27
=- @ tables (1 items) !Expand _here for more
_ L.PDBESearchResults 13 | information.

Display all J

Objects

\— Tables

Alignments

hd
|TJ=JI ER

Sequences
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3.6.10 Workspace Navigation

Once you have mastered how to navigate the ICM workspace making a
selection will become easier. Each object is divided into 3 levels:

1. Object Level - Showninredif it isthe current object. Holds
details about the structure - name, X-ray, NMR, resolution etc.
Importantly it will state whether the structure is an ICM object
or astructure straight from the PDB. To learn how to convert a
PDB into an ICM abject go to the sectiononconverti ng a PDB.
2. Molecular Level - Showsthe individual subunits, ligands and
hetatoms of a molecule.
3. Residue Level - Shows the sequence.

Current object in red
F N

no selection

n ects 3|temsj
@J ICh4
nm =cd5d Fosx 77 Aming

E|x wFay, 9.90 &
|:|m == by t;sx 77 Amino .
E|1c:rn %-Pay: 1.50 & crambin ——— Objectlevel
m 4B Aming
‘1 TTCCPSIVUAR SHFHUCRLPG

21 TPEAICATYT GCIIIPGATC — |

41 PGDYAN Residue level

Molecule level

Object information
Click to expand tree

NOTE: You can expand each level of the |ICM workspace by clicking the
"+" button as shown above.

3.6.11 How to Select an Object

To select the whole object:

» Doubleclick on the object level.

no selection J .
—u ects (3 tems) Double click here to select ALL
mj IChd currently loaded objects.
HE nm == cdhY t;sx 77 Amino
=[x %Ray 990 A
wllm =cdsd FEsx 77 Amino
---H_ Tcm  ¥-Ray 1504 crambin Double click here at the object

=lm 46 Amino level to select the whole object
1 TTCCPSIUAR SMENUCRLPEG
21 TPEAICATYT GCIIIPGATC

1 PGDYAN

Use the CTRL button to select multiple non-contiguous objects or if they
are continuous you can use double click and hold the tab button.

3.6.12 How to select a Molecule

To select a molecule(s):
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* Double click on the molecule in the ICM workspace.
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Use the CTRL button to select multiple non-contiguous molecules or if
they are continuous you can use double click and hold the tab button.

3.6.13 How to select Residues

There are different options to select residues:

OPTION 1:

¢ Click and drag over the residues you wish to select in the ICM
workspace. Selected residues will be highlighted in dark bluein
the workspace and with green crossesin the graphical display.

3.6.12 How to select a Molecule
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Selection information is recorded here

ﬁ.‘& 1H-1Atums 35 Res1 Mol1 Oby
{1 itermns)
Click here to ) s
expand treeto ———— 336 Amino OPSD
hp . id MHGLIEGPHFY [JPFSEKTEHI
] '.?WaI'I'III'IOHCI | E] nPOYYRLAEPHOF S Hi
residues, T HFLLIML GFPINFLTLY
. 61 VTUOHKKLRT PLHYILLHLA
] | 81 UADLFHUFGE FTTTLYTSLH
Click and drag . 101 [1JFUEGPTGE NLEGFFATLE
over residues 121 GEIALWSLUY LATERYUUUC
i trt— KPHSHFRFGE NHAIMGUAFT
z:;glsmo 161 WUMALACAAP PLUGWSRYIP
. 181 EGLOWSCGID YYTPHEETHM
2081 ESFUIYMFUY HFIIPLIUIF
Selected | 221 ECYGOLUFTU KEARASATTO
i ; 241 HAEKEUTRMU IIMUIAFLIC
Ir_le_sm!.le; ""3" be 261 WLPYAGUAFY IFTHOGSDFG
ighlighted in - 281 JIFMTIPAFF AKTSAUYHPU
the workspace 3081 IYIMMHKOFR HCHUTTLCCG
and graphics 321 KHPSTTUSKT ETSQUAPA
window G i i " -
Any selection is highlighted in the workspace as well as in the
3D graphics window if the structure is displayed.
OPTION 2

» Click ontherectangular selection icon or lasso selection icon on
the tool bar.

 Click and drag around the residues you wish to select. Selected
residues will be displayed by green crosses on the graphical
display and bluein the ICM workspace.

e Usethepropagate sel ection to residue | evel hutton.

OPTION 3:

» Right click on the aresidue in the graphical display and amenu
as shown here will be displayed.

Selection Dialog

Advanced r

Residue atoms »
Open with kol dit
Connect to Malecule
Dizconnect

Eutract Sequence(s)
Center

Annotate zelection
Meighbars
Clozed Cavities

Select [

Delete residue selection

* Click on Select and afurther menu will be displayed.
* Click on Residue, Molecule or Object.
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Cloged Cavities

Fesidue

W Delete residue selection
Maolecule

Object

OPTION 4:

Usethesdectr esi due button.

3.6.14 Select All

Ctrl + A will select everything in the ICM workspace, and Ctrl + Shift +
A will unselect your objects.

NOTE: The selection you have made is aways recorded at the top of
the ICM workplace. If you are familiar with using the ICM terminal
(See language manual) the atoms, residues, molecules or objects
selected interactively in the graphics window are automatically s

3.6.15 Selecting Neighbors

In some instances you may only want to display or select only a subset
of astructure. For example you may only wish to display the residues
surrounding aligand (as shown below (ligand red; graphical selection
green crosses). The " Selecting Neighbors' option selects the residues
within a shpere of adefined radius.

There are two ways of selecting neighbours to a particular atom or
residue in ICM. Either by right clicking on the atom or residue in the
graphical display or by right clicking in the ICM workspace.

3.6.14 Select Al



3.6.16 Selecting Neighbors: Graphical

To select neighboring atoms or residues around a sphere of a certain
radius:

» First select the residue(s) or atom(s) around which you wish to
select neighbors. (Seethe Sel ecti on Tool bar Secti on)

* Right click on the selection and a menu as shown below will be
displayed or choose Tools/Geometry/Neighbors.

a_x1.mjafhdz1

Filter Selection
Colar
Edit
Advanced
Connect ko Molecule
Disconneck
Extract Sequence(s)
Center
Six¢ Frame Translation
“a. MNeighbors
Select
“ Delete atom

» Select the Neigbors option and a data entry box as shown below
will be displayed.

This option will allow you to make a spherical selection.

The window will open as displayed as below:

& select Meighbors @E

Select Meighbours For | % Graphical Selection (0 mal)
Radius g, v

by pe wisible -
exclude source

unselect water

[Undisplay Bevond Selectianl

[ (8] 3 H Cancel H Help

» Select the molecule you wish to select neighbors around. For
exampleyou can sel ect aligandinthel CM Wbr kspace and then
choose the Graphical Selection option in the " Select Neighbors
For" dialog entry box. Or alternatively you can select the object
by clicking on the drop down button next to the " Select Neighbors
For" dialog entry box.

» Enter the radiusin Angstroms for the neighbor selection. e.g. 5.

» Type-thisoptionisimportant. This option relatesto what is
going to be selected. For example if you leave this option as
visible and you only have ribbon representation displayed for your
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receptor (e.g. when selecting neighbors for aligand) then only
backbone atoms will be selected.

Selection Type option includes:

» visible- will select al atoms displayed within the radius
selected.

* visiblesidechainswill select al visible side-chains - not
backbone atoms.

» same object_other_chainswill select all atomsin other chainsin
the same object as the original selection.

» other objectswill select atomsin objects other than the origina
selection.

» same object will select atoms in the same object as the original
selection.

» all_objectswill select atomsin all objects

» choose from_list will allow you to select the object you wish to
include in the neighbors selection.

» exclude sourceif checked will not include your original selection
in the spherical selection.

» unselect water if checked will not select water molecules

» Undisplay Beyond Selection will only display the atoms selected.

NOTE: The selection you have made is always recorded at the top of the
ICM workplace. If you are familiar with using the ICM terminal (See
language manual) the atoms, residues, molecules or objects selected
interactively in the graphics window are automatically saved in the
variable as_graph. Graphical selections are shown in green (crosses) or
highlighted in blue in the ICM Workspace.

3.6.17 Selecting Neighbors: Workspace

To select neighboring atoms or residuesaround a sphere of a certain
radiusfrom aresiduein the |CM workspace:

» First select the residue in the ICM workspace around which you
wish to select neighbors. (Seethe Resi due Sel ect i on)
* Right click on the selection and a menu as shown below will be

displayed.

41 PGDYAH
Filter Selection
Color 4
. Advanced 3
Selection made here
Residue atoms 4

Connect ko Malecule
Disconneck

Extract Sequencels)
Cenker

Annotate selection

Six Frame Translation

y : Meighbors

Closed Cavities

Copy ChrlC
¥ Delete

3.6.16 Slecting Neighbors: Graphical
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» Select the Neigbors option and a data entry box as shown below
will be displayed.
» Follow theinstructionsin the pr evi ous secti on.

NOTE: The selection you have made is always recorded at the top of
the ICM workplace. If you are familiar with using the ICM terminal
(See language manual) the atoms, residues, molecules or objects
selected interactively in the graphics window are automaticaly s

3.6.18 Select by Residue Number

To select by residue number:

* Right click on the molecule you wish to make the selection in and
choose Select/Res Number...
» Enter the residue numbers e.g. 3,7:12,30 Colon indicates range.

3.6.19 Alignment and Table Selections

Descriptions on how to make selectionsin Alignments and Tables arein
the sections entitled Maki ng Sel ections in Alignnents and Making Table
Selections.

3.6.20 Making Links

It is sometimes necesary to make links between sequences objects and
alignments. A link enables you to make selections in one environment
such as an alignment and then these selections are transfered to the
object such as the PDB structure displayed.

If alink is made then a symbol will be displayed next to the object in

the ICM workspace. In the example shown below subunit_a of the X-ray

structure 1916 is linked to the sequence 1g16_a and the alignment called
"dig'.

Linked to alignment 'alig’

I
unjec’cs (2 items)

Tglb  =-Ray 240 A; Jhusphorylase kinase
Bz =—1g6_a ¥F-alig 281 Amino
hatp | 1 Hetatm atp

bran | 1 Hetatm manganese +2

bmnZ | 1 Hetatm manganese +2

csod | 1 Hetatm sulfate-ion (504-)

Linked to sequence 1ql6_a

If an object islinked to an aignment a symbol as shown below will be
displayed.

_t ali'gnments (1 itermns)
Lalip S8 id=75nSeq=7

Alignment is linked to an object

To link a sequence from an object - extract the sequence from the
object.

* Right click on the object in the ICM workspace.
» Select extract sequence.
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To link a sequence and object to an alignment.
Use the extracted sequence as described above to build your alignment.
In addition alink can be made between a structure and alignment by:
» Bioinfo/Link to Structure.
» Enter aignment name.
+ OK
3.6.21 Tags

It is sometimes convenient to tag selections so you can come back and
use them at alater date. To do this:

B R RO e R { Select the region you wish to tag.
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w 8 : '
o6 B0 o o6 a9 2 WMol 0
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Step 1. Sel ect theregion you wish to tag.

3.6.20 Making Links
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Step 2. Right click on the selection and choose Annotation/Add a Tag.

B b Mook kn 391 MaPe A0 b J Enter a name for the tag along with
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Step 3. Give the tag a name and choose the selection level (atom,
residue, molecule, or object).
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Step 4. You will see thetag in the ICM Workspace. Y ou can toggle the
display on or off or select the tag by double clicking onit in the ICM
Workspace.

3.7 Preferences

Your ICM preferences can be changed by:
» Select File/Preferences.

NOTE: Thereisa"Reset to Default" button in case you make any
changes you are not happy with and also a search option.

3.7 Preferences
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3.7.1 Bonds Preferences

To change Bond Preferences:

» Select File/Preferences.
¢ Choose the Bonds tab.

GRAPHICS.ballStickRatio - A default ratio of ball and stick radii. This
ratio is applied when the styles are switched from the GUI xstick
toolbar. Default (1.4)

GRAPHICS.hbond Ball Period - Default (3)

GRAPHICS.hbondMinStrength - parameter determines the hbond strength
threshold for hbond display. The strength value is between 0. and 2. By
changing 1. to 0.2 you will see more weak hydrogen bonds. Default: (1).

GRAPHICS.hbondStyle - determines the style in which hydrogen bonds are
displayed. Here hbond-Donor, Hydrogen, and hbond-Acceptor atoms will be
referred to as D, H and A, respectively,

GRAPHICS.hetatmZoom - The default ball and stick radii of aligand can
be different by the GRAPHICS.hetatmZoom factor. This makes a better
ligand view since the ligand stands out from the surrounding protein

atoms.

GRAPHICS.stickRadius - radius (in Angstroms) of acylinder displayed as
apart of stick or xstick graphical representation of amolecule.

Individual (residue-wide) control of stick radii.

GRAPHICS.xstick Backbone Ratio - Default (1.2)

GRAPHICSxstick Style- xsti ck style
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wireBondSepar ation the distance between two paralel lines representing
achemical double bond if wireStyle = "chemistry". Default (0.2

Angstroms).

GRAPHICS.distance Label Drag - enable distance label dragging
GRAPHICS.hbondAngleShar pness determines how the strength depends on the
D-H...A(lone pair) angle. The preference can be found the genera

Preferences menu Default (1.7)

GRAPHICS.hbond Ball Style even, by atom size, by energy or telescopic
GRAPHICS.hbond Rebuild

GRAPHICS.hbondWidth relative width of adisplayed hbond .

GRAPHICS.hydrogenDisplay determines the default hydrogen display mode
for the display command.

GRAPHI CS. hydr ogenDi spl ay = "pol ar"

1 ="all" # all hydrogens are shown
2 = "polar" <-- current choice # polar displayed, the non-polar hidden
3 = "none" # no hydrogens are displayed

GRAPHICS.wire Width - relative width of wire Default (1)
GRAPHICS.xstick Hydrogen Ratio - Default (0.5)
GRAPHICSxstick Vw Ratio - Default (0.6)

Wire Style - change the default wi r e style

"wre" # Just a line
"chem stry" # shows different types of chemical bonds.
"tree" # shows a directed graph of the | Cv nol ecul ar tree

GRAPHI CS. hbondStyl e = "dash"
= "aromatic" #

AWNEF

3.7.2 Directories Preferences

DIRECTORIESTAB:
To change Directory Preferences:

» Select File/Preferences.
* Choose the Directories tab.

Within thistab you can select the default directories for:

FILTER.gz, FILTER.uue, FILTER.Z, Filter.zip alowsyou to read
compressed files .gz, .uue, .Z, and, .zip files automatically leaving

the compressed file intact.

PDB Directory Style - The style of your Protein Data Bank
directory/directories. ICM will understand all of the listed styles,
including distributions with compressed *.gz , *.bz2 and *.Z fil es
BlastDB Directory - return directory with Blast-formatted sequence files
for ICM sequence searches.Y ou can download Blast formatted databases
fromhereftp://ftp. ncbi.nih.gov/blast/db/

Dock Directory - Default directory for storing docking files.

CCP4 Directory

Editor - Select adefault text editor

3.7.2 Directories Preferences
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Inx Directory - location of stored index (*.inx) files.

Log Directory - when you quit an icm-session, a_seslog.icmfileis
automatically stored. If the s_logDir variable is empty, it is stored to
the s userDir + "/log/" directory. However one can redirect it to the

current working directory ("." ) or any other directory.

Output Directory -

PDB Directory - directory containing the PDB database of 3D structures.
Thesefiles can a so be easily downloaded directly from the PDB site if
the variables are set as in the example below. PDB distributions can
exist in severa styles (all filesin the same directory, or divided

etc.).

PDB Directory FTP

PDB Directory Web

Projects Directory - Select the default location for storing ICM
projects. Save your datain an ICM project. It isaconvenient way of
keeping all your structures, alignments, tables, docking results etc...

in one place. A description on how to save an ICM project is described
inthe GUl Basi cs section of this manual.

Prosite Dat - location of the prosite.dat file a dictionary of protein
sites and patterns, (Copyright by Amos Bairoch, Medical Biochemistry
Department, University of Geneva, Switzerland).

Ps Viewer - Select a postscript viewer

Swissprot Dat - location of swissprot.dat file

Temp Directory - scratch directory for temporary files ( some montecarlo
fileswill be saved there).

Uniprot Dat - location of uniprot.dat file

XPDB Directory - Path to the ICM XPDB database of compact binary ICM
objects which are annotated with the site information. The advantage of

the XPDB database is the speed of reading and smaller size than PDB.
XPDB entries are read about 80 times faster!

TOOL S.default ChemDB

TOOL S.eds Directory

TOOL S.pdb Read Nmr Models

1. = "first" : reads only one nodel froma nmulti-nodel (e.g. NVR) pdb file
2. ="all" : reads all nodels froma nulti-nodel (e.g. NVR) pdb file and creates a separate
3. = "all stack" : creates one object and |oads all other nodels as a stored cartesian stac

3.7.3 Graphics Preferences

To change Graphics Preferences:

» Select File/Preferences.
» Choose the Graphicstab.

Atom Single Style - display style of isolated atoms in the wire mode.

1. "tetrahedron"
2. "cross"
3 "dot"

GRAPHICS.clash Style - choose clash length, strain or length.
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GRAPHICS.clip Grabs - enable grob clipping.
GRAPHICS.clip Static -

GRAPHICS.grobLineWidth - relative width of displayed lines of 3D meshes
(grobs). Also affects the interatomic distance display.

GRAPHICSlightPosition - X ,Y and Z posiion of the light sourcein the
graphics window. The X and Y coordinates are usually slightly@@ beyond
the[-1. 1] range where [-1.,1.] isthe size of the window, and the Z

position is perpendicular to the screen and is set to 2. (do not make it
negative).

GRAPHI CS.occupancyDisplay preference controlling if and how the
partical or zero atom occupancies are displayed. The abnormal
occupanices are shown as circles around atoms. These following values

are alowed.
1. = "none" # nothing is displayed
2. ="circle" # acircle is displayed
3. ="label" # a circle and a lable with the value (zero values are not shown)

GRAPHICS.quality - integer parameter controlling quality (density of
graphical elements) of such representations as cpk, ball, stick, ribbon
. Do not make it larger than about 20 or smaller than 1.

GRAPHICSruler Style- change ruler from center to side

GRAPHICS.stereoMode - 1. "up-and-down", 2. "line interleaved” 3.
"in-a-window"

» asimple hardware stereo mode for workstations with a horizontal
frame splitter.

* Inthe"up-and-down" mode alonger frame with two stereo images on
top of each other is generated and the two halves are then
superimposed with the splitter. This mode does not require
anything from a graphics card, but does require a frame splitter.

A frame splitter box was connected between a monitor and a
graphics card output. This mode has an unpleasant side effect, the
rest of the screen (beyond the OpenGl window) becomes stretched
and the lower part of the screen is superimposed on the top half.

e The"lineinterleaved" mode can be used with a new type of frame
splitter at the line level. In this case the odd lines from one
stereo-image are interleaved with the even lines of another. The
side-effect of this mode is that the intensity is reduced in half
since at each moment one sees only one half of thelines. The
splitter device for this mode can be purchased from Virex
(www.virex.com). This mode produces adark stereo image but is
easily available (requires stereo goggles, e.g. from Virex).

» The"in-aswindow" mode isused in SGI workstations and in a Linux
workstation with an advanced graphics card supporting a quad
graphics buffer. In this mode the hardware stereo regime applies
only to an OpenGl window. Thisis the best mode but it requires an
expensive graphics card (plus the stereo goggles).

GRAPHICS.surfaceDotDensity - Determines the number of dots per square
Angstrom on the graphical solvent accessible surface.

GRAPHICS.surfaceProbeRadius - An increment to the van der Waals radii
of atoms at thich the dotted atomic surface is calculated. It is used by

the display surface command to display dotted van der Waals surface. If

the GRAPHICS.surfaceProbeRadius is set to 1.4 the surface becames
equivalent to the solvent accessible surface with a probe of 1.4A

GROB.arrowRadius - areal arrow radiusin Angstoms used by the Grob(
"ARROW", R ) function. Default: 0.5.

3.7.3 Graphics Preferences
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GROB.contour Sigmal ncrement - area increment in the sigmalevel used
to re-contour an electron density map using the make grob m_eds add
r_increment command. This parameter is used in the GUI when plus and
minus are pressed.

GROB.relArrow Size - aredl ratio of the arrow head radius to the arrow
radius. This parameter is used by the Grob( "ARROW", R_) function.
Default: 3.0.

shineStyle - defines how solid surfaces of cpk , skin and grobs reflect
light. Possibilities:

1. "white" <- default
2. "color"

The first option gives amore shiny and greasy look.

GRAPHICS.center Follows Clipping - determine the function of center
button.

GRAPHICS.clashWidth - relative width of adisplayed clash .
GRAPHICS.clip Skin - enable skin clipping.

GRAPHICS.displayM apBox - controlsif the bounding box of amap is
displayed

GRAPHICSlight - ararray of 13 elements between 0. and 1. which
controls the main properties of lighting model in GL.

GRAPHICS.mapLineWidth - relative width of lines and dots of a displayed
map.

GRAPHICS.occupancy Radius Ratio - preference controlling the radius of
the partical or zero atom occupancies

GRAPHICSresize Keep Scale

GRAPHICS.selectionStyle - preference for the style in which the
graphical selection is shown. The preference may have the following
values.

GRAPHI C.store Display - maintains representation and coloring for an
object.

GRAPHI CS.surfaceDotSize - Determines the size of the dot on the solvent
accessible graphical surface.

GRAPHICS.transparency - Two parameters regulating the transparency of
grobs.

GROB.atomSpher eRadius - default radius (in Angstroms) which is used to
select a patch on the surface of a grob.

GROB.relArrowHead - ared ratio of the arrow head radius to the arrow
radius.

lineWidth - the real width of lines used to display the wire
representation of chemical bonds.

3.7.4 GUI Preferences
GUI TAB:
The options contained within the Preferences/Gui tab are described

below.
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GRAPHICS.alignment Rainbow - This option controls how alignments are
colored by defaullt.

GRAPHICS.NtoC Rainbow - Controls the coloring of structural
representation from the N-terminal to the C-terminal

GRAPHICS.rocking - Controlsdefault r ocki ng noti on.
GRAPHICS.rocking Speed - Controls rocking or rotation speed.
GUI.auto Save Interval - Controls auto save period (minutes)
GUI.table Row Mark Colors- Controls colors used for marking tables.

GUI.workspaceT abStyle - Controls the style of ICM-object tabs created
inthewor kspace panel of ICM GUI.

M ovie.fade Nof Frames - Controls number of frames for the fade out
optioninscr eenshot mnovi e making.

Movie.quality - Controls the resoltuion of the movie
SEQUENCE.site Colors - Controls coloring of squence sites.

SLIDE.ignore Fog - Fog representations can beignored in sl i de
preparation if desired.

GRAPHI CS.discrete Rainbow -

GRAPHICS.rainbow Bar Style - determinesif and where the color bar will
appear after amoleculeis colored by an array.

GRAPHICS.rocking Range - real value of rocking range.

GUI .auto Save - auto save on or off

GUI.max Sequence L ength - maximum segquence length displayed in ICM
GUIl.workspace Folder Style- Wor kspace folder style.

MOVIE.frame Grab Mode - with scr eenshot novi e making you can choose
either fixed frame time or real time.

Movie.quality Auto - withscr eenshot novi e making you can alow ICM to
control the movie resolution.

SLIDE.ignore Background Color - Ignore background color when you are
making asl i de.

3.7.5 GUI Preferences

To change GUI Preferences:

» Select File/Preferences.
e Choose the GUI tab.

Quality - controls the quality (density of graphical elements) of such
representations as cpk, ball, stick, ribbon . Do not make it larger than

about 20 or smaller than 1. We recommend to make this parameter at least
15 if you want to make a high quality image. Y ou can a so increase the
number of image resolution by making the image window 2,3,4 times larger
(in the example below it is 2 times larger) than the displayed window.

Wire Style - Four different wire styles are available.

3.7.5 GUI Preferences
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Hydrogen Display - Select whether you always want all hydorgens
displayed or just-polar hydrogens or no hydrogens at all.

Rainbow Scale - determines if and where the color bar will appear after
amoleculeis colored by an array. Coloring by an array is one of the
options of the display and color commands.

"left" <- default choice
"right"

"no text"

"no bar"

PwnE

Ball Ratio - Theratio of ball and stick radii. Thisratio is applied
when the styles are switched to xstick from the GUI xstick toolbar.

Selection Style - Change the graphical display of your selections.
Default is agreen cross.

Clash Threshold - aclash is defined as an interatomic distance less
than a sum of van der Waals radii of two atoms of interest multiplied by
the clashThreshold parameter. For hydrogen bonded atoms, the distance
threshold is additionally reduced by 20% . Default = 0.82

DotSurfaceRadiusl ncrement - adius of a probe sphere used to display a
dotted surface of amolecule. All van der Waalsradii are expanded by

this value. vwExpand=0 corresponds to the CPK surface, vwExpand=1.4
corresponds to the water-accessible surface. Be aware of the difference
between the waterRadius and vwExpand parameters. waterRadiusisused in

show energy "sf"

show [arealvolume] skin

display skin while vwExpand isused in
show [arealvolume] surface

display surface

Defaullt (1.4).

H Bond Style - How do you wish your H-Bonds to be displayed by default?
Dashes, Bond Length, Bond Lenght and Angle.

grobLineWidth - relative width of displayed lines of 3D meshes ( grobs
). Also affects the interatomic distance display.

general linewith - the real width of lines used to display the wire
representation of chemical bonds. See also IMAGE.lineWidth parameter
which controls line thickness in molecular images generated by the write
postscript command, and the PLOT.lineWidth which controls the width for
the plot command. Default (1.0)

single atom as - display style of isolated atoms in the wire mode.

. "tetrahedron”
. "cross"
. "dot"

1
2
3
The size of the first two representation is controlled by the GRAPHI CS. bal | Radi us paraneter an

xstickhetatomzZoom - The default ball and stick radii of aligand can be
different. This makes a better ligand view since the ligand stands out
from the surrounding protein atoms.

solid shine style - choose either white or color

Stick Radius - radius (in Angstroms) of a cylinder displayed as a part

of stick or xstick graphical representation of amolecule. Individual
(residue-wide) control of stick radii.

Stereo Mode - Select adefault stereo mode
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Display Style - A default display style can be chosen using a
combination of styles.

Water Radius - radius of water sphere which is used to calculate an
analytical molecular surface (referred to as skin) as well asthe
solvent-accessible surface (centers of water spheres).

clashWidth - relative width of adisplayed clash.
hbondWidth - relative width of hydrogen bond display
mapLineWidth - relative width of lines and dots of a displayed map.

3.7.6 Image Preferences

To change Image Preferences:

» Select File/Preferences.
» Choose the Image tab.

IMAGE.color - logical to save color or black_and white ("bw’) images.

IMAGE.gammaCorrection - real variable to to lighten or darken the image
by changing the gamma parameter. A gamma value that is greater than 1.0
will lighten the printed picture, while agamma value that isless that

1.0 will darken it.

IMAGE.lineWidth - thisreal parameter specifies the default line width
for the postscript lines.

IMAGE.orientation - image orientation.

IMAGE.previewer - astring parameter to specify the externa filter
which creates a rough binary (pixmap) postscript preview and adds it to
the header of the ICM-generated high resolution bitmap or vectorized
postscript files saved by the write image postscript, and write

postscript , respectively .

IMAGE.print - unix command for printer.

IMAGE.scale - real variable. If non zero, controls the image scale with
respect to the screen image size.

IMAGE.stereoBase - real variable to define the stereo base (separation
between two stereo panels) in the write image postscript and write
postscript command.

IMAGE.writeScale - an integer parameter used to increase the image
resolutioninthe Qui ck 1 mage Wite tool .

IMAGE.bondL ength2D - real length of achemica bond (ininches) in
chemical 2D drawings upon the Copy Image command.

IMAGE.compress - logical to toggle simple lossless compression, standard
for .tif files. This compression is required to be implemented in all
TIFF-reading programs.

IMAGE.generateAlpha - logical to toggle generation of the alpha
(opacity) channel for the SGI rgb, tif and png image files to make the
pixels of the background color transparent.

IMAGE.lineWidth2D - integer thickness of bonds in chemical 2D drawing
upon the Copy Image command. Thisis useful for cutting and pasting from
ICM to external documnents.

IMAGE.paper Size - specify paper size.

3.7.6 Image Preferences
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IMAGE.previewResolution - integer resolution of the rough bitmap
preview added to the vectorized postscript file in lines per inch.

IMAGE.printer DPI - thisinteger parameter the printer resolution in Dot
Per Inch (DPI). Important for the write image postscript command.

IMAGE.stereoAngle - real variable to define stereo angle (relative
rotation of two stereo images) in the write image postscript and write
postscript command.

IMAGE.stereoText - logical to make text labels for only one panel or
both panels of the stereo diagram.

3.7.7 Label Preferences

To change Label Preferences:

» Select File/Preferences.
* Choose the L abels tab.

atomL abel Style style of atom labels invoked by clicking on an theat om
| abel button.

GRAPHICS.displayLinel abels - enableg/disables the display of edge
lengths (inter-point distances) of a grob generated with the Grob(

"distance" .. ) function.

GRAPHICS.font Line Spacing - Change the spacing between lines in labels.

GRAPHICSresLabelDrag - if yes, enables dragging of the displayed
residue |abels with the middle mouse button.

GRAPHICS. site Arrow - Highlight sites with an arrow yes or no.

Show Res Code I n Selection - When you make a selection the icm selection
language will be displayed when you right click on the selection.

ResLabel Style- Defaultr esi due | abel style.

SITE.label Style- Default | abel sites style

Var Label Style- Default | abel vari abl e style.
GRAPHICS.atomL abel Shift - a non-negative integer number of spaces
preceding an atom label. This parameter is useful for displaying labels
next to a solid representation,

GRAPHICS.fontColor - set font color

GRAPHICS.font Scale - set font size

GRAPHICS.site Labd Shift - GRAPHICS.resL abel Shift a non-negative
integer number of spaces preceding asite label.

GRAPHICS. site Label Drag - if yes, enables dragging of the displayed
site |abels with the middle mouse button.

Res L abel Shift - a non-negative integer number of spaces preceding a
residue labdl. This parameter is useful for displaying residue labels
next to a solid

SITE.labelOffset - (default 5. A) the real offset of the site label with
respect to the residue label atom.

SITE.wrap Comment - Number of characters per comment line.
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3.7.8 Plot Preferences

To change Plot Preferences:

» Select File/Preferences.
» Choose the Plot tab.

PLOT.color - logical to generate a color plot. Usually it does not make
sense to switch it off because your b/w printer will interpret the color
postscript just fine anyway.

PLOT.draw Ticslogica yesor no

PLOT .fontSizereal font size. Any reasonable number from 3. (1 mm, use a
magnifying glass then) to 96.

PLOT.lineWidth - real line width for graphs (not the frame and tics)
PLOT.markSize - real mark sizein points. Allowed mark types: line,

Ccross, square, triangle, diamond, circle, star, dstar, bar, dot, SQUARE,

TRIANGLE, DIAMOND, CIRCLE, STAR, DSTAR, BAR. Uppercase words indicate
filled marks.

PLOT .paper Size - preference to specify plor paper size

PLOT.rainbowsStyle - preference defining the color spectrum used by the
plot area command.

PLOT.Yratio - real aspect ratio of the ICM plot frame. Using link option
of the plot command is equivalent to setting thisvariableto 1.0. If
PLOT.Yratioisset to 0., the ratio will be set automatically to fill

out the available box optimally.

[PLOT.date} - display date on plot

PLOT .font - preference for the title/legend font.

PL OT .labelFont - preference for the data point label font.

PLOT.logo - logical switch for the ICM-logo on the plot.

PLOT .orientation - preference for the plot orientation.

PLOT .previewer - command to local ps viewer

PL OT .seriesL abels - preference to indicate position of a series/color
legend inside the plot frame.

3.7.9 Ribbon Preferences

To change Ribbon Preferences:

» Select File/Preferences.
» Choose the Ribbon tab.

Combo Display Style - select ribbon-cpk, atoms, ribbon-ligand, chemical

GRAPHICS.dnaRibbonRatio - rea ratio of depth to width for the DNA
ribbon .

GRAPHICS.dnaRibbonWorm - logical which, if yes, makes the DNA backbone
ribbon round, rather than rectangular. Default: no

GRAPHICS.dnaWormRadius - real radius of the worm representing bases in
DNA ribbon .
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GRAPHICS.ribbonWidth - rea width of the protein ribbon .

GRAPHICS.wormRadius - radius of coiled segments (i.e. those where the
secondary structureismarked as™_") of a polypeptide chain in ribbon
representation. Default (0.3).

Ribbon Style - specifies default stylewhen r i bbon is displayed.

GRAPHICS.dnaBallRadius - DNA basesin ribbon representation are shown
as balls controlled by thisreal parameter.

GRAPHICS.dnaRibbonWidth - real width (in Angstroms) of the DNA ribbon .

GRAPHICS.dnaStickRadius - real radius of the sticks representing bases
in DNA ribbon .

GRAPHICSribbonRatio - real ratio of depth to width for the protein
ribbon .

GRAPHICS.ribbonWorm - logical parameter, if yes, makes the ribbon round,
rather than rectangular.

ribbonColor Style -

ets the ribbon coloring schene.

3.7.10 Shell Preferences

To change Shell Preferences:

» Select File/Preferences.
* Choose the Shell tab.

Clash Threshold - aclash is defined as an interatomic distance less
than a sum of van der Waals radii of two atoms of interest multiplied by
the clashThreshold parameter.

Map Sigma Level - (in Rmsd values over the mean value). Margin value
used for making graphical objects contouring the 3D density map .

Mnconf - maximal number of conformations in the conformational stack .
The stack stops growing after this number is achieved and starts

replacing representative conformations with higher energy values by new
conformations with superior energies, if the latter are found.

Icm Prompt - defines the ICM-prompt string.

Select Min Grad - default minimal gradient vector length for gradient
atom selection (a //G). This parameter is also used by the montecarlo
fast command, which requires avalue of 2. to 10. for optimal
performance.

Map Atom Margin - Margin in Angstoms around selected atoms. The margin
is added to the positional boundaries to define a submap index box in
the Map ( map_source, as_) function.

maxColor Potential - local electrostatic potential in kcal/e.u.charge
units at which the surface element is colored by extreme red or extreme
blue. All higher values will have the same color. This absolute scaling
is convenient to develop afeeling of electrostatic properties of
molecular surfaces.
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mnSolutions - this parameter limits the number of hits retained by the
program after a search.

Real Format - format of real numbers

Water Radius - radius of water sphere which is used to calculate an
analytical molecular surface

3.7.11 System Preferences

To change System Preferences:

» Select File/Preferences.
e Choose the System tab.

FTP.createFile -

FTP.proxy - string path to the proxy server for connections through
firewall. Default: " (empty string).

GUI.max Nof Recent Files - maximum number of r ecent fil es stored.
GUI.splash Screen Image - path to splash image displayed on startup
HTTP. support Cookies - http support cookies yes or no

HTTP.user Agent - client application used within a particular network
protocol for www

Beep - warning beep yes or no

Max File Size Mb - Maximu file size in MegaBytes that can be loaded into
ICM.

USER.friends
USER.organization

FTP.keep File - (default no). If yes, the temporary fileiskept in the
s _tempDir directory. Otherwise the fileis deleted.

GUI.enumberation Memory Limit - memory limit for enumeration operations.

GUI.splash Screen Delay

HTTP.proxy - string for HTTP server for connection through firewall
HTTP.timeout - timeout in seconds

Http Read Styleicm or lynx

Force Auto Bond Typing - yesno

USER.email, USER.full Name, USER.phone

3.7.10 Shell Preferences
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4 Protein Structure

Chapter Contents:

Binding Site Display Tools.

Crystal | ographi c Anal ysis Tool s.

Pr ot ei n Super position.

Protein Structure Analysis.

Protein Structure Prediction Tools e.g. ICM Pocket Finder.

4.1 Convert to ICM Object

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro |l CM Chem st

4.1.1 Load a Protein Structure

There are a couple of waysto read into ICM a protein structure.

1. Searchthe PDB using the Sear ch Tab.
2. LoadinaPDB file that you have saved on your computer using
Fi | e/ Open.

4.1.2 Converting PDB Files Into ICM Objects

If you are going to make any type of energy calculationin ICM (eg

docking, display H-bonds, display electrostatic and binding property

surfaces etc..) it is necesary to convert aprotein or chemical into an

ICM object. Be aware that upon conversion ICM adds missing side-chain

atoms (but wont try to build missing loops) due to the nature of the

internal -coordinate system. The list of residues/ atoms added is

presented in the command line shell and can be reviewed. For reference,

the original PDB entry is kept in the system. See the command line

manual for amoreconpl et e descri pti on of what the conversion process
does.

NOTE: Before converting a protein structure to an ICM object make
sure that the chemicals contained within the structure (e.g. ligands)
are correct. If an error is found you can edit the ligand as

described here.

Toconvert a PDB structureinto an ICM object follow the steps shown
below:

4 Protein Structure

How to Convert Proteins and Chenicals to | CM bj ects.
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» Right click on the name of the protein you wish to convert in the
| CM Wor kspace.

» A dialog box will be displayed as shown below.

» If you want to delete the water molecules select Delete Waters

« If you want to optimize hydrogen atoms (recommended for important
work) select Optimize Hydr ogens. This option performs global
optimization of hydrogens to find the best hydrogen bonding
network.

* If you want to optimize the orientation of His, Pro, Asn, GIn, Cys
residues then choose optimizeHisProAsnGInCys. The following
residues will be further optimized: His - three protonation states
and two rotations will be tried and the residue will be renamed
according to its subtype: hie (epsilon tautomer) or hip (+). Asn
and GIn - (a 180 deg. flip will be tried). Cys - in the vicinity
of Zn, Cu, Fe and Co to cym.

» If you want to keep a copy of your PDB file uncheck the option
replaceoriginal.

» The converted structure can be displayed immediately by checking
display the result

e Uncheck the box hide missing side chainsif you want ICM to build
missing heavy atoms that are not reported in the PDB (due to the
lack of density), they will be added according to the residue name
and assigned zero occupancies. Check this box if you want residues
missing heavy atoms to be hidden.
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If your object isan ICM object it will display ICM next to the molecule
in the ICM Workspace.
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4.2 Pocket Display

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

4.2.1 Receptor Pocket Surface.

Todisplay the Receptor Pocket Surface:

» Asan example we will use the PDB structure 1STP. Type 1STPin the
pdb search tab and pressreturn.

» Convert theproteintoan ICM object. If you do not convert a
generic surface will be displayed that is not colored by binding
property.

» Right click on the ligand "abtn" and select Pocket/Receptor
Pocket.

» Select whether you would like to display side-chain hydrogen bonds
and label.

» The receptor pocket will be displayed colored by binding property
- White=aromatic lipophilic, Green=non-aromatic other (mostly
aliphatic) lipophilic surface, Red=hydrogen bonding acceptor
potential, Blue=hydrogen bond donor potential.

» The surface can be toggled on and off by selecting in the ICM
Workspace in the meshes section.

4.2 Pocket Display
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4.2.2 Ligand Surface.

TheLigand Surface option allows you to visualize cavitiesthat are open
for ligand modifications. To display the Ligand Surface:

¢ Asan example we will use the PDB structure 1STP. Type 1STPin the
pdb search tab and pressreturn.

e Convert theproteintoanICM object. If you do not convert a
generic surface will be displayed that is not colored by binding
property.

« Right click on the ligand "abtn" and select Pocket/Ligand Surface.

¢ The Ligand Surface will be displayed colored by binding property -
White=aromatic lipophilic, Green=non-aromatic other (mostly
aliphatic) lipophilic surface, Red=hydrogen bonding acceptor
potential, Blue=hydrogen bond donor potential.
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4.2.3 How to Display Hydrogen Bonds

NOTE: The method by which hydrogen bonds are calculated is described
her e in the command line manual. The GRAPHICS.hbondMinStrength
parameter determines the hbond strength threshold for hbond display.
The strength value is between 0. and 2. By changing 1. to 0.2 you

will see more weak hydrogen bonds.

 Inorder to display energy related properties we need to convert
the PDB fileinto an ICM object. Convert 1STPintoan|ICM object.
In this example, the option "Replace the Original" was selected.

» Display the receptor in wire format and the ligand in xstick.

» Right click on the ligand and select "Neighbors" - Enter 3
Angstroms and Type = Visible. Do not exclude source (the ligand)
therefore remove tick from box entitled "exclude source'.

» Select the display tab and then select the Display H-Bond button.

4.2.2 Ligand Surface.




How to display hydrogen bonds,

1. Convert to
1ICM Object

3. Click on the EfTea8il
hydrogen bond
atom in the }f {*"i] i @0
display tab “ [ "“x\/ ~
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i display here
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NOTE: Different options for displaying the H-bond can be accessed by
clicking and holding on the H-bond button in the "Display" tab. The
coloring of the H-bonds are red (strong - thick spheres) to blue

(weak - thin spheres). Once the hydrogen bonds have been displayed
they can be displayed and undisplayed in the 3D |abels section of the
ICM Workspace (left hand side of graphical window).

4.2.3.1 Edit Hydrogen Bond Label

To edit a hydrogen bond label
* Right click on thelabel.

» Choose Edit Label.
» Make changesin the dialog box and press OK.

98 4.2.3 How to Display Hydrogen Bonds
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4.2.3.2 Move Hydrogen Bond Label

To move a hydrogen bond label

¢ Right click on the label.

¢ Click on the label using the middle mouse button.

4.2.3 How to Display Hydrogen Bonds



* Hold the middle mouse button down and drag.
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4.2.4 Ligand Pocket Interactions

To view the ligand pocket interactions.
¢ Right click on the ligand and choose Pocket.

¢ Choose Ligand Pocket Interactions. Hydrogen bonds, key waters and
neighboring residues will be displayed.
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4.3 Crystallographic Analysis

Availablein the following product(s): | CM Br owser - Pro || CM Pro
4.3.1 Crystallographic Neighbor

Theory

Molecular objects and 3D density maps may contain information about
crystall ographic symmetry. It consists of the following parameters:

1. Crystallographic group eg. P2121 that determine N (depends on a
group) transformations for the atoms in the asymetric unit.
2. Crystalographic cell parameters A, B, C, Alpha, Beta and Gamma

To generate the coordinates within one cell one needsto apply N
transformations and then to generate neigboring cells the content of one
cell needs to be translated in space according to the cell position.

ICM has a function which generates crystall ographic neighbors for the
selected atoms. For large proteinsit isimpractical to generate
neighbors for the whole molecule due to the high number of atomsin all
neighboring molecules.

4.3 Crystallographic Analysis

101



Thisinformation allows to generate symmetry related parts of the
density or molecular objects.

To generate symmetry related molecules around a selection of atoms:

» Read aPDB fileinto ICM. For instruction see the section entitled
Search PDB.

» Display the structure and select the residues around which the
symmetry will be generated. For information on how to select
residues seethe Maki ng G- aphi cal Sel ecti ons section.

» Select the menu Tools/Xray/Crystallograhic Neighbors.

A data entry box as shown below will be displayed.
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» Check that the selection is correct in the I nput Selection box.

 Enter the radius around your selction from which you wish to
construct the symmetry related molecules.

 |f you have made symmetry related molecules previously you can
select appendT oPr eviousNeighbor s otherwise leave unchecked.

* The extendResidueWindowsBYy option will allow awindow of residues
outside of the selection radius selected above to be displayed

* If you leave the keepEntireChain unchecked then a fragment of each
neighbor will be created. If you check this box the full neighbor
will be generated

» Check display symmmetry neighbors to display them in the graphics
window. The nearest neighbor residues will be displayed in xstick
representation and the each neighbor colored by molecule.

» Click OK.

The crystallographic symmetry neighbors will be displayed in the
Workspace. By default the object will have the object name + "Sym" and
each of the neighbors will be individual molecules.

For packing analysis and display you can color each symmetry unit a

different color asdescribed inthe St r uct ur al Represent ati ons Col or
sect i on. Thisisshown in the picture below.
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4.3.2 Crystallographic Cell

Theory

The crysta structure of a protein is often discussed in terms of its

unit cell. The unit cell isabox containing one or more motifs, a
spatial arrangement of atoms. The units cellsaretiled in
three-dimensional space to describe the crystal. The unit cell isgiven
by its lattice parameters, the length of the cell edges and the angles
between them, while the positions of the atomsinside the unit cell are
described by the set of atomic positions measured from alattice point.

To display the crystal cell of a PDB structure:

¢ Read aPDB fileinto ICM. For instruction see the section entitled
Sear ch PDB.

« Select the whole object. Y ou can do this by double clicking on the
name of the structurein the ICM Workspace (a selection is
highlighted blue in the ICM Workspace and green crosses in the
graphical display) or you can use the right-click button and drag
it over the whole structure in the graphical display.

¢ Select the menu Tools/Xray/Crystallograhic Cell and a data entry
box will be displayed.

e Click OK

The crystallographic cell will be displayed as a box as shown below.

4.3.2 Crystallographic Cell
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4.3.3 Biomolecule Generator

Theory

It isvery useful to know how a protein from the PDB may look in a
biological environment. The PDB entries solved by X-ray crystallography
and deposited in the PDB contain the information about the crystal
structure rather than the biologically relevant structure. For example,

for aviral capsid only one instance of capsid protein complex will be
deposited and only one or two molecules of haemoglobin that is a
tetramer in solution maybe deposited.

In some other cases the asymetric unit may contain more than one copy of
abiologically monomeric protein. ICM reads the biological unit
information and has atool to generate a biological unit. Not every PDB
entry has the biological unit information.

A gallery of images created using the ICM Biomolecule generator is shown
below:

Left: PDB: 1DWN Bacteriophage Pp7 From Pseudomonas Aeruginosa At 3.7 A
Resolution Right: PDB: 1C8E Feline Panleukopenia Virus Empty Capsid
Structure At 3.0 A Resolution
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Left: PDB: 1AL2 P1/Mahoney Poliovirus, Single Site Mutant V1160l At 2.9
A Resolution Right: PDB: 1LP3 Adeno-Associated Virus (Aav-2), A Vector
For Human Gene Therapy At 3.0 A Resolution

NOTE: Right click on a PDB structure in the ICM workspace to
determine whether a structure from the PDB has biological unit
information. If it does have this information then there will be an
option in the menu entitiled "Generate Biomolecules' if not the
option will be blanked out.

To generate a biological unit with ICM:

* Sel ect theobject or PDB file.
» Select the menu Tools/Xray/Biomolecule Generator.

» Tick the makeAllBiomolecules box.
» Click OK - with very large molecules the biomol ecul e generation
may take some time.

4.3.4 Get Electron Density Map

Theory

An electron density map is a representation of acrystal structure based
on the diffraction data. The map is constructed by a summation of waves
of known phase, amplitude and frequency using Fourier transform. The
electron density map of a protein can be viewed along with the pdb
structure. The easiest way to view the electron density map isto

contour and convert it into a graphical object (mesh).

A figure showing the electron density contours surrounding the ATP
moleculein pdb entry 1ATP.

4.3.4 Get Electron Density Map
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Toload an electron density map:

» Tools/Xray/Get Electron Density Map

» Enter the PDB code of the map you would like to view.

* Click OK and the map will be downloaded from the Uppsala Electron
Density Server.

The map will be represented in the ICM Workspace as shown below.

ICM Workspace

no selection u
-l objects (1 itern)
- mlTatp  [1] %-Ray, 2.204
=6 maps (1 item)

Ll latp size= 2471 K

I Name of map

Display and undisplay map here

The map can be displayed as shown below however a clearer way of
representing the density is to contour the map into a graphical object
(mesh) as described in the following section.
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4.3.5 Map’s Original Cell

Todisplay theoriginal cryst al | ographi ¢ cel | of an electron density
map:

» Toolg/Xray/Map's Original Cell

 Enter the name of the map or use the drop-down button to locate
it. If you do not know the name of the map the name can be located
in the ICM Workspace.

e Click OK and the cell will be displayed. The map can be displayed
and undisplayed in the meshes section of the ICM Workspace.

Generated cell

H- |a | 454
-l meshes | (1 item)
. =[EgCelMap  v=BI=1:
= maps (1 item)

L] m_ Zhdw size= 94

MName of map
4.3.6 Contour Electron Density Map

To contour an electron density map and display asa graphical object:

» Load an electron density map as described earlier inthe Load Map
section.

* Readinthe PDB file - File/lLoad PDB or use the PDB search tab.

e Toolsg/Xray/Contour Electron Density.

» Enter the name of the map e.g. m_1cdg - the name of the map is

displayed in the ICM Workspace or use the drop down arrow to
locateit.
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« If nothing is displayed then the whole map will be contoured. If
you only want to contour a particular region of the map then you
needto sel ect theregion to be contoured (e.g.the binding pocket)
and then select the option Trim to Selection Vicinity.
¢ Enter asigmalevel value for more information see:
http://ww. nol soft. conf man/ real s. ht Ml #mapSi gnalLevel . Oncethe
contoured map has been created the sigma level can be changed
manually using the +/- buttons in the ICM workspace. Two contour
levelsat 1 and 2.5 sigma respectively are generated for the 2Fo -
Fc map
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The sigmalevel can be changed interactively in the ICM workspace as
shown below.

E B meshes (2 items)

{Jg_tatp_ 1 1.80:
- ~EXo tatp 2 16
=) maﬁs (3 items)

Click here to increase or decrease
the sigma level of the contouring

NOTE: Meshes can be cut away using thenesh cl i ppi ng t ool s.
4.3.7 Convert Xray Density to Grid

For some applications, such astrying to fit a structure to a density
map, you may want to extract a sub map and convert to agrid. Y ou can do
this by

» First read into ICM amap (eg File/Open or Tools/X-ray/Get

Electron Density Map)
¢ Tools/X-ray/Convert Xray Density to Grid
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» Enter the map name or use the drop down list
e Enteragridsize
* Click OK

4.4 Protein Superposition

Availablein the following product(s): | CM Br owser - Pro || CM Pro

e

$e

!

Superimpose
Button

One or more proteins can be superimposed. Simply select

the molecules or parts of the molecules you wish to superimpose and then

use the selection of protein superimpose tools described in this

section. A convenient superimpose button can befoundinthe Di spl ay tab
(seeimage of button (left).

Chapter Contents:

Sel ect Proteins for Superposition

Superi nmpose Button

Superi nmpose by 3D

Superi nmpose Miultiple Proteins

Arrange as Gid

Superinmpose Sites by Atonmic Property Fields

4.4.1 Select Proteins for Superposition

Before any superposition operation can be undertaken you need to select
the protein structures you wish to superimpose.

One way to do thisis by selecting in the ICM workspace. For other
selection tools please see the Maki ng Sel ect i ons section of the manual.

» Select both receptors by double clicking on the name of the
moleculein the ICM Workspace. To select two molecules use the
Ctrl button or use the shift button to select arange of objects
in the ICM Workspace. A receptor which is selected will be
highlighted in blue in the ICM Workspace and with green crosses in

the graphical display.

4.3.7 Convert Xray Density to Grid
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Superimpose the kinase structures.
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Once the molecules are selected you can then superimpose them using the
options described in the next section of this manual.

4.4.2 Superimpose Button

A convenient way to superimpose two moleculesis by using the
superimpose button in the display tab, ICM will calculate the Ca-atom,
backbone atom and heavy atom differences between the two structures.

More advanced superimpose options can be found in the Tools/Superimpose
menu.

To superimpose;

» First load the two structuresinto ICM.

» Select which parts or all of the two structure you wish to
superimpose (see the chapter on Sel ect i ons or the description
protein-superposition-select{ here} .).

» Select the display tab (previously called Advanced tab) at the top
of the GUI.

» Select the superimpose button.

i)

LY

Superimpose
Button

The rmsd will be displayed in the terminal window as shown below:
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LHTUS U dLUNS SUPET LNPpUSEU, FTNsU—1.90 104D

icm/1yé6> superimpose { Res{ as graph ) & a_./fca,c,n,0 ) & 0bj{ as _graph )[1]
Warning> [118] skipped 4 atom pairs with zero occupancies

Info> 64 atoms superimposed, rmsd=1.381643

icm/1y6>

4 |

RMSD displayed here

NOTE: You do not need to select the whole molecule, the superimpose
button will work on small selections e.g the loop regions or domains.

4.4.3 Superimpose by 3D

To superimpose proteins by 3D:
» Firstdi spl ay and sel ect the proteins you wish to superimpose by
3D

. Toéls/SJperi mpose/Proteins by 3D
* A window as shown below will be displayed.

€ Automated multiple structural superposition @@

Help

malecules must be SELECTED and belong to different objects. Ta
zuperimpose molecules in the same object clone it

i~ C alpha " Backbone " Heawy Atoms

Static Dbject |a_1qE. |
sequence weight |EI.5 j
zeed length | 15 ﬂ

Ok | Cancel

» Select by which atoms you wish to superimpose.
» Enter the ICM selection language description for the protein
structure you wish to remain static. Y ou can aso use the drop
down arrow button to select it.
» Enter the sequence weight Average local sequence alignment score.
» Enter the seed length Thisisthe similarity window size.

4.4.4 Superimpose Multiple Proteins

To superimpoe multiple proteins:

» Firstdi spl ay and sel ect the proteins you wish to superimpose by
3D

. Toéls/Superi mpose/Multiple Proteins
* A window as shown below will be displayed.

4.4.2 Superimpose Button 111



@ Align Residues () Match By Res Mumbers () Exact Match

@ Visible Atoms ) Caipha () Baddone (7 Heavy Atoms
Static Ohject a_glpl.

@ weighted iterative superposition (¢ single global superposition

{ Ck H Caricel H Help ]

» Select by which method you would like to superimpose

Align Residues - Residue correspondence is established by sequence
alignment using the ICM ZEGA aignment Abagyan, Batalov, 1997. Atom
alignment: by atom name.

Match by Res Number s - Residue alignment by residue number.Atom
alignment: by atom name for pairs of identical residues or pairs of
closeresidues (F with Y; B with D,N; D with N; E with Q or Z, Q with
Z), for other residue pairs only the backbone atoms ca,c,n,0,hn,haare
aligned.

Exact Match - Residue alignment is by the Needleman and Wunsch method.
Inside residue atoms are aligned sequentially and regardless of the
name.

» Select which atoms you would like to superimpose. Visible Atoms, C
alpha, Backbone, or Heavy Atoms.
» Select whether you would like to use weighted iterative
superposition as described here
http://ww. nol soft. conf man/ i cm comuands. ht nl #superi npose-m ni nm ze
or non-iterative single global superposition.

4.4.5 Arrange as Grid

To separate superimposed proteins:

» Tools/Superimpose/Arrange as Grid

112 4.4.4 Superimpose Multiple Proteins



Superimpose

Arrange as grid

4.4.6 Superimpose Sites by Atomic Property
Fields

Here we describe how to superimpose and compare aligand binding site
using Atomic Property Fields. This method is described in more detail in
this publication.

In this example we superimpose the ligand binding pocket of thiamine
diphosphate in the binding sites of pyruvate dehydrogenase (pdb code:
1rp7) and pyruvate decarboxylase (pdb code:1pvd).Even though the
sequence identity between both proteinsis very low (19%) and the
secondary structure surrounding the ligand undergoes considerable
displacement you will see that the pockets can still be superimposed
very well using the APF method.

Some Comments about Selecting the Pocket APF pocket overlay works by
superimposing alayer of receptor atoms around the pocket using APF
chemical property fields of these atoms "pocket" of course is something

that is not uniquely defined and is somewhat subjective. One way to

defineit isto use the ligand inside, in which case alayer of receptor

atoms within a certain cutoff distance from the ligand is considered in
superposition. Thisis "around selected ligand” mode. It focuses on

atoms that directly interact with the ligand while largely disregarding
backbone fold, which can be helpful when comparing different pockets
binding similar ligands. The other mode uses input selections directly,
leaving it up to the user to define the sets of atoms that comprise the

two pockets. Depending on the system and degree of similarity, different
selections may work better or worse. For instance in the absence of

ligand one may want to detect pocket with pocket fi nder and then select
residues around the pocket "blob". Regarding the influence of ligand on
superposition, if pocket is defined viathe ligand it will of course

matter whether the ligands extend into certain regions or not. If

external pocket definition is used, ligands will have no direct effect

0N superposition process.

4.4.5 Arrange as Grid
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2) 1rpT Molsoft iom 3.7:-3c [NewProgect *] (1 object] Read in PDB ﬁle 1rp?

FEHD 90 TR LB e Ol MEEBBOA40%% TTFff#22L21
oty i haht \/ lebels [ meshes "\ search "\ igedit |

PDE Saarch = | 1pT b “ pdbflesdimrModels | &l Siack * | sdtupencylesplay | FONS "

Worlspace Panel [ ]

:n:- selection
B 1. Select the search tab and

il B enter 1rp7
a b

amg
atzd
birig
bizd

{5 pyruvate dehydrogenase
In"n"

« fields

eddr odn @

D i (4 o lod [

%
= -

o -

El

& liem/1rpT

o @ &= O O [ | | B | Welcome to KM & Mol 1 Obj

Step 1: Read in the pyruvate dehydrogenase (pdb code: 1rp7) structure.

Read in PDB file 1pvd

FEHO O RRD AV FIIN MEBqrEBLA09E% TTIifgssrl

&) lpvd Molzoft xm 3.7-2¢ [NewProgect "] (2 obpects)

| dsptay \/ ight \/ Tabels \/ meshes \/ search [ igedit ®
i PDE Seanch = | 1peed - H pabRleachimyModels | ol glack * | scoupancyDepley | o - a
[+
Werkspace Parel & x +
no selection Py
M b Sy 1. Select the search tab and z
i ]a enter 1pvd '5"
+ b O

amg
atrd o
bmg a
btzd i

14 pyruvate dehydrogenase
o |wW
ae

a - I
b i
amg -
atpp -
bmg -
+ I btpp =]
13 pyruvate decarboxylase; «
1w
b
« fields %
f‘-r
|
[ o« e Y
] =
-]
5|4
O | 'h_ mf @_ ﬂ_ F -‘.-;__ Welcorrse o JOM & Mel 1 Oky

Step 2: Read in the pyruvate decarboxylase (pdb code: 1pvd).
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% lpvd Malsoft icm 37-2¢ [NewProject ° 2 objects Delete waters and all molecules other
than the “a” subunit and Iigand
EEHEO A TRO qf-‘,n.;F-;.;Px Fi6| ) v EB W8

—— s
¥ desplay \/ ght \/f babels \/ meshes \/ rx---_.l-;ue-:b

&

DB Search = | 1ped » i | pbfeachimodels | ol stack = | sooupancyDesplay | Pong - .
x

[+

Wiorkspace Parel & x +=
P 945 Mol 2 Obi P
‘8 i )
v _|a et

+ o

atzd =

a

=n
=

pyruvate dehy ::Irc:t'enaqp 1. Hold “CTRL" kE‘jl" and select
4= moleculesto delete.

iv Ll

T "y
L]
BWw ip
ga[up
o
:. p.lu ate decarboxylase; «

[,.:h 2. Right click and choose delete,

Termind & X
|
*

@ e O O [ | | B | welcome te M & Mell Oy

Step 3: Delete unwanted moleculesin the b chain and waters.

e e I The two structures should contain the
: g “atzd” and “atpp” ligands.
FEHS A TR B e I [FEE e B

i desplay W ight W/ lebels " meshes \/" seanch LI igedit P
—n raEceE . - . e | = a | =
Hi| 24 e @ ot o= s RS e |L @ | nos e G| 8o
- s
Worlspaoe Pane ax +
no selection o]
- objects z
ﬂ'rﬂ 1r';'|' -
[
. ﬂarzn 3
{a Py -u-ale dehydrogenase D
- 1pvd
«[H a @
+ [ atpp At
-
18 pyruvate decarboxylase, «
« fields

D ) o4 e jof =

@ B O G 68 | | | Weicome to lM 7 mon-ICM Obj

Step 4: Y ou should have two objects containing the protein and ligand.
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3 1ovd Moksoltiom 37-2¢ [NewProjec ] (2 cbjects Convert each structure to an ICM object.

FHO N TR AR i SN MEBvyEGA0E TTIidssll

| Sty \ i\ T\ e\ smara \/ hgeat ) i -
v |2 @ie@ o | @ EEER: | e | a2 |G| [m]e) -
O
Workspace Parel & x +
no selection 5—-5
ﬂﬁ,j:‘; o 1. Right click here and choose z
1 s
convert object. &
nulzu O
\ p.lu aabe dehydrogenase

HE ?
9 - ]
. Eatpp b

10 pyruvate decarboxylase, « < [ rep—

« fields

« opGmize hydrogers. | opbmize HisProdsnGinCys

+| replace the ongral | deplay the result i

=4 Cone Help

O [ | || T | Welcome to I0M 2 non-1CM Okyj

Step 5: Convert both structures to an ICM object.

F) 1pwd Molsaft km 3.7-2¢ [MewPraject | (2 obpects, Note Each ob]m isan ICM ubjectl
FHO 90 TR0 HBrR Pl SN MMEvyEBODA0%% Tidgssll
¥ daciay gt \ Tﬁﬁ”? . < °
|2 e @ Eeas | E: 8 E N | e | s |G | (@]
Workspace Parel &2 x +
no selection 5-!'
- Il objects - 3
d'{" 1r‘.)| b
+ nulzu o
{h D.lu qate dehydrogenase
F°T% : >
- [Ea L]
-l atpp 1)
{i pyruvate decarboxylase «
« foelds T
i
:
&
B
s
-]
O B OO @& .| % 2 1CM Oty

Step 6: If the pdb is converted you will see"ICM" in the workspace.
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%) lpvd MolsoR icm 3.7-2¢ [MewProject | (2 objects Select one “gand and copy green

selectionto orange.
FEHO A TRO HB L QAN [FEE e B

T, ey e, e ey
i capiay '\ ight [/ labels /" meshes \J search W igedit

H | Bl a6 | & 2 | Me | ceMEd 2 | @ | [ ]e

&
=
[~
Workspaoe Panel o x +
o® 1Mol 1 Obj P
- e e anmrerrel|  sclectiontoorange. z
- 1T :
+[E a L]
+« [ atzd O
-
1 pyruvate dehydrogenase b
B 1ped !
«[E a =
% g AS
1] pyTu
fields

1. Double click here to select.

- - T

%

s

2ICM Oy

Step 7: Select one ligand and copy the green selection to orange.

el R Select the other ligand.

EEO A THRO ERRFISAN MMEBqoBRD4a0%% TETEFF2L1

i b W o wp W v, I s s, W g wn
{ dhmotey '\ ight '\ labels \/ meshes \/ " ssanch "\ Iged 1\

i el e v B e RE e | M2+ | @ | (=]

3} 1pwd Malioft cm 3

Workspaoe Parel

g® 1Mol 1 Obi
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-
=t

S B e =

Step 8: Select the other ligand (regular green selection).
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3} 1pwd Malzok icm 3.7-2¢ [NewProgect | (2 obgects, Tm|sf5upeﬁmp°5,e SitE'S bv APF
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Step 9: Select the option Tools/Superimpose/Sites by APF. Note you can
also superimpose pockets - choose the appropriate tabs in the dialog
box.

31 1pwd Malzobt icm 3.7-2¢ [NewProgect | (2 obpects) ‘l'he two pocket_s supenmmsed hv APF
File Edit View Biocinfc Tock Homology Chemistry Doclang MolMechamics  YWnOOWS Fiehg
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daciay W ight \/ labels L/ meshes \/” search \/ bgedit |

0 BBl ) CRELA® | (=1 = (R e e | ©
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- T arp7 .
+[@ a &
+ [0 atzd =
-
1 pyruvate dehydrogenase D
-2 1pvd
+[H a B
+[ atpp 1
%8 pyruvate decarboxylase; «
« fields z
I
i
=
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8
B
&
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SNTED JTATIC & =
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Step 10: Observe the superimposed site.
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4.5 Protein Structure Analysis

Availablein the following product(s): | CM Br owser - Pro || CM Pr o

In this chapter we describe the tools available for analyzing protein
structure. These tools include calculating RM SD, identifying closed
cavities, calculating contact and surface area, measuring anlgles and
distances, and generating Ramachandran plots.

Chapter Contents:

Fi nd Rel at ed Chai ns

Cal cul at e RVBD

Cont act Areas

Identify Closed Cavities
Surface Area

Measure Di stances

Pl anar Angl e

Di hedral Angle

Ranachandran Pl ot Interactive
Export Ramachandran Pl ot

4.5.1 Find Related Chains

This option allows you to search the currently loaded PDB files or ICM
objects and identify chains which are similar and/or related.

Y ou can do this by:

Sel ect theobjects or pdb files you want to compare.
Tools/Analysis/Find Related Chains

Click OK to confirm the selection you made

A table as shown below will be displayed.

2 jelated_sequences

namel  nameZ  lend len2 seoul | rsd CONSENsUs
dicba  Z2icbec 278 277 g 012 SWEKLAEDIKKIFEFKETLG TGAFSEVYLAEERATGELFA)
1 IENEIAYLRKIKHENIVALEDIVE SPHNHLYLYVMOLVS GGELF
Zicba  3bkkva 278 289 3 042 B HEEBRG H VL HTG HAHBKH  HeH HBEER
2 HER BEH NNV LD 8 BEYLVE LY GGELF- IV + Y E
DAS H OHL-AVEEHH MGHVHRDLEPENLLERS  #E
PGEYH PEVL Y KEVD#W #GVIHILLEGYPPFEDE
3 |2icBa 3bkhb 273 283 38 0.41 ﬂ :HtE IIG ﬂﬁ W ﬂTG ﬂAﬂ!‘i#l_ _ #t- 13 ﬂE Eﬂ
4  Zicha 3bhhe 273 285 37 0.44 g ﬂ # E Fl ti ﬁtt E A # KB p HE EIi ﬂﬂﬂ H#KH
) 2cba  3bkhd 278 286 37 043 It ﬂ 1# E It H 11# E A i K# II+ 11 ItE EH iﬂiﬂ #icH
S 2icBe  3bkbva 277 288 39 0.44 ﬁ ﬂ#E ﬂG ﬂ "JL HTE #ﬁﬂﬁlﬂ K - ﬁE Eﬁ ﬂ!-‘;F’
7 2itbe  3bhib 277 285 39 043 u ME HG hﬁ W HTG ﬂ,ﬁﬂrﬁl_ ¥_ ~ ﬁE E#
§ 2ichc 3bhhe 277 285 38 0.44 ﬁ # l¢ 41 Wﬂ ﬁTE marzm K #E_E_ﬂﬁltF%
ol @ a%

namel = Name of query structure molecule name2 = Name of hit lenl =

length of query len2 =
percentage consensus = Consensus sequence

4.5 Protein Sructure Analysis

length of hit seqid = Sequence identity
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4.5.2 Calculate RMSD

NOTE: Thisoptionisfor protein structures only not for chemical
compounds. Y ou can use the command line options RMSD
(http://mol soft.com/man/icm-functions.html#Rmsd) and Srmsd
(http://mol soft.com/man/icm-functions.html#Srmsd) for chemicals.

To calculate RM SD between two protein structure:

* Readinto ICM thetwo structures ( Fi | e/ Open or PDB Sear ch or Read

in Chemical) you wish to compare.

* Sel ect one of the two molecules you wish to compare, you can do
this by double clicking on the name of the structure in the ICM
Workspace. Convert this selection to an Or ange Sel ecti on.

» Select the second molecule, and then you should have one orange

and one green selection in the graphics display.

9 Calculate cartesian RMSD @@
" Keptin place
f+ Mo aAlignment (" Align Residues i~ Ewmact Match

i+ Visibledtoms ™ Calpha (™ Backbone ™ Heawy Atams

Apply | Cloze Help

» Select whether you wish the atoms to be superimiposed onto one
another or kept in place. The kept in place option would be ideal

for comparing docked structures.

» Choose whether you wish to make the superposition by alignment or

exactly matching the atom names.
» Select which atom types you wish to superimpose.

The RM SD value will be displayed in the terminal window.
4.5.3 Contact Areas

Sel ect theregion you wish to analyse.
Tools/Analysis/Contact Areas

contacts with aligand will be displayed in thicker xstick
representation (and colored yellow) than those making less
significant contacts.

» A table as shown below will be displayed.The table lists the

contact area, exposed area, percentage of contact area compared to

exposed, the nearest atom of aresidue and the distance.

120

Read in aprotein structure ( Fi | e/ Open or PDB Sear ch).

The xstick display in the region will be scaled according to the
atom/residue contact area. For example, residues making large
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AR EEREE R How to calculate contact areas.
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meold HoEHO
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3 |1abd.af~v3ss 2.2 714 33 1 astinye2s 3484 ;
4 Lubbaf~448 226 #.5 3853 lbh astiuiics 318 i)
e T et ] 0.8 ! T sl

SO ES DA e
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4.5.4 Identify Closed Cavities

Thistool will identify cavities within a molecule which are completely
closed,. If you are looking for buried and open pockets then use
i cmPocket Fi nder .

Read in aprotein structure (Fi | e/ Open or PDB Sear ch).
Convert the protein structureto an | CM obj ect .
Tools/Analysis/Closed Cavities

Use the drop down arrow to locate the molecule you are interested
in.

Enter the minimum volume of the cavities you wish to identify.

* Click OK

¢ The closed cavities will be displayed in the meshes section of the
ICM Workspace and atable of the cavities will be displayed.
Double click on arow in the table to jump to a particular closed
cavity and select the residues surrounding it.
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| 3 Labb Mobioft wm 3.8-5 [Pewiroiect *] (1 obpect 1 tabile) & 4

How to predict Closed Cavities.
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What isthe difference between Closed Cavity and | CMPocket Fi nder ?
Closed pocket (cavityFinder) is purely geometrical/topological - it

isapart of molecular surface that is completely disconnected from

the exterior surface. It means that a probe sphere of 1.4A radius

(representing a water molecule) can not passin or out of the cavity
(considering protein as completely rigid of course). icmPocketFinder

identifies pockets that are likely to contain ligands (not

specifically open or closed pockets). Pockets are defined based on

physical interaction rather than geometric criterion. Blobs of

"pocket density’ generated by icmPocketFinder represent continuous
regions of space where there is significant favorable van der Waals

interaction with the receptor.

455 Surface Area

This option calculates solvent accessible area of each selection in
multiple objects and storesit in atable. If amoleculeis specified in
amulti-molecular object, the surface area of an isolated moleculeis
calculated and other molecules are ignored. The areais reported in
square Anstroms and the probe radius is assumed to be the value set in

the variable waterRadius.

Output: the macro creates table AREA . The empty comment field is added
for user’s future use. If the table exists, new rows are appended.

To calculate a surface area:

Sel ect theregion you wish to analyse.
Tools/Analysis/Surface Area

along with the corresponding total surface area.
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Read in aprotein structure ( Fi | e/ Open or PDB Sear ch).

A table will be displayed listing the residues in the selection

4.5.4 |dentify Closed Cavities




4. 5.6 Measure Distances

There are two approaches to calculating and displaying distances between
atoms. Y ou can either use the optionsin the Label s tab or use
Tools/Analysig/Distance.

To display all to all distances:

» Select the atoms between which you would like to find the
distance. (Seesel ecti on tool bar)

» Toolg/Analysig/Distance

* Sdlectaltoal

To display intermolecular distances
» Select the atoms between which you would like to find the
distance. (Seesel ecti on t ool bar)
» ToolsAnaysig/Distance
» Select intermolecular
To display the distances between the same atoms in two objects.
* Select the atoms between which you would like to find the
distance. (Seesel ecti on t ool bar)

» ToolgAnalysig/Distance
» Select same atomsin two objects

NOTE: Distances can be displayed and undisplayed in the 3D labels
section of the ICM Waorskapce. Y ou can change the color of a distance
label by right clicking on it in the ICM Workspace. Y ou can alse
export the distance to atable.

4.5.7 Planar Angle

If you wish to find the planar angle between three atoms:

e Sdlect Tools/AnalysisPlanar Angle

4.5.6 Measure Distances 123



Find planar angle between three atoms E|rz|

First atarn | a_pep.m/2/ica j

Second atom |a_|:uep.mf'E.fn j

Third atam [ |

Help

To select atoms: Right-Click, shde down to atom name and release.
To zee the resultz: look in the terminal window

Apply | Close Help

» Right click on the each of the three atoms which you wish to use,
and select their name. The spaces next to First atom, Second atom,
and Third atom should now contain the name of your atoms.

a_pep.m/2

Selection Dialog
Edit 3
Advanced r

» Click Apply to display the angle measure in the terminal window.

Angle ( a_pep.m/6/hh21 a_pep.m/2/0e2 a_pep.m/3/0 ) = 74.72 deg.

4.5.8 Dihedral Angle

In order to find the angle dihedral angle between two sets of atoms:
» Select ToolgAnalysis/Dihedral Angles.

Find dihedral angle formed by four, atoms

First atom |a_pep.mi3/n x| Secondatom  |a_pepmidica v
Thidatom  |apepm&ic |  Fouthatom || xl
Help

To zelect atoms: Right-Click, slide down to atom name and releaze.

Apply | Cloze Help

» Right click on each of the four atoms which you wish to use, and
select the name of the atoms. The spaces next to Atom 1, Atom 2,
Atom 3, and Atom 4 should now contain the names of your atoms.

a_pep.m/2

Selection Dialog
E dit 3
Advanced r
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» Tofind the correct angle, select your atoms according to the
following diagram:

» Click Apply to display your dihedral angle measure in the terminal
window.

4.5.9 Ramachandran Plot Interactive

To make an interactive ramachandran plot:

* Readinaprotein structure (Fi | e/ Open or PDB Sear ch).

» Select the structure you wish to build the plot for. Y ou can do
this by double clicking on the name of the structure in the ICM
Workspace (a selection is highlighted blue in the ICM Workspace
and green crosses in the graphical display) or you can use the
right-click button and drag it over the whole structure in the
graphical display.

» Tools/Analysis’Ramachandran Plot Interactive

e Theinteractive ramachandran plot will be displayed in table
caled RAMA.

* You can view the Omega, Phi/Psi (Gly) or Phi/Psi angles by
clicking on the tabs at the top of the plot. Each point is linked
to the data in the table RAM A and a so to the graphical display.
Clicking on apoint in the plot will highlight the corresponding
anglesin the table and also center on thisregion in the 3D

display.
4.5.10 Export Ramachandran Plot

* Readinaprotein structure (Fi | e/ Open or PDB Sear ch).

» Select the structure you wish to build the plot for. Y ou can do
this by double clicking on the name of the structure in the ICM
Workspace (aselection is highlighted blue in the ICM Workspace
and green crosses in the graphical display) or you can use the
right-click button anddrag it over the whole structure in the
graphical display.

» Tools/AnalysigRamachandran Plot Export

A postscript viewer needs to be downloaded onto your machine in order to

view the plot. This can be downloaded from

http://ww. cs. w sc. edu/ ~ghost/. Oncethis software is downloaded you
need to tell ICM where it islocated by typing the pathname into

File/Preferences.

NOTE: You can aways export the plot as an image directly in ICM
without exporting. Y ou can do this by right clicking on the plot and
select save asimage. Another approach could be to export the RAMA
table to Excel and use the plotting tools there. Y ou can do this by
right clicking on the table name tab and selecting "Export to Excel"

or saveas".csv".
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4.5.11 Protein Health

Theory

The protein health option calculates the energy strain of a structurein
ICM. It isgenerally agood ideato investigate the energy strain of any
protein structure before undertaking such processes as docking. It is
also essential to use thistool after making a model (see Molecular
Modeling) to identify strained regions within your model and then some
optimization procedure can be undertaken to rectify the problems.

The protein health option calculates the relative energy of each residue
for a selection and colors the selected residues by strain. This macro
uses statistics obtained in the following paper Maiorov, V.N. and
Abagyan, R.A. (1998) Energy strain in three-dimensiona protein
structures Folding and Design, 3, 259-269.

To use the Protein Health option:

Read in aprotein structure ( Fi | e/ Open or PDB Sear ch).
Convert your PDB structureinto an | CM obj ect .
Makeasel ect i on of the residues you wish to analyze.
Tools/3D Predict/Protein Health and a window as shown below will
be displayed.
» The scale of the coloring can be changed by atering the value
within the trimEnergy data entry box.
» Click OK and the structure will be colored according to energy
strain (red - high) and atable of residue energy will be
displayed in atable.
» A tableand plot of Normalized energies for each amino acid in the
selection will be displayed. The tableis ranked and colored by
residues with poor normalized energies. Click on arow in the
table or plot to center in on the residue.

4.5.12 Local Flexibility

This option systematically samples rotamers for each residue side-chain
in the input selection and uses resulting conformational ensembles to
evaluate energy-weighted RM SDs for every side-chain atom. These are
stored in the'field” values on atoms and can be used for example to
color the structure by side-chain flexibility. Conformational entropy

for each residue side-chain is also calculated and stored in atable. If
|_entropyBfactor flag is on, the atom rmsds are normalized within the
residue to reflect itstotal conformational entropy. If |_bfactor flag

is set, the bfactors are reset to the same values that are placed in the
atom 'field', and occupancy is set to be inversely proportional to it (
O=1/(1+2*rmsd) )

* Read pdb file (File/Open or PDB Search Tab).
e Convert toanICM Object.
» Tools/3D Predict/Loca Flexibility

4.5.13 Protein-Protein Interface Prediction

The ICM Optimal Docking Areamethod is a useful way of prediciting
likely protein-protein interaction interfaces. If you do not have

mutational data or other experimental data which indicates the likely
protein-protein docking site this method will be useful. This procedure
can save you time during the docking procedure by focusing your docking
only on areas on the receptor and ligand most likely to interact.

Theory
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ODA (Optimal Docking Areas) is a new method to predict protein-protein
interaction sites on protein surfaces. It identifies optimal surface

patches with the lowest docking desolvation energy values as calculated

by atomic solvation parameters (ASP) derived from octanol/water transfer
experiments and adjusted for protein-protein docking. The predictor has

been benchmarked on 66 non-homol ogous unbound structures, and the

identified interactions points (top 10 ODA hot-spots) are correctly

located in 70% of the cases (80% if we disregard NMR structures). For a
description of the method see Fer nandez- Reci o et al Proteins (2005)
9632.

Todisplay the optimal docking area.

e Convert the PDB fileto an ICM object.

» Tools/3D Predict/Protein Interface by ODA

» If you select the Residue Table option the average ODA score for
each residue will be displayed in atable. The lower the number
the higher the chance the residue will be involved in
protein-protein interactions. Regions colored red represent low
ODA score and blue represents a high score.

4.5.14 Identify Ligand Binding Pockets

Theory

The ICM Pocket Finder method (1-2) uses only the protein structure for
the prediction of cavities and clefts. No prior knowledge of the
substrate is required. The position and size of the ligand-binding

pocket are determined based on a transformation of the Lennard-Jones
potential by convolution with a Gaussian kernel of a certain size, a

grid map of abinding potential and construction of equipotential
surfaces along the maps. The pockets are displayed graphically as a
surface and the dimensions of each pocket are presented in an
interactive table and plot.

Factors that can influence ligand binding to a pocket include the pocket
volume and area, buriedness, hydrophobicity, and how compact the pocket
is. All these properties are calculated using | CM PocketFinder and
tabulated. Scientists at Merck used Mol Soft.s |CM PocketFinder algorithm
to define away for quantifying "drugability” of a protein target (3).

The metric they used is called Drug-Like-Density (DLID), and this score
isalso provided in the results table. A good example of the use of the
icmPocketFinder method isin the database called Pocketome. The
Pocketome (www.pocketome.org) is an encyclopedia of conformational
ensembles of all druggable binding sites that can be identified
experimentally from co-crystal structuresin the Protein Data Bank (4).

1. An, J, Totrov, M. & Abagyan, R. Pocketome via comprehensive
identification and classification of ligand binding envelopes. Mal.
Cdll. Proteomics 4, 752 (2005).

2. Abagyan, R. & Kufareva, |. The flexible pocketome engine for
structural chemogenomics. Methods Mol. Biol. Clifton NJ 575, 249.279
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(2009).

3. Sheridan, R. P., Maiorov, V. N., Holloway, M. K., Cornell, W. D. &
Gao, Y .-D. Drug-like density: amethod of quantifying the .bindability.
of aprotein target based on avery large set of pockets and drug-like
ligands from the Protein Data Bank. J. Chem. Inf. Model. 50, 2029.2040
(2010).

4. Kufareva, 1., llatovskiy, A. V. & Abagyan, R. Pocketome: an
encyclopedia of small-molecule binding sitesin 4D. Nucleic Acids Res.
40, D535.540 (2012).

To predict pockets:
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Read in aprotein structure (Fi | e/ Qpen or PDB Sear ch).
Convert the protein structureto an | CM obj ect .
Tools/3D Predict/icmPocketFinder
Enter atolerance level (4.6 isthe default value and we
recommended you to use this). The lower the tolerance value the
more pockets predicted and the higher the tolerance the less
pockets predicted.
» Check the box create sequence sitesif you wish the site to be
labeled.
» Check the box display results to see the predicted pockets as
grobsin the display panel.
» Check the box keep compoundsif you wish the compounds (ligands)
in the receptor to be included in the prediction. If you dont
check this box the pockets will be calculated based on the
receptor without ligands.
e Click OK to run icmPocketFinder and the results will be displayed
inatable.
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Results

» Click on arow of the results table to select the residues
surrounding the pocket.

» The pocket view can be toggled on or off in the meshes section of
the ICM Workspace. Right click on the name of the meshin the ICM
workspace to change properties such as color.

« A fully interactive plot (Areavs Volume) is also provided,
pockets that fall within the blue shaded region have a
"drug-like" volume and size.

About theicmPocketFinder Results Table

Factors that can influence ligand binding to a pocket include the pocket
volume and area, buriedness, hydrophobicity, and how compact the pocket
is. These values are reported in the results table:

* Volume of the pocketin”.

» Areaof the pocketin”.

» Hyrdophobicity - represents the percentage of the pocket surface s
in contact with hydrophobic protein residues (values can range
from 0-1)

» Buriedness - The buriedness parameter is calculated as follows:
One measures the solvent accessible surface area of the pocket
(proberadius, 1.4) in isolation. Then one measures the solvent
accessible surface area of the pocket covered by its shell. The
ratio of the second number to the first is the fraction buried.

The lowest possible value is 0.5; i.e. the pocket is completely
open and the surface flat. The highest is 1.0, i.e., completely
buried.

* DLID - Merck’s Drug-like density score (see Sheridan et al JCIM
2010). >0.5 is considered "druggable”.

» Radiusgivesan indication of how sprherical apocket is. ( 3/4
Volume/ Pi Y*1/3 , i.e. radius of an ideal spherical cavity of
the same volume as a pocket blob.

* Nonsphericity give an indication of how spherical the pocket is.
Area/ (area of ideal spherical cavity) . It is 1.0 if the cavity
is spehrical

4.5.14 | dentify Ligand Binding Pockets
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» Conservation Average conservation (%identity) of residuesin
contact with the pocket. Calculation is performed if multiple
alignment is present and linked to the protein chain being
analyzed.

» RelCons Above conservation, relative to the average over the
entire chain.

* Type- returnsthe ICM selection for the residues forming the
pocket.
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5 Molecular Graphics

In this chapter we describe how to
make beautiful graphical
representations of molecules and
mani pulate them in the 3D graphics
window. Thisincludes how to change
color, light, represenations,

clipping planes, and how to use
built in graphics effects. We also
teach how to label and annotate
molecules displayed in the graphical
user interface.

Chapter Contents:

Mol ecul e Representati on
Meshes- Sur f ace- G obs

Col ori ng

Li ghti ng

Label i ng and Annotati on

Di spl ay Di stances and Angl es
Graphics Effects

Graphi cs Shortcuts

Mol ecul e Move Buttons

d i ppi ng Tool s

Graphi ¢ Layers

H gh Quality Publication |Images
Movi es

5.1 Molecule Representation

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

To change the molecule display representation:
» Sel ect theatoms, residues, molecules, or objects you wish to
change in the graphical display or in the ICM Workspace.
» Then use the molecule representation (e.g. wire, ribbon) options
intheDi spl ay Tab.

The display tab containstools for avariety of functionsincluding -
structural representations, coloring, labeling and superposition.

There are six main types of structural representation in ICM. They are
wire, ball and stick (Xstick), ribbon, skin, CPK and dot envelope
(surface).

To display one of these representations:

 Click on the representation button you desire in the display tab.
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wire cpk  skin ribbon

g

xstick  dot envelope

Toremove adisplayed representation or to toggle between display and
undisplay:

» Click on the corresponding representation button in the display
tab.

I dentify which representations ar e displayed: The button display will
change appearance (shaded blue) when selected. This makesit easier to
identify which representations are currently being displayed.

ribbon displayed
”; :a-:;: P
xsték displayed

Changethe display and size of the representations Many characteristics
of the graphical representation such as color can be changed by clicking
and holding on the button. The size can be changed by clicking the
plus(+) and minus(-) buttons next to them.

click and hold for more options
/e L}J @@ Qg
+/-tocha ﬂgzz size
5.1.1 Wire Representation

Click and hold on the wir e representation button. A menu will be
displayed as shown below.
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To changethewirestyle:

 Click and hold on the wir e representation button and then click on
wire, chemistry or tree.

To changethe size of the wire representation:

* Click and hold on the wir e representation button and then click on
thin, normal or thick.

NOTE: Clicking on the +/- next to the wir e r epresentation button also
changes the thickness of the wire representation.

Toundisplay representations other than wire:

» Click and hold on the wir e representation button and then click on
undisplay other representations.

If you make amistake or you are not happy with the way your structure
is displayed with the wire representation:

» Click and hold on the wir e representation button and then click on
reset to default.

5.1.2 Stick and Ball (Xstick) Representation

Click and hold on the stick and ball representation button. A menu will
be displayed as shown below.

5.1.1 Wire Representation
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transparert

To changethe style of the Xstick representation:

e Click and hold on the stick and ball representation button and
then click on style and choose either plain, chemistry, Chem Plus,
or Chem Plus Aromatic.

To changethe size of the Xstick representation:
e Click and hold on the stick and ball representation button and

then click on set thickness, set ball/stick ratio, set hydrogen
ratio, and set backboneratio.

NOTE: Clicking on the +/- next to the xstick representation button
also changes the thickness of the xstick representation.

In order to make some parts of your picture clearer, the xstick
representation can be set to transparent:

* Click and hold on the stick and ball representation button and
then click on transparent.

Toundisplay representations other than xstick:

» Click and hold on the stick and ball representation button and
then click on undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the xstick representation:

» Click and hold on the stick and ball representation button and
then click on reset to default.

5.1.3 Ribbon Representation

Click and hold on the ribbon representation button and a menu will be
displayed.

To changethe style of the Ribbon representation:
» Click and hold on the ribbon representation button and then click

on a style option: smooth, wide, wide smooth, cylinders, protein
worm .
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To assign secondary structure:

To accurately represent the secondary structure of the moleculein
ribbon representation you may wish to assign secondary structure:

» Click and hold on the ribbon representation button and then click
On assign sec. structure.

To make some partsof your picture clearer, theribbon representation
can be set to transparent:

» Click and hold on the ribbon representation button and then click
on transparent.

Toundisplay representations other than ribbon:

 Click and hold on the ribbon representation button and then click
on undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the ribbon representation:

 Click and hold on the ribbon representation button and then click
on reset to default.

NOTE: Alwaysusethe | CM assign sec.** structure tool in the ribbon
right click menu to get accurate secondary structure assignment. This
is particularly important when studying helices which may have
non-cannonical elements within them such as 3/10 or pi. To view
non-cannonical helix segments use the segment option in the ribbon
right click menu.

To change the display of chain breaks (dotted lines):

» Click and hold on the ribbon represenation button.
» Select the options Display Chain Breaks or Display Chain Break
label.

5.1.4 Skin Representation

Click and hold on the skin representation button. A menu will be
displayed as shown below.

meshes Y movie

Skin %’ﬂl lﬁ:l-l--!|!_ -

— | | |
@ color.
TS

tight

niormal

sparse

undizplay other representations

rezet to default

To make some parts of your picture clearer, the skin representation can
be set to tight, normal or sparse:

» Click and hold on the skin representation button and then click on
either tight, normal or sparse.

Toundisplay representations other than skin:

5.1.3 Ribbon Representation
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» Click and hold on the skin representation button and then click on
undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the skin representation:

» Click and hold on the skin representation button and then click on
** reset to default**.

NOTE: Sometimes due to singularity problems holes may appear within
the skin surface. To cure thisinfliction select atoms nearby and
right click select Advanced->RandomizeAtoms

5.1.5 CPK Representation

Click and hold on the CPK representation button. A menu will be
displayed as shown below.

b ¥ meshes ¥ movie

EEE |
— HEN
@ color.

by s 4

undizplay other reprezentations

reset to default

Toundisplay representations other than CPK:

* Click and hold on the CPK representation button and then click on
undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the cpk representation.

* Click and hold on the CPK representation button and then click on
reset to default.

5.1.6 Surface Representation

Click and hold on the surface representation button. A menu will be
displayed as shown below.
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To changethe style of the surface representation:

» Click and hold on the surface r epresentation button and then click
on tight, normal, or surface.

Toundisplay representations other than surface:

» Click and hold on the surface representation button and then click
on undisplay other representations.

If you make a mistake or you are not happy with the way your structure
isdisplayed with the surface representation:

» Click and hold on the surface representation button and then click
on reset to default.

5.1.7 Display and Undisplay Hydrogens

To display and undisplay hydrogens. Click and hold on the " Change
Hydrogen Display" button shown below. Multiple single clicks will toggle
through the hyrogen display options.

» Display Tab

» Click and hold on the " Change Hydr ogen Display" button shown
below.
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5.1.8 Display Hydrogen Bond

NOTE: The method by which hydrogen bonds are calculated is described

her e in the command line manual. The GRAPHICS.hbondMinStrength
parameter determines the hbond strength threshold for hbond display.

The strength value is between 0. and 2. By changing 1. to 0.2 you
will see more weak hydrogen bonds.

In order to display potential hydrogen bondsin your structure:

e Converttoan ICM Object
» Makeaselection - if you are trying to display the H-bonds

between aligand and the receptor make sure the ligand is part of

the selection.
» Click the Display Tab.
» Click onthe Toggle H-bondsicon in the display tab.

Select the display tab
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Click and hold on the H-bond button to get
access to other display options
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» Click the +/- on the right of the H-Bond button to change
thickness of H-bond representation.

 Click and hold the button to change representation or use the
hbondpairs option in the ICM Workspace.

Click and hold
e | A

text label

zolid line
dotted line
zpheres
Set Sphere Period...
Change Color...

Diwnamic Hbonds

What do the default coloring of the H-bond represent?

Longer and shorter H-X distances in the hydrogen bond are color-coded,
from red to blue, respectively.

NOTE Dynamic hydrogen bonds can be set by clicking and holding on the
H-bond toggle button in the Display tab. Hydrogen bonds will then
respond to any changes made to the ligand.

5.1.8 Display Hydrogen Bond
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5.1.9 Display Formal Charges

You can display formal charges by clicking and holding on the " Change
Hydrogen Display" button in the Display tab.

5.1.10 Ca (carbon alpha) Trace

To generate a carbon alpha (Ca) trace:

* Right click on the object in the ICM workspace and select
Tools/Make Ca-Trace object.
» The Ca-Trace object will be displayed in the ICM workspace.
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5.2 Multi-Windows

To display more than one window click on the buttons shown below.
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5.3 Meshes - Surface - Grobs

Availablein the following product(s): | CM Br owser - Pro || CM Pro

Click on the tab button entitled 'meshes and more graphics tools for
surfaces are available. In ICM surfaces are sometimes referred to as
meshes or graphical objects (Grobs).
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Macroshape Solid Macroshape Transparent

5.3.1 Surfaces

The surface of your structure can be displayed and colored by
electrostatics or binding properties. To do this:

Load a structure into ICM Fi | e/ Open or tab-pdb{ PDB Search}
Convert thestructure into an ICM object.

Select the ’meshes’ tab button.

Click on the drop down arrow menu shown below and select which
surface you wish to generate.

¢ Click on the generate surface button next to the drop down arrow.

Fodisplay W labels Y analysis W pdb zearch ¥ meshes  movie

(T CW clechiostatic (_ﬂl ‘ I-aII- 'l ¥| M IS 3: step ID_ 'I|7 color  MacroShape |

surfaces meshes macroshape

5.3.2 MolSkin

Mol Skin is a new macro that instantly makes publication quality graphics
and it gives each molecule a color and colors contact patches. It

5.3.1 Surfaces



undertakes the following:

¢ Molecular surfaces are generated with those assigned colors and
occlusion shaded.

¢ Carbons of each molecule are colored by its own consistent color.

¢ Labels, ribbons, are colored accordingly.

« Surfaces are gradually cross-colored by each other to mark the
contact patches.

¢ Thelabels are brought to the surfaces.

To use Mol Skin:

* Right click on the object in the ICM workspace and choose
Shapes/Make/Molecular Shapes and Contacts.

¢ Once the surfaces are made they will be listed in the ICM
workspace where they can be toggled on or off.
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5.3.3 Color Surface by Proximity

To color asurface by proximity to neighboring molecules:
* Make asurface.

¢ Right click on the molecule you want to color by proximity and
choose Shapes/Make/Color by Proximity.

5.3.4 Color Surface by Selection
To color asurface by a selection:

* Make asurface.

e Make asdection.

« Right click on the molecule you want to color by selection and
choose Shapes/Make/Color by Selection.
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5.3.5 Meshes

A variety of shapes can be constructed automatically using ICM. These
shapes are referred to as meshes. The types of shapes you can build are
shown in the drop down option in the meshesh tab

earch ¥ meshes ¥ movie

| |

l

meshes

To make a shape select it from the menu by clicking on the down arrow
and then click the button next to the menu. The shape will then be
displayed in the 3D graphics window.

membrane |+ ﬂ— click here
Iqu:u:k -

‘membrane
zphere
spiral
shar
tarus
triangle
wire_zphere
Wire_zeppe
- all -

select here

5.3.6 Macroshape

A macroshape can be constructed and allows easy viewing and manipulation
of the structural representation. A macroshape representation is ideal

for large structures which allows the user to easily identify important
regions of the structure and facilitate the return to the ' standard’

view of aparticular molecule. All the buttons needed to display a
macroshape structure are shown below in the ' meshes’ tab.

Y
‘ M| El: step [0 | color  MacroShape

macroshape

To construct a macr oshape:
e Load amoleculeinto ICM Fi | e/ Open or tab-pdb{ PDB Search}
» Select the amount of detail required in the shape by increasing
thevaluesin’'N’ or 'step’ data entry box (note the default
values are usually sufficient).
» Check the’color’ if you wish your molecule to be colored.
* Click the button labeled ' MacroShape' .

Macroshape can a so be used from the View menu: View/Macro Shape

5.3.7 Google 3D Objects (Sketchup)

Toread in a 3D Mesh from Googlein KMZ or COLLADA format:
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e File/Load/ 3D Mesh in KMZ or COLLADA Format from Google
« Search for the object you would like to view and download it.
¢ Toread thefile go to File/Open

5.3.8 Display or Undisplay Meshes or Surfaces

To display or undisplay the surface click in the box in the ICM
workspace as shown below:

ICM Workspace

no selection
E ects
=J1c:rn

: -l m
- ﬂ rmeshes
. q_electro_Term_

=

check here to display
or undisplay surface

NOTE: All surfaces, meshes and macroshapes come under the one heading
of meshesin the workspace panel.

5.3.9 Mesh Options.

A number of options relating to meshes can be found by right clicking on
the mesh in the ICM Workspace. This section describes some of these
options.

i"""m . "M""“"’"M o Aselection of mesh dispiay options
LT Homelogy Chernisfry  Oodiing  Rsihschonicn Wi . = "
. can be found by right clicking on the
5w H @y R ] i E ] e HR G
asyh? mﬂ- £ uﬂ?ﬁmm o R i name of the mesh in the ICiV
workspace,

Ha B was | @ Eem 8 |

ihiarispaoe Parsl & x -

f ' u wshes _I_':“ 1 - T
(5 g kit 1. Right click herein :
gk 1 the box i

& Connectito 300Mesh
Besing/bove Mode...
Crop Meth...

B Conter
Creehuion Shading..
Compress and Sampiy..
Advanced Proparties...
Add Matenals

Me oD P B0

Coplesr ]

& Dl

i

&y Copy Chit

o B B

£ @: Save Ae_ 2 Bdol 1 Obj
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5.3.9.1 Resize Mesh

Once a mesh has been created you can move it and resize it. To do this:

» Locate the mesh in the ICM Workspace and right click on it
» Select the Resize/M ove Mode in the menu.
» A purple box as shown below will surround the molecule.

To resize the mesh click on one of the corners of the box and drag to
the required size. The number displayed on the edges of the box
represent the dimensions.

5.3.9.2 Move Mesh

To move amesh:

» Locatethe mesh in the ICM Workspace and right click on it

» Select the Resize/M ove M ode in the menu.

 Click on the mesh in the graphical display with the middle mouse
button.

5.3.9.3 Mesh Representation

There are five different display modes:

Dot

Wire

Solid Rugged

Solid Smooth
Smooth Transparent.
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5.3.9.4 Mesh Color and Lighting

There are anumber of optionsto color and change the display of the
mesh. These options can be accessed simply by right clicking on the mesh
name in the ICM Workspace as shown below.

5.3.10 Mesh Clipping

Clipping tools can be used to adjust the frames of the mesh
independently of other objects.

The buttons shown below can be used for this purpose.

+— Clipping tools

Sl b [

Clip meshes —

Lock mesh clipping

The buttons used for clipping are described in the section entitled
C i pping Tools.

To clip the skin independently of the object as shown in the image
above:

¢ Display object and mesh.

¢ Click and hold on clip meshes button(red button) and select Reset
Clipping to Default and check the option Clipping enabled

e Clickonthefront clipping plane button.
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» (Optional) To lock the mesh clipping click on the yellow lock mesh
clipping button.

5.3.11 Save Mesh

Y ou can save a mesh as awavefront object by right clicking on the mesh
in the ICM Workspace and selecting SaveAs.

5.3.12 Occlusion Shading

The occulusion shading option provides better representation of depth
within a cavity. The color of each surface element of agrob (mesh) is
changed by mixing its own color with the background depending on the
burial of the surface element.

To add occlusion shading:

* Right click on the mesh in the ICM Workspace and select Occlusion
Shading. The occlusion shading value can a so be changed before
generating the mesh in the meshes tab.

» Enter adepth value - default is 0.8. Higher values will generate
amore dramatic shading.

See example her e.

5.4 Coloring

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

To change the coloring of molecules:
» Sel ect theatoms, residues, molecules, or objects you wish to

color in the graphical display or in the ICM Workspace.
» Then usethecolor optionsinthe Di spl ay Tab.

5.3.10 Mesh Clipping
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5.4.1 Coloring

To changethecolor of astructural representation such as CPK, Xstick,
wireor ribbon.

» Sel ect theatoms, residues, molecules, or objects you wish to
color.

» Click and hold on the structural representation button for the
representation you wish to color (e.g. wire, ribbon etc...) in the
Display tab.

» Select acolor by clicking color.

Tocolor by a particular parameter such as atom type, b-factor,
secondary structureetc...

 Click and hold on the structural representation button for the
representation you wish to color (e.g. wire, ribbon etc...) in the
Display tab.
» Select ..by-> option
To changethe color of everything displayed :

Click on the color paletteinthe Di spl ay Tab.
5.4.2 Color Background

To changethe color of the background:

» Select View/Color background.
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Color background

Color

bioc =] M| B
Ok, | Cancel | Help ‘

OR

Click on the square of your desired color. If you are not
satisfied with the color palate, click on the arrow next to the
colorsto customize acolor.

Right click on acolor in the colors panel in the display tab.

R T Q)

Right click here in the display panel to
set the background color.

5.4.3 Background Image

A background image can be added to the graphical display. This can be
useful for making cool images or for comparing structures (e.g.compare
displayed object with background image of object).

To add a background image from an imagefile (png or jpeg):

File/Open Image

Right click on theimage in the ICM Workspace and select "Set as
Background in Graphics."

Choose one of the following: (1) Origina Resoution, (2) Original
Resolution Centered, or (3) Scaleto Fit

Enter the Scale (%)

Enter whether you want to keep existing background.

To move and resize a background image: Version 3.7-2b and higher.

File/Open Image

Right click on the image in the ICM Workspace and select "Set as
Background in Graphics."

Choose the option Original Resoution.

Click on the drag atom button (looks like a hand).

Click and drag image.

Remember to deselect drag atom button.

5.4.2 Color Background
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To set current display as background image:

¢ Click and hold on the "Copy Image to Clipboard" button at the
bottom of the gui and select the " Set as Background" option.

Toremove a background image:

¢ Select the display tab and then click and hold on the color sphere
button and select "Remove Background Image"
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OR
* Right click on theimage in the ICM Workspace and select "Set as

Background in Graphics."
» Choose the option Remove From Background

5.5 Lighting

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

These optionsareinthel i ght tab

Iigh|t tab Save light settings
J display %y Tight " labels % pdbsearch % meshes %Y mawie l
Shine Ambient Diffuze Spec Alpha A-Bright ® b =
— = | B
Drag to Change settings Set default I|ght Settings

CLick and drag the dliders to change the lighting. Y ou can also save
your preferred lighting settings and return to default.

Shine - shininess property of the solid material

Ambient - ambient light intensity of RGB for ambient light
Diffuse - diffuse light intensity of RGB for diffuse light
Spec - specular light intensity of RGB for specular light
Alpha - transparency setting for grob

A-Bright - light intensity shinning on grob

X and Y - Change the position of the light source in the graphics window

5.6 3D Stereo

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

Click and hold on the stereo hardware button (see image below).

Docking MolMechanics Windows Help
FH MECEBAPes TFfsiil

% up-and-down i

line interleaved .‘.| G 3,65 5 ey 'Q:

-

it~ g-winidow
Sharp
ﬂ.nagl':,lph

There are 5 different options available which are described here
http://nol soft.com man/icmtabl e. ht Ml #GRAPHI CS. st er eoMode .

5.5 Lighting
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up-and-down
line interleaved
in-a-window
Sharp
Anaglyph

The Anaglyph option is the easiest to used with inexpensive 3D glasses
and and without any expensive 3D compatible hardware or monitors. The 3D
effect is better with alighter background.

grLONE

5.7 3D Printing

Y ou can save surfacesin the STL format for 3D printing. To do this:

» Makeanesh eg. goto the meshestab - plain solid.

» The mesh (surface) will then be displayed in the ICM workspace
(left hand side).

* Right click on the mesh and choose Save as.. and choose stl from
the format option list

5.8 Labeling and Annotation

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

To add labels or display or undisplay pre-defined annotation:
* Sel ect the atoms, residues, molecules, or objects you wish to
label in the graphical display or in the ICM Workspace.
e Thenusethelabel optionsintheDi spl ay Tab.
To add new user-defined annotation:
* Sel ect the atoms, residues, molecules, or objects you wish to

label in the graphical display or in the ICM Workspace.
» Right click on the selection and choose "Annotate Selection”.

5.8.1 Labeling

Labeling options are contained within the Labels or Display Tab. In many
cases clicking and holding alabel button will allow you to view more
options.
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5.8.2 Labeling Atoms

Select the atoms you wish to label (seedi spl ay structure orsel ection

t ool bar).

Select the display tab.
Click the label ATOM button.

Click and hold to change label options

2

arom +|  wam

1l | W
@ Chooze Color.
. by 3
Font...
Label style chi

cbl -0.3 [charge]

Fe +3 [farmal charge)

all properties

chl <mmff_type> charge
Element

Element+box

To changethelevel of label detail:

Click and hold the label ATOM button and select the desired level
of label detail, color or style.

5.8.3 Labeling Residues

To labd residues:

Select the display tab.

Select the residues you wish to label (seedi spl ay structureor
sel ection tool bar).

Click the label RES button.

5.8.2 Labeling Atoms
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Click and hold for more options

SmY e | .
" @ Choose Calor..

by s 3

Label Style A5

Dirag Labels Alas

Fant... ALAF

Shift to Sidechain Tips Ala

Shift to Calphas ALA,

Restore Positions ilanine 5
5
&
&
<molnarne
<ohjhames

To changethelevel of label detail:

» Click and hold the label RES button and select the desired level
of label detail or style.

5.8.4 Move Residue Label

To changethelocation of your residue label:

» Select View/Drag res labels.

« If your mouse has a middle mouse button, then click on handle (as
shown) of the label you wish to move, and drag it to your desired
area

Click on B )
this area _tj’”‘b( !

to drag
your
label.

* If your mouse has no middle mouse button, then click on the
Trandation icon on the toolbar, and click on the handle (as
shown) of the label you wish to move, and drag it to your desired
area.

The +/- buttons on the side of the Residue and Atom buttons will shift
the label. There are also other residue label move options available
when you click and hold the residue label button. These options include
Shift to Sidechain Tips, Shift to Calphas, and Restor e Positions

5.8.5 Label Variables
Tolabel variable angles (dihedral-torsion, planar and phase angle) the
molecule needsto be converted intoan | CM obj ect .

» Convert the molecletoan | CM obj ect .

e Select the atoms for which you would like to display the variables
(seedi splay structureorsel ection tool bar).
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» Click onthetoggle variable label button shown above located in
the display tab.

» Change the font size by using the +/- buttons.

» Change the font and color by clicking and holding on the variable
atom label button.

To change the variable label style click and hold the variable atom
label button as shown below.

Click and hold

o

@ | X LS | BB

P

x ﬂ Choose Culor

phi

£z
Ereray

‘ ¥ Ringz Only

Rings of varying diameter and color are superimiposed on rotatable
bonds. Green rings with large diameter are considered less constrained
than rings with small green rings. Red rings are highly constrained.
When the L abel Style/Energy option is selected the first number
displayed represents the bond angle, the second the energy and the third
the worst energy that could be achieved by rotating the bond.

5.8.6 Sites and Annotation

5.8.5 Label Variables
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Individua sites can be displayed or undisplayed in the ICM workspace.
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DENI TPLYEQ =" , 1 Annotation/Make Site.
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To create your own annotated site:

& 8 5

Sel ect theregion you wish to annotate as a Site.
Right click on the selection.

Choose the option Annotate/M ake Site

Enter the annotation into the text box and select ok
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To edit or delete asite:

* Right click on the site in the ICM workspace.
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5.8.7 Changing Label Colors

To changethecolor of any label:

 Click and hold down the required label button and a menu as shown
below will be displayed.

display abels ar

’?ﬂ AMH (FA!I

") choose color..

» Select color.

5.8.8 Customized Label 2D or 3D

To generate a customized a label:

* Select thelabelstab.
» Select either 2D or 3D button.
» Enter your label and select the desired color, font and size.

Select2D or

3D label Undisplay label
£ di Ia_l,l il labe pdb search ' meshes ' movie
FEPY % o O

€3 New Label

Type your custom label here

o 1 Add custom text

Faont
Farnily: | times ﬂ
Size: |20 3
[~ italic [~ bald
=
Help:

& |

OF. | Cancel |

To edit or delete alabel - right click on the label in the graphical
display as shown below.
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Right click here to Edit or Delete label

Structure of ZCJ
e s L I label 1: Crpsta.,

¥ Delete

€ Edit Label

Crystal Structure of 2CHM

Color: =-- .--l Muore

Farik

Family: | courier ﬂ
Size: |20 4
[ italic [~ bald

Ok | Cancel ‘

To move a custom 3D label you need to right click on it in the ICM
workspace (under meshes) and choose Connect/Move independently. Press
the Esc key to disconnect when you have finished moving it.

5.8.9 Undisplay Customized Label

Undisplay Residue, Atom, and Variable Label Any label that is displayed
can be undisplayed by selecting the region of the molecule related to

the label and clicking on the corresponding label button in the labels

tab. For example if you wish to undisplay an atom label - click the atom
label button. If alabel isdisplayed the coresponding button in the

display tab will be shaded blue. When you del ete the button will return

to grey. 2D and 3D labels have an undisplay button (red cross on the

button seecust oni zed | abel section).

Undisplay 2D or 3D label Click onthe undisplay label button in labels
tab.

NOTE: A label can also be deleted by right clicking on the label in
the graphical display and selecting delete.

5.8.10 Labeling Distances

Within the labels tab there are tools for calculating and displaying
distances. These tools can also be found in the Tool s/ Anal ysi s menu.
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Select Iabels tab Show distance from one atom to many

r Iabels " pdb se rc:h Ymeshes Y movie

“Jﬂl_ ¥4 [0 ]_ J ‘ Delete all distances

Threshcrlds

Show distance between two atoms

Show corresponding distance between two objects

To display distance between two atoms:

» Click onthelabelstab (previoudly called advanced tab).

* Select the atoms between which you would like to find the
distance. (Seesel ecti on tool bar)

» Click on the’ Show Distances Between Two Atoms' Button

* Thedistance will be displayed in angstroms, in green.

Tofind the distance from one atom to many:

» Click onthelabelstab (previoudy called advanced tab).

» Select the atom from which you wish to measure the distance from
(Seesel ection tool bar)

 Click on the’ Show Distances From One Atom To Many’ button.

» Thedistanceswill be displayed in green.

The maximal and minimal distances can be selected by entering valuesin

the boxes shown here (below) in the labels tab (previously called
Advanced tab).

o ¢ ol

NOTE: Distances can be displayed and undisplayed in the 3D |labels
section of the ICM Workspace. See image below.

5.8.10 Labeling Distances
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To changethecolor of thedistance label

* Right click on the distpair s under the 3D labels section of the
ICM workspace and select Change Color.

5.8.11 (Un)display Origin

Todisplay and undisplay the axis of the coor dinate frame (origin):

» Select the labelstab and select the toggle origin button.

Display or undisplay origin button - located in the
labels tab

S| G| [

5.8.12 Displaying Tethers

Theory

A tether is aharmonic restraint pulling an atom in the current object
to astatic point in space. This point is represented by an atomin
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another object. Typically, it is used to relate the geometry of an ICM
molecular object with that of, say, an X-ray structure whose geometry is
considered as atarget. Tethers can be imposed between atoms of an
|CM-object and atoms belonging to another object, which is static and
may be anon-ICM-object. Y ou cannot create tethersin ICM-Browser,
however, if the project that you have loaded contains tethers between
two objects, then they can be displayed:

» Click onthedisplay tab (previously called advanced tab).
» Click onthe’Toggle Tethers' button.

5.8.13 Displaying Distance Restraints

Theory

A distance restraint imposes a penalty function on the distance between
two atoms in the same object. Y ou cannot create distance restraintsin
ICM-Browser, however, if the project that you have |oaded contains
distance restraints, then they can be displayed:

» Click onthedisplay tab (previously called advanced tab).
» Click onthe’Toggle distance restraints’ button.

5.8.14 Display Clash

Todisplay aclash thefileneedstobean| CM Obj ect .

» Sel ect theregion around which you would like to identify clashes.

» Select the display tabs and the "toggle clashes' button shown
below.

Labels tab
£ labels  pdb search Y meshes % movie

N P e e “j

Togygle clashes buttun

5.8.15 Display Rainbow, Box, Ruler
To (un)display arainbow scale, box or ruler use the buttons shown below
located inthe Label s Tab.

box

SIBIA e

rainbow (click and hold to change colors)

5.8.16 Display Gradient

This button islocated in the display tab.

5.8.12 Displaying Tethers
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Toggle energy gradient button
EJ ﬁgg

This option is described in detail in the language manual
htt p: // ww. mol sof t. conf man/ i cm commands. ht m #di spl ay- gr adi ent

5.9 Display Distances and Angles

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

5.9.1 Display Distance Between Two Atoms - the
quick way

Click on the Display tab

Click on the Distance between two atoms button shown below.
Click on the atoms you wish to measure.

Distance will be displayed in the graphical display. Y ou can turn
this on and off in the ICM Workspace panel under the heading 3D
labels.

4|l G

Display distance

5.9.2 Display Planar Angle

» Select the display tab.
* Sel ect three atoms.
» Select the button shown below.

< wlaAl| G
Display plarLar angle
5.9.3 Display Dihedral Angle

» Select the display tab.
* Sel ect four atoms.
» Select the button shown below.

ﬂﬂ,ﬁﬂ K

Dihedral angle
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5.9.4 Delete Label

To delete distance or angle labels

e Select thedisplay tab.
» Select the delete distance or angle label button shown below.

Delete distance or angle labels button in display tab

| L] ~ |3 %
5.10 Graphics Effects

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

All the visual effects tools can be accesed by the Vi ew Menu or click on
the corresponding button in the View Tools panel shown below.

View Tools

B« EDAPSE & =
5.10.1 Fog

Fog Toggle(Ctrl + D) : this feature creates a fog-like environment for
your object, so that the part of your structure that is closer appears
clear and the distant parts are faded asif they arein fog. The
cl i ppi ng pl anes control the point at which the fog begins.

* View/Fog

5.10.2 Shadows

* View/Shadows
OR
select the shadow button shown below.

Toggle shadow

- I Qla

5.9.4 Delete Label
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5.10.3 Sketch Accents

To make images as shown below use:

* View/Sketch Accents

5.10.4 Elegant Ribbon & Ligand Sketch

» Display Tab
» Click and hold Hydrogen button
e Select Elegant Ribbon+Sketch

5.10.5 Occlusion Shading

Occlusion shading is for surfaces and meshes to give a perception of
depth.

To add occlusion shading:
* Right click on the mesh in the ICM Workspace and select Occlusion
Shading. The occlusion shading value can a so be changed before

168

5.10.2 Shadows



generating the mesh in the meshes tab.
» Enter adepth value - default is 0.8. Higher values will generate
amore dramatic shading.

5.10.6 Perspective

Toggle perspective Ctrl_P thiswill add perspective to your structure,
enhancing depth in the graphical display.

* View/Perspective
5.10.7 Animate View

Learn how to build fully interactive and interruptable animations.

Smooth Animated Yransitions

5.10.7.1 Make Animation

To quickly produce an ICM Molecular Animation:

* Click and hold down the "Begin rocking/rotation" button shown in
the picture below.

» Choose from the following options - X-Rock, Y-Rock, Xy-Rock,
XY -Rock, X-Rotate, and Y -Rotate.

t} s-Rock Q_ Click and HOLD DOWN the
Q \Bock :;':_'i Begin rockingirotation button
Fy-Rock s
v dT-Rock 3
&- *-Rotate L
Q, Y-Rotate [ t
&, SetSpeed/Range... —l__
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NOTE: Default rocking representation can be changed in the
Fi | e/ Pref erences/ Gui menu.

5.10.7.2 Change Speed, Range and Cycle Length of
Animation

To change the speed, range and cycle length of the animation:

* Click and hold down the "Begin rocking/rotation" button shown in

the picture above.

» Choose the set speed range option and change the speed and range

using the drag bars. Any change will appear in the graphical
display behind this box.

« If desired you can change the number of cycles of the animation.

Thisisanideal tool for scr een- shot novi e nmaki ng.

9 Rocking Preferences @@
Range Ji 1.00
Cycles

" Endless movemnent

-

f* Mumber of cpcles 4 >

Ok | Cancel ‘ Set Defaults |

NOTE: Thereisareturn to default button in the Rocking Preferences
dialog box shown above and defaut values can be changed in
Fi | e/ Preferences/ Gui .

NOTE: Default rocking speed can be changed in the
Fi | e/ Pref erences/ Gui menu.

5.10.7.3 Interrupt Animation

AnICM Animation or Transition isfully interactive and is interrupted
by asingle click of the mouse.

To stop or change an animation or transition:

» Click the "Begin rocking/rotation" button shown in the picture
below.

To temporarily halt an animation or transition:

* Click inthe graphical display. Once you release the mouse button

the animation will start again.

NOTE: If you click on the graphical display during an animation the
animation will beinterrupted. Whilst clicking and holding the mouse
button other operations can be performed such as zooming and
selections.
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=

B #Fock

& vRock =
Hy-Fock Eﬁ'

v WV-Fock X

{‘5- ¥-Rotate L

&, SetSpeed/Range...

Click in the graphical display window to
temporarily interrupt an animation

5.10.7.4 Saving an Animation

An animation can be saved in an ICM project:
Fi | e/ Save Project
Or

asasl i de.

5.11 Graphics Shortcuts

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[l CM Pro

The left mouse button can be mapped onto different graphics tools which
can be selected from the right hand tool bar.

Note: (1) You can access many non-rotation modes directly from the
rotation mode by using Middle and Right-mouse buttons, aswell as by
using theright, top and left margins of the graphics window. (2) Y ou
can access the rotation mode from non-rotation modes by pressing
Ctrl.

 rotation ( the default , press Ctrl if you in the non-rotation
modes)

* trandation ( the middle mouse button in the rotation mode)

» zooming in and out by dragging the mouse up and down (the left
margin in the rotation mode, or use the mouse wheel)

» Z-rotation ( the top margin in the rotation mode)

» selecting by box ( the right mouse click in the rotation mode )

 selecting by lasso ( Ctrl-draw lasso in the rotation mode )

» picking out atoms ( atoggle)

» picking out and labeling residues (atoggle)

« moving the front clipping plane ( the top section of the right
margin in the rotation mode)

» moving the rear clipping plane ( the bottom section of the right
margin in the rotation mode)

» moving the slab ( the middle section of right margin in the
rotation mode)

e unclipping ( Ctrl-U )

* rotating torsions (Ctrl-left-mouse-click in the rotation mode)

5.10.7 Animate View

ke . . .
(&2 — Click here to stop an animation
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 connect and unconnect separate molecules to movement controls
Many useful graphicstips are summarized her e.

NOTE: Key mouse controls are summarized in the command line manual
hereht t p: / / ww. nol sof t. conl man/ gr aphi cs-control s. ht ni

5.12 Molecule Move Buttons

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

To move your structure it must first be displayed in the graphics window
(for instructions on how to display a structure seethe Di spl ay Tab).
All of the following options are displayed in the Move Tools toolbar

(shown below).
— Center
Rotate — ' — Click and hold custom rotate options
4 — Translate
Zoom — &

s — Z-axis rotation

5.12.1 Rotation

In order to achieve the best pose for a picture or to enable the study
of a certain region of your structurein moredetail you may need to
rotatethestructure:
» Click on therotation icon on the toolbar.
Rotate — C
& -
£
=

* Click and drag on your structure in the display window until it is
in the desired position.

5.12.2 Custom Rotation

An option is provided to customize the rotation of the molecule. This
allows exact rotation by a specified number of degrees.

Rotate — G: — Click and hold custom rotate options

<+
£
%
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* Click and hold down the rotation button and a data entry box as
shown below will be displayed.

» Enter the number of degrees of rotation you require and in which
X, Y or Z coordinate.

9 Custom Scene Rotation @@
Rotate around:
{* X -5 Z
Rotate by 180, degress
45, | 90. | 180. | 270 ‘
soey [ ok | caneal |

To continuously rotate the picture:

* Click on the continuous rotation icon on the toolbar.

» Click, hold, and slightly move your mouse anywhere on the
graphical display window. The point at which you hold your mouse,
is the direction to which the object will turn.

* Positioning the mouse towards the center of the display will move
the object slower than if the mouse is positioned towards the edge
of the graphical display.

In order to rotate your picture around the Z-axis:

* Click on the Z-axisrotation icon on the toolbar.

Bodq @

— Z-axis rotation

» Click and drag your object around the Z-axis until itisin the
desired position.

5.12.3 Translation

To tranglate your structure up, down, left, or right:

» Click on thetranslation icon on the toolbar.

— Translation

Ho+q ©

» Click and drag on your structure in the display window until it is
in the desired position.

When you are displaying more than one object and you wish to trand ate
one object in relation to the other on the Z-axis:
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» Right click on the name of the object you wish to movein the ICM
workspace and select connect to object. This object is now
independent from the other object and can now be manipulated
separately.

» Click onthe Z trandate icon on the toolbar.

» Click and drag your structure along the Z-axis, moving it closer
or further from your unconnected structure.

» Onceyou are finished, right click on the name of the object which
is connected, and click on disconnect.

5.12.4 Zoom

Tozoom in or out of your structure:

» Click on the zoom icon on the toolbar.

— Zoom

ot @

» Click and drag your mouse up to zoom in and down to zoom oui.

Y ou can also zoom in and out directly with the right-mouse-button
without explicitly switching to the zoom toal, if you use the left
5% -mar gin of the graphics window.

5.12.5 Center

Torestoreyour pictureto the center of the graphical display window or
to center on a selection:

* Makeasel ecti on of theregion you wish to zoominto - if no
selection is made the whol e structure will be centered.
» Click on the center icon on the toolbar.

— Center

5.12.6 Torsion Angles

To alter thetorsion angle of certain residues of your structure
manually:

e Convert your pdb structure into an ICM object.

» Click on the change torsion anglesicon on the toolbar (see image
below).

 Click on the bond until you see the torsion angle displayed in
yellow (see image below). Click and hold on the bond around which
you wish to rotate aresidue. The changing torsion angle will be
displayed in orange.
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NOTE: This option can be used more effectively in conjunction with
thevari abl e | abel option.

To alter torsions by entering specific angle values:

» You can edit torsions by specifically defining the exact angle as
described here.

5.12.7 Connect (Move)

When there is more than one object displayed in the graphical display
window the objects are connected to one another. If you wish to move or
mani pulate one object independently from the others you need to connect
toit

Todo thisfrom the ICM Workspace:
» Right click on the name of the object you wish to movein the ICM

workspace and select Connect to Object. The object will now be
colored yellow.

5.12.6 Torsion Angles
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» Theobject is now controlled separately from the rest of your
objects by your mouse.

 Disconnect your object by once again right clicking on the name of
the object in the ICM Workspace and selecting disconnect in the
drop down menu or Pressthe ESCAPE key.

Note: you can temporarily switch to the global rotation in the
connected state if you press Shift

Note: usethe Escape button to disconnect

5.13 Clipping Tools

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

t —— Move Front Clipping Plane
T — Move Rear Clipping Plane
L Slab

+ —— Unclip

The clipping tools allow you to adjust the frames of the ICM window,
changing the clipping planes.

Clipping planes can aso be moved without switching to the clipping
toal, if you click the right hand margin of the graphics window:

e Thetop section of the right 5% margin of the graphics window:
moves the back clipping plane

» The middle section of the right 5% margin of the graphics window:
moves the slab (both clipping planes)

* The bottom section of the right 5% margin of the graphics window:
moves the front clipping plane

In order to move the front or rear clipping planes of your screen:
e Click onthe Movefront clipping plane or Moverear clipping plane
icons on the toolbar.
» Click and drag the respective plane frontward or backward,
depending on how you wish to clip it.

Y ou can aso move the slab of viewing window, keeping the distance
between the front and back clipping planes. In order to adjust the area
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of the structure where your viewing window is located:
* Click on the Slab icon on the toolbar.
» Click and drag the dab frontward or backward, depending on the
desired area of the structure you wish to see.
If you have made changes to the clipping planes which you do not wish to
keep or you wish to automatically fit your entire structure within the
clipping planes:

 Click onthe Unclip icon on the toolbar. Thiswill automatically
set the clipping planesto fit your object.

5.13.1 Mesh Clipping

Clipping tools can be used to adjust the frames of the mesh
independently of other objects. Thisis described her e.

5.14 Graphic Layers

Availablein the following product(s): | CM Br owser || CM Br owser - Pro

[ CM Pro

To display and undisplay layers of a structure you can use the buttons
shown below. Seven layers can be created and within each layer different
structural representations can be displayed.

Right click on one of the layer buttons and a number of options can be
chosen as shown below.
Tisgsean
FE [off]
Rename

Mernarize

Clear
=
ustick
CPE.

kake Current

To change the display in one of the layers:

» Right click on one of the layer buttons.

» Select arepresentation wire, xstick or CPK.

* You can do thisfor each of the seven layer buttons.

 Click on the layer button to display and undisplay. If the layer
button is shaded red then the layer is not displayed. If the layer
button is shaded light blue then it is displayed. Y ou can switch
between layers by clicking on the button or using the. Y ou can use
the memorize button to store a particular representation and clear
to remove a memorized representation.

5.15 High Quality Publication Images

5.13 Clipping Tools
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Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

5.15.1 High Quality Image
To make high quality publication images:

Thefirst step isto improve the quality of the image using the High
Quality Image and Antialias buttons shown below.

antialias
EA?&
high quality image

Tosaveand write an image:

» Select File/Write Image and the following window will be
displayed:

= Write image to a file 7 P4

" Antialiasing -"\f High resclution PNG 4/ High resolution '/ Vectorized Postscript &
Image Filz Name  icm Browse

@ ong () 6F (O rgh O targa () eps

{ Ok H Cancel H Help

Choose one of the tabs depending on the image type you require:

» Antialiasing allows you to make png, tif, targa, epsor rgb file
types.

» High Resolution PNG Allows you to specify aresolution increase
and transparent backgroun.

* High Resolution Allows you to specify aresolution increase for
tif, targaand rgb files.

» Vectorized Postscript This creates a vectorized postscript model
of the screen image. Instead of the bitmap snapshot this command
generates lines, solid triangles and text strings corresponding to
the displayed objects. Since the postscript language is directly
interpreted by high-end printers, the printed image may be even
higher quality than the displayed image. The final resolution is
limited only by the printer since the original image is not
pixelized. Warning: there may be inevitable side-effects for some
types of solid images at the intersection lines of solid surfaces
(i.e. large scale cpk representation, hint: use display skin
instead).
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**NOTE: With some graphics drivers the high resolution image may be
distorted or multiple representations of the image in one frame.
Please see the FAQs for a solution to this.

5.15.2 Quick Image

A quick image can be saved using this option. The image will be saved as
icm1.png in the current directory in which you are working. Each
subsequent image produced will be incrementally numbered.

Thisoption is also available via a button as shown below:

hSEG O

Quick Image Button

5.15.3 Image Options

Click and hold on the image button at the bottom of the GUI to:

e Copy image to clipboard (single click on the button also does

this).

Resize image (Write Image Advanced)

Transparent Background Write Image Advanced)

Store an imagein ICM (Write Image Advanced)

If you aremaking an| CM docunent you may want to store images
inside ICM (Add Image to Album).

et b el For additional image options — click
fide  Edit View Buoido  Tooh Momelogy LChewusty Docking  Bloldechonics g .
FEEO AR TR0 BB JISE EcED and hold on the image button at the
ey L\ o\ e \/ i\ i\ E—— bottom of the GUI.
H 4 @led gyl EEEEE N o= :
Wortapace Panel DE‘
no selection 5
S obiects (1 iter
ﬂmmm i

e @l P B0+

(v] g_skin_ beh a s';hbb ¥

{3 Copylmageto Chpboard
Write Image v
Write Image Advanced ... -
Add Image to Album...

Set as Background
YEIEIEY

1. Click and hold _

o [l o

' IQV

(o8 m0m (04

135 Agonns 16 Fiedd Mell Oy

5.15.1 High Quality Image
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5.16 Movie Making

Availablein the following product(s): | CM Br owser-Pro || CM Pro

B v =

BREA e Forie o A movieisan excellent way of
communicating 3D structural data.
The resulting movie can easily be
transfered into other applications
such as Microsoft Powerpoint.

| st T ]

— °066¢ =

There are two ways to make amovie:

» Makeamoviedirectly from aseriesof sl i des.
» Makeamoviedirectly fromscr eenshot s.

An dternative to amovieisafully interactive 3D document embedded in

Windows PowerPoint or a Web Browser, this can be undertaken using slides
andthe Act i vel CMplugin.

5.16.1 Making a Movie from a Set of Slides

To make amovie from a set of slides:

i MMk bon 27 3 Pl VQotint s R D W - Make a series of slides using the camera
‘button at the bottomof the screen. 0 |
CEEHO 90 TR0 AR PIAE EEDD P e e
o daginy "\ A S Tobefs \/ reshes Y/ starch 4l | &
BB vl b = i ptasadimoden |8l * | scmgancylinplyy | |t =
vsorkspacs Paned & L g
o seleckon . 2
-y shdes b
= shdeshow
4 Slide 1 [
2 Shide 2 ]
3 Shide 3 pal
4 Slide 4 ]
= ffl objects i
= - | R Wi 6A
L Ba 268 g
o ast ¢ 1 e
i tyrosine-| pfmen Iunase s‘,‘k cham i
HCIW (357 wate v
L4
]
&
i
" & K] ?:
- 1cm/1xbb>add slide display="-layout™ 3 1a
1cmflxbb>add slide dlspldy“‘ula,uu "4
E icm/1xbb>2
5 @ ‘!E_‘E] e &_‘Q_Ijﬁ_:.c' |1 [aged =] d‘.D 2 Mot O 1 ps. D= 00%)

Make aseriesof sl i des using the camera button.
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Right click on the dlideshow in the ICM Workspace and choose the option

"Export as Movie".
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Enter the filename for your movie and set the movie effect parameters.
Press OK and the movie will be written to afile.

5.16.1 Making a Movie from a Set of Sides
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5.16.2 Screenshot Movie

@; @ =’=l*—$creenshot movie making

To make a Screen-gr abbing M ovie follow these steps:

» Resize the graphical display to the screen size/resolution you
need. Y ou may also want to select thehi gh qual i t y image button
and antialiasing to improve the quality of the movie or add visual
effects such asshadows.

» To begin making amovie click on the movie making button at the
bottom of the graphical user interface (as shown below).

» Enter afile name for your movie and select the movie format
(-.mov, .avi, mpeg).

Enter filename

. . ¥
File namne: |||:mmm-'

Led Lo

Save az lype: |DuickTime filesz [*.movw “.gt)

QuickTime files [* mow * gt]
Wwindows video files [*.aw]
ool El_ NOMPEG videa files [*.mpg *.mpeq]

Choose movie format

By

Screenshot movie making button

NOTE: If you want to make a movie to include in a PowerPoint
presentation you need to save the moviein AVI format.

» To begin recording the screenshot movie click on the red Record
video button. Anything displayed in the graphical display will be
recorded, for example you can record ani nat i ons and transitions.
Specifying the nunber of cycl es intheanimation (rocking,
rotation) isan idea tool for screen-shot movie making. If you
have afast computer you can use Realtime screen grabbing which
can be selected by clicking and holding the Recor d video button.
Thereal timeoption canalsobesetinFi | e/ Pref er ences/ Gui menu.

& @)%

Record video button

» Thelength of the movie in minutes, seconds and millisecondsis
displayed in the top right hand corner of the graphical display.
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0:04:800

* You can pause the movie and fade out by clicking on the button
shown below. The number of frames for the fading out option can be
controled using the option in Fi | e/ Pr ef er ences/ Gui

Pause and fade out

|
& 11)m
Pause recording

* You can record a smooth transition from a previous frame by
clicking on the button shown below.

Smooth transition from previous frame
ORCKF

NOTE: Anything you do in the graphical display will be recorded in
the movie. For example you can change representations, lighting, add
new molecules etc. This can be achieved in a more controled manner
using the pause and record smooth transition button.

e Once you have paused the recording the viewpoint and
representation of the molecules can be changed and a smooth
transition from the previous frame can be generated by selecting
the Record smooth transition from previous frame button.

» To stop recording avideo press the button shown below.

Record smooth transition from previous frame
. @ 4 g

Stop recording

5.16.2 Screenshot Movie
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In this chapter you will find a
description of the tools available
to create files (.icb) containing
fully-interactive three-dimensional
(3D) molecules and two-dimensional
(2D) data. These files can contain
multiple interactive views and
animations of molecular structures
and objects in conjunction with
ittt related hyperlinked text, chemical,
o — biological sequence, alignment and
= | dataviews. The files are small and
easily transferable and
downloadable. The files can be used
for Molecular Presentation and Documents inside the ICM browser or
displayed on the web and in PowerPoint using the Act i vel CMplugin. For
examples of ICM Molecular Documents please see Mol Soft’s Activel CM
product page at www.mol soft.com/activeicm.html

= :ﬁ:_;t.fiz. -

EEN - -

Chapter Contents:

Maki ng Mol ecul ar Slides

How to Vi ew and Navi gate Slides

How to Edit Slides

How to Add Snooth Bl ending and Transition Effects Between Slides
How t o Make Mbl ecul ar Docunent s - Link HTML Text to Slides

Act i vel CM- Activel CM enables you to view and display ICM

graphical slides and animations interactively inside Windows

Microsoft PowerPoint and web browsers such as Internet Exporler

and Mozilla Firefox.

e | cmis isaJavaScript/HTMLS5 version of the Activel CM plugin.

6.1 Making Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

A dlide enables you you to store alarge number of different 3D
visualization along with text and window layout.The following
information can be stored in adlide:

» Viewpoint (e.g. rotation, translation, zoom, lighting and depth
effects)

» A set of atom-specific graphical representations such as surfaces,
which can be represented as smooth, transparent or wireframe,
ball-and-stick models, CPK (space-filling) models.

* A set of atom, residue or distance labels on any of the atomic
items

* A setof arbitrary 3D textual annotations assigned to apoint in
space

e A set of arbitrary 2D annotations assigned to specific 2D

coordinates on a screen

Parameters of the parametric ani mat i on

Window layout - for when the slides are viewed in the browser.

Current table(s)

Sequences and Alignments

HTML text with hyperlinks

2D images

For each grob (mesh): representation and colors.

A slide can be made by clicking on the Camera button at the bottom of
the GUI.
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e T e ”“’"‘“"”"’"’“‘”"‘{ Make a slide by clicking on the camera button.
EEFEO N TR0 ARSI SN MO«DBl@Ees TTEEERL
V" Gy "\ i\ Tabels 1 mesbus A seanch \/ ekt ) _ ®
| e R e | (B E & o e X2 | @] @la) g
icrkamot Faral 8% q’
no selection . P
.umt‘s (3 Besris) :
g - 2R &
L - ds06R (213732
H - ool ]R3 =
+-am SEQUBNCES } dem ]
: t;mﬂs -]
i
x
-
¥
-
&
%
bt
1- :SI’
} 1. Click on the camera |
s 4 0 I@ {-;] ;
o ® & i button to make a slide. S L o

Slidescan bevi ewed inthe GUI, can beedi t ed and gr aphi cal effects can
be added to them. Slides can also be embedded into the web, or
Power Poi nt using ActivelCM or viewed in ICM-Browser (or ICM-Pro).

Thistutorial takes you through the steps to create a series of fully
interactive 3D dlides. Another t ut or i al can befound here. To begin
making ICM Molecular Slides:

 First load the structure or structures you wish to display in your
first side. Additional structures, labels etc and text can be
added at any point during the slide making process. In this
example we will load the PDB file IXWS aPIM1 kinase.
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Load a kinase structure from the PDB.

“a 3. Click on the search button
8 . and a table of hits will be
2. Enter displayed
search string
lllst"

4, PDB stucture is

automatically listed
in the ICM
Workspace and
displayed

* Next, we will convert the PDB fileto an ICM abject so we can make
dlides of the ligand-receptor hydrogen bonds and binding pocket
surface.

Convert the structure from PDB format
=HE = "2 N | EEED A @ K . -
R oV into an ICM object.

a
-8
-a
1. Right click
here and
select
“Convert
PDB"
2. Enter the
options as
shown and
press OK.
s Bl ERE]——

* Now we are going to prepare the first slide by rotating the
protein structure to an orientation which allows the viewer to see

6.1 Making Sides
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the key features of the kinase. For example the bulge in the hinge
region (between the N- and C- lobes) which is unique to PIM
proteins.

Prepare the 1% slide: Orientate the
structure in the graphical display. ~

4. Undisplay the
default molecule
annotations by

3. Undisplay
the default
molecule

1. Use these
buttonsto

labeling by clicking here p
; clicking here rotatean
2. Undisplay move the
it Sinats structure.
molecule by
clicking here
-
J u L[] T

» Next, makethefirst slide by clicking on the camera button at the
bottom of the graphical user interface.
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e — : Make the 1% slide: A view of the first
*EE = Fim wEBER 49 %
o\ s bunit with li d displayed .
B subunit with ligand displaye y&
L= 2. Note: Slide is
s listedin the ICM
{5 Workspace
8.
1. Click here
to make a
slide
e |5 2

Click to add slide

» Onceyou have clicked on the camera button you will see that the
first slide has been generated. Thefirst slide is shown in the

CM Workspace window as shown below.

no selection

@ slides (1 items)

;"S'EidehDW The number and name of the

first slide is displayed in the ICM
= ohjects (1 iterns)
SBiom xReyis  Workspace
2 m 46 Amino

» Slidescan consist of Static viewsor Transi ti ons and Ani nati ons.
Here we will zoom into the flexible glycine rich region of the
kinase which lays across the roof of the ATP-binding pocket. Click
on the camera button and make the second slide
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) Vs b et 17 Ra [Pewragect 7] [1 s jeet)

ind & »
1. Click here to Make the 2™ slide: Center on the

glycine rich loop and color.

expand display to .
sequence level. =
=
4. Click on the color o
panel. 3. Click on the center =
B e g button.
2. Click and drag over .
400 glycine rich residues P ) .
" sl ‘ to select them. i
5. Click here to add
rocking and or rotation.
6. Click here
to make a
slide
LR =IEN OO
* Next, wewill make adlide of the surface of the ligand binding
pocket colored by binding property.
- = Make the 3" slide: Ligand binding
FEE = PN wEEDASE
SO S — - pocket surface colored by property. o
F =
HE' :‘:
a

3. Right click here
and select
pocket/receptor
pocket.

2. Right click
here and
select
center.

1. Display
ligand.

4. Click here
to make a
slide

* Now save the document as anicb file. Go to File/Save as...
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6.2 Make a Movie from a Set of Slides

Availablein the following product(s): | CM Br owser - Pro || CM Pr o

Please seethe novi e chapter on how to make a movie from a set of
slides.

6.3 How to View and Navigate Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

6.3.1 View Slide Show

To view adide show select the buttons shown below:

b Loy o — = — . _macro
o T ted. ..
icmfd - ocdh Y icw browser exsmple.ich”
Info % Hernl Documents- =Main ogene serinef/threonine-protein kinase pi
Info 52-: graphic modes read from C:/FProgram File
w | Info zad (skipped 1) frow V:hicmd)icw browser
E|licm/ 1] B Default Layout lideshow.slides index=1 add
& icm/ 1 Toggle Slide Layout

€4 6D

EIEI G@]=]8] « [= ][] *@‘]

Click and hold and select Toggle Slide Layout Run Slideshow

NOTE: Slides are associated with the objects currently loaded into
ICM. Thereforeif you del ete an object then the slides will not work.
However if you delete an object and then re-read the same object with
the same name and structure the slides will be ok.

To save adide show

» File/Save Project
6.3.2 Slide Navigation

Y ou can make as many slides as you wish as described in the Maki ng
Mol ecul ar Slides section.

To navigate through the slides you can use the buttons shown below, the
cursor keys for some operations or the right click optionsin the ICM
Workspace.

6.2 Make a Movie from a Set of Sides
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Previous Slide Jump to Selected Slide

C RN g
I
Next Slide

Add a Slide Final Slide

The dlide currently displayed is highlighted in red in the ICM
Workspace.

- slides (1 items)
=-slideshow

Currently displayed slide

To jump to another sideright click and select "Set Slide".

All sides are displayed in the ICM Workspace. Y ou can hover the mouse
over aslide namein the ICM Workspace and athumbnail sketch of the
dlide isdisplayed as shown below. This can be used for slide navigation
purposes.

€8 slides (1 items)

4-slideshow
-
3 -"h
d]
5 Hover mouse over slide name in the
- ICM Workspace and a thumbnail
-7 sketch of that slide will be displayed.
.8
..
-1

= obje .

BN - R == mn i
S m 46 Amino

Or you can right click on the name of the slide in the ICM Workspace and
select the option "Preview".
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no selection B €3 ICM Slide Preview [test] ?X]

-5 slides (1 items)
L slideshow This is a test

Select

Set Slide

Set Shide Smooth
Codisplay Slide
Edit Slide. ..

LR s B I e B o B SR RN

Prewigw. . —  1a

- ¥ Delete
—u DbjE:L.t [T TETITS])

S 1o %-Ray 150

Pl 46 Amino

6.4 How to Edit Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pr o
[ CM Pro

Y ou can jump to the slide you wish to edit by following the sl i de
navi gati on instructions.

6.4.1 Edit Slide

Edit slide contents: To edit the content of a slide the procedureisto
add a new dide and then delete the old one or use the "overwrite
current slide" option as shown below:

» Click and hold down on the camera button.

Save Slide...

Owenarite Current Shide
Edit Shde Descrption...

Maove Current Slide. .
@ ale] o o/

Click and hold

To edit aslidedescription.

* Click and hold down on the camera button and select the option
"Edit Slide Description”.
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@@ 3 FIiN =EEDAIE
i el #x

- Hoodpf Aodn O

2. Edit the slide
name and
description

1, Click and hold
here and select
“Edit Slide

Description

 Enter the name of the dlide

» Enter adescription of the slide.

* If you wish to keep the current window layout or active tabs check
the boxes provided

Todeleteadide:

* Right click on the name of the dlide in the ICM Workspace and
select Delete.

To change the name of a dide

* Right click on the name of the dlidein the ICM Workspace and
select Edit Slide.

6.4.2 Move Slide

To change the slide' s position in the slideshow use the Move Current
Slide option and select the new position from the list.

* Click and hold on the "make dide button"”.
» Select Move Current Slide.

a a

Save Slide...
Owenarite Current Slide " laYOL
Edit Slide Descrption...

Click and hold
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» Select the position in the slide show where you want to move the
dideto.

5 Wove Shide in Siideshow

Move to position:

Ok Cancel ‘

Co-display morethan one dlide

* Right click on the name of the dlide in the ICM Workspace you wish
to co-display with the curently displayed slide.
» Select the option co-display slide.

6.5 How to Add Smooth Blending and
Transition Effects Between Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

How to add smooth and blend transitionsto a slide.

* Right click on the name of the slidein the ICM Workspace.

» Select Edit Slide.

» Select the desired transition effect - smooth or blend as shown
below.

» Select the length of the transition in milli seconds.

Add smooth transitions and
transformations between slides.

FEE T PN mEERADE
- o —

1. Right click "
" hereand |~
b choose Edit i
- Slide :
G
3, Enter the
2. Check the transformation
Smooth i
phapiel timein
an fnl'_ en milliseconds
option
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6.6 How to Make Molecular Documents -
Link HTML Text to Slides

Availablein the following product(s): | CM Br owser || CM Br owser - Pro
[ CM Pro

An ICM Molecular Document contains text and images which can be
hyperlinked to the graphical display. Click on the hyperlinked text and
then afully-interactive 3D dide will be displayed. The hyperlinks are
usualy linked to a set of slides but can also be linked to a series of
commands in a script, aweb page, atable or alignment. Once a molecular
document has been made you can view it in the ICM-Browser (File/Save
Project .icb file) or download Act i vel CMand view it in aweb page or
Powerpoint.

Tobegin creating an ICM document

» File/New/ and click onthe HTML tab.

» Enter sometext. E.g the Name of the HTML document. Formatting can
be changed as described in the edi t section below.

* Click OK

Prepare HTML text for the molecular
document,

im wWEEGAR

C - AR T

. _ 2. Click on the
g e Html tab.

= & S

3. Enter name
ofdocument.

e A HTML text panel will be displayed in the graphical user
interface.

NOTE: You can add multiple documentsinto asinglefile. The
documents will be accessible viatabs at the top of the HTML panel.

6.6.1 How to Add Text or Edit a Molecular
Document
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Toedit the HTML text in the graphical display

» Firstcr eat e an HTML document and the text panel will be displayed
in the graphical user interface.
* Right click in the body of the text display panel and select Edit.

To oo Add text to the Html document (1).
) 'ﬁ,:_. _:LI _:'_:‘]]EBB.U.I "
: m.f @ alEas | BEED (B S | R | b 2|n

EsoDr AD+n O EI

T 1. Right click in the
o= white space select
L
: o
: oot ok 1
8

- [w] ADDOOE

» Enter text and use the formatting tools provided in the panel
above the text editor. Make sure you have selected the Edit tab in
the HTML editor. Y ou can see your pagein the View tab or write
directly in HTML in the Sour ce tab.
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Add text to the Html document (2).

o it Ak SPGB CEIDER X

- EeCDF Bot+ne E

BlIUcid =« BEEDE EEa@
The Crystal Structure of the Pim1 2. Use t!"IE
b e N e e formatting
’_' Lo | =L N T Ty tools here.

1. Type text
here. Make
sure you are
in Edit mode
(see below)

3. Toggle between View,
"1 Edit and Source mode.

AT g 573 o i1 04

| Zoom |[insert External Link e.g http!

1 Insert Comment f Insert CheckBox
. 1 Remove Formatting

2 e == w
Insert Table| | Insert Special Character |

y of iPage proferd raed i the semby ane of the ol e therelors Lapgerg iPace
re gl s b gorsd ey Ui harard, The dryg Carsched (i o9 2 bada |

Write in HTML using the Source Tab |

! Italic | !Sub,z‘SuperSr:npt| [ Text Format I
£ @
Cy | B i | = 2§ |ryzen
q‘-% List Level |
- el TE}Ct AHgnmEﬂt et . The drag Carssodsl (bnosen 45 a beta

of ths vell sind Ehewrefone bergating Ehese

BT OLRANTSTES £ ART A
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6.6.2
Slide

How to Make a Hyperlink Between Text and a

To makea hyperlink between thetext and the graphical display (dide)

Make adlide or set of dlides of the graphical display you wish to link

to. See

created:

Maki ng Mol ecul ar Sli des for help on this.Once dides have been

File/New/Html

Right click in the body of the text display panel.

Select Edit.

Highlight the text you wish to link to a graphical display - you
can do this by left clicking and dragging over the text (selected
text will be highlighted in blue).

Click on the "Camera button" in the HTML editor formatting tool
panel.

Select the Slide tab.

Select which number slide you wish the text to be linked to from
the drop down menu.

Thereisan option to display the slide as a thumbnail image in
the text document panel. Check if appropriate.

2. Click on
the camera

button
et | [ e
down button to find
websites or add an the slide
ICM script

| Add a link from the text to a slide.

" I DB AR

BAe S oarBE0B0E R ¥
BT (ujc ¢ T '.,:'.;;..Esi- ” . 1. Click and drag over
. Leetilaw | the text you want to

make into a link

6.6.3

Insert Image

NOTE: The easiest way to add images (PNG or JPEG) into an ICM
Document is to use drag and drop. Y ou can drag and drop the image
into the ICM Workspace or go to File/Open. Once theimage isin the
album in the ICM Workspace you can then drag it from the ICM
workspace into tthe HTML editor.

6.6.2 How to Make a Hyperlink Between Text and a Side
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F display % Tight “‘t" labels “‘y"pdh zearch “‘{me&he& Womavie

| no hydrogens J | H ’_j ‘luﬁ.- &3 HTML Source Editor

< @ |G| 8| | ulHw
} docT
ho selection Ill f khtuls
oy images (1 itern) |”§":') & | # " R <headr<titlex
- Ealbum Insert an gji%u =< fheads
Lemgdels browser’ . SeETin e
E@html “ ”Em) |mage. <hody text=hlack hgocolor=whitex
""" doc <hlxInsert an image.< hl>
< /body
</htmls

Drag and Drop from the ICM Workspace to the HTML source editor

Another way toinsert a pictureintothe HTML text panel

 First read theimage into the ICM photo album File/Open OR Drag
and Drop from directory into the ICM Workspace.

Theimage name and preview will then be displayed in the ICM Workspace.

=gy images (1 item)
- album

----- =1 guil.png
----- .2 guiZ png

* Create HTML text - File/New/HTML. Add text.

* Right click inthe HTML window and select ' Edit Source'.

* Right click on the position in the ICM Script Editor where you
would like to insert the image.

e Select 'Insert Image

Image source:

—image Size
Width: I1ﬁﬂ Heset Qriginal!
Height: 1123

W Keep original aspect ratio

oK Cancel

- £

» Select the image name source.
» Choose the desired Width and Height.
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e Click OK.
e Click Saveinthe ICM Script Editor.

6.6.4 Insert Script

How toinsert a script to the text panel
There are 3 ways to add a script - described in more detail below
1. Drag and drop script from ICM Workspace

2. Inthe HTML Source Editor - right click and select Insert Slide or
Action

3. Create an "inline" script
These methods are described below:
Drag and Drop Method

» Create a script File/New/Script

» Thescript will be displayed in the ICM Workspace.

e Right click inthe HTML Text Panel (for instructions on how to
create this panel seecr eat e nol ecul ar docunent ) and select edit
source and the HTML Source Editor will be displayed.

 Click-Drag and Drop the script into the HTML Source Editor

A line as shown below will be added.

<a href="#icm script/scriptl">text placed here will be displayed as a link in the docunent</a>
Another way to add a script to the document isto Insert Action:

* Right click in the body of the text display panel.
» Select Edit Source
» Highlight the text you wish to link to a graphical display - you
can do this by left clicking and dragging over the text (selected
text will be highlighted in blue).
* Right click and select ’Insert Slide or Action’ or select the
button in the HTML Source Editor and a window as shown below will
be displayed.
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9 CreatefEdit a 5lide or a built-in |[CM Script

Internal Link Mame |Linking toa m:ripd

Highlighted text |Link ket ko & script

Help: start script from fdialog!'name" to generate a dialog)

™ Dizplay Slide : slideshiow1] W Az Thumbral - Smooth Trangtion:  |2000 El: MEec

f* [Arguments and] ICH commands

Ldd wour script here

0K | Cancel

» Select the option [Arguments and] ICM commands
» Add script in the editor provided
» Select ok

Inline Script
A script can be added to the HTML text in the following way

* Right click in the body of the text display panel.
» Select Edit Source
» Enter script in the format as shown below.

<l--icnscript nanme="script2"

#di al og{" Test"}

# i _nunberl (2)

# i _nunber2 (3)

print $1 + $2

--><a nane="script2" href="#_">script2</a>

6.6.5 Insert a Dialog Box

Dialog boxes are provided to enable a viewer to interact with a
presentation or document file. The dialog box will be a gui data entry
box. For an example here is a script to prompt the user of the fileto
enter a pdb code;

#di al og{"Read PDB File"}
# s_pdbcode (1lcrn)

read pdb $1

ds a_ 1.
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RR=T P

Please Enter PCB Cods |1erm j

ok Gancel I

The code above can be saved as a script or inside the html text. To do
this:

1. Rightclick onthe HTML text display and select "Edit Source".

2. Highlight the text you wish to link to adialog box and then
select theright click and select ' Insert Slide or Action’ or
select the button in the HTML Source Editor and a window as shown
below will be displayed.

hd Create/Edit 2 Slide or a built-in ICM Script

Internal Link Name IExamplescriptE

Highlighted text I

Help: start script from #dialog{"name”} to generate a dialcg.

" Display Slide : E ] r ] 3:

& {Arguments and] ICM commands

8] 4 Cance| l
b o

OR.

1. Right click onthe HTML text display and select "Edit Source".
2. Addalink to ascript as shown below.

<a href="#icnl script/scriptl">Exanple Script 2</a>

6.6.6 How to add a check box.

To add a check box:

 Click on the check box button in the HTML editor tools panel (see
below).

* You can choose the check box to toggle an object or molecule on or
off. Or you can be more specific about the toggle actions using
the ICM command line. Y ou can choose different actions for On and
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doct W docl 14

Q) undo e 3 cut | {anel EE #8 & (@ocemslk € Speosl e
4 o F T

o Pasts D K x 3 > EEEHE g Action

(i@ Open HTML Fie B I U G Body text ¥ BEE 3y cide

ﬁ Ingert Checkbox 7 W

Obgect Type [objects =] [a_nam, e

¥ Customize Togge Actions

User 351 o refer i the object name albove., For exsmpls: “display %1
OnCheck | Oniinchedk |

d% &pk n_;bc}::.u:t.l

6.6.7 Document Navigation

The following buttons shown below aid document navigation. Also remember
that more than one document can be stored and the header of each

document file will be displayed in multiple tabs in the text panel

window.

/ENNOT_FOFS
‘IH« XA
|

View Previous / Home |Zoom Out Search Text Tools
View Next ZoomIn

6.6.8 Protect Shell Objects From Deletion

When making a molecular document you can protect objects from deletion
by the person who reads your document by:

* Right click on the object in the ICM Workspace.
e Select the Protect option.

6.7 ActivelCM
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| Activel CMenables you to view and

d|splay ICM graphical sl i des and ani mat i ons interactively inside Windows

Microsoft PowerPoint and web browsers such as Internet Exporler and
Mozilla Firefox.

Chapter Contents:

How to Enbed in M crosoft Power Point 2003
How to Enmbed in M crosoft Power Poi nt 2007
How to Enbed in M crosoft Power Point 2010
How to Enbed in a Web Browser

How to Use Activel CMin Power Poi nt

How t o Change Activel CM Conponent Properties

Background | nages

6.8 How to Embed in Microsoft PowerPoint
2003

Setup
» Download ActivelCM from www.mol soft.com/support
» Savean ICM file (.icb) containing dides. Click her e to see how
to make slides.

Embed icb file

» Open the Insert menu from the top bar of PowerPoint and select
Object
» This opens up the Object dialogue. Select Activel cmCtIClass:

¥ Creste new MCEFClage | B

W ndmbﬁ Arohat 7.0 Document | ancal E
= Bitrnap Image i

Calendar Contral 11.0

DatePicker Contral I :

Group'Wise Secure Mime Control I Display a5 icon

W amposeCt] Class

Microsoft Equation 3.0 ;I

Result

i , Inserks a new ActivelocmChl Class ohject inko wour
Mm prasentation.

» Click on OK. A file dialogue will then be opened. Open the ICB
file you wish to use viathis dialogue. IMPORTANT: To avoid later
problems, make sure the ICB fileisin the same folder as the
PowerPoint file.

» A low-resolution snapshot of thefirst didein the ICB file will
be shown in the activel CM control you created. Y ou can change the
shape of the control by dragging the corners of the control with

6.7 Activel CM

Advanced use of activelCM Macros to direct visualisation changes



the mouse, once selected.
¢ Right-click on the activel CM control and select the Properties
menu item

T

] e EBR yew Iest Foema ook Shgethow  Wrdow el

af e £ 3 EOA W e ek BXQ P @es mEs g
W% '. 3 2 vepeadlacrca@eacpader-qondeaaop@enea pdl noaca@eoncacagoasagoropoatoronerdleaonea i@
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¢ Savethe PowerPoint presentation

6.9 How to Embed in Microsoft PowerPoint
2007

Setup

¢ Download ActivelCM from www.mol soft.com/support
¢ Savean ICM file (.ich) containing dlides. Click her e to see how
to make dlides.

NOTE: Here are the instructions for Activel CM in Microsoft Office
2007, for older versions of PowerPoint see her e.

Enable the Developer Menu:

¢ Click the Microsoft Office Button (button top left), and then
click Power Point Options.

¢ Inthe Power Point Options dialog box, click Popular.

¢ Under Top optionsfor working with Power Point, selet the Show
Developer tab in the Ribbon check box, and then click OK.
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1, Click the
Microsoft Office
Button and
then Click
PowerPoint

Options : | 2. Enable Developer Menu

Insert Activel CM into Power Point:

Select the Developer menu.

Select the M ore Controls button in the Controlsfield.

Select Activel CM Ctl Class from the list of controls and click OK.
Click the mouse anywhere in the white PowerPoint space and a
diaog box will be displayed asking you to select your ICM (.ich)
file.

¢ Click and drag at the corners of the image to resize the normal

way you would resize an object in PowerPoint.

o el e s . -
= s i i g - s .
Ty AR N E— _k C 2

g:#‘ el i 1. 5elect Developers Menu

3, Select "Activel CMGt) Class!

4, Click anywhere here and select
ICM (.ich) file.

6.10 How to Embed in MicroSoft
PowerPoint 2010

Setup
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» Download Activel CM from www.molsoft.com/support . Please always

check you are using the latest version.

» Savean ICM file (.icb) containing dides. Click her e to see how
to make slides.

Enable the Developer Menu:

 Click on the File tab, and then click Options menu.

» Select the Customize Ribbon option and then check the Devel oper
option in the right hand side panel (see image below).
» Click on the Developer Menu.

* IMPORTANT! Click OK and then you will see the Developer Menu in
the Ribbon at the top of PowerPoint.

Select the Devel oper menu.
Select the M ore Controls button in the Controlsfield.

Select Activel CM Ctl Class from the list of controls and click OK.
Click the mouse anywhere in the white PowerPoint space and a

dialog box will be displayed asking you to select your ICM (.ich)

file.

e Click and drag at the corners of the image to resize the normal

way you would resize an object in PowerPoint.
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6.11 Embed in Web Browser
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NOTE: Thereis now aplugin-free version using JavaScript/HTML5 - click
her e for moreinformation.

To embed in aweb browser.

1. Download ActivelCM from here
http://ww. nol soft. conl get browser. cgi ?product =acti vei cn&act =l i st

(itisfreel).
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2. Creat e anHTML pagein ICM (File/New/Html).
3. Addaseriesof sl i des.
4. File/Export As ActivelCM Html..

NOTE. Thereis an issue with FireFox21 because it disables the Activel CM
plugin. The workaround at the moment is:

 typeabout:config in the location (address) bar and press the
"Enter" key to open the about:config page, just like you open a
website by typing the URL in the location bar.

* if you see awarning message then you can confirm that you want to
access the about:config page.

* inthe Search bar at the top of the about:config page type
"load_appdir_plugins

» double click on the preference to set value to true

e restart FF

6.12 How to Use ActivelCM in PowerPoint

**MPORTANT There aretwo waysto open a presentation:

» Doubleclick on the ppt file in windows folder. (in this case
PowerPoint will set the current directory to the one which
contains the file and there should be no problems with both
relative and absolute paths)

e Open ppt through the "File-Open™ or recent files. (in this case
PowerPoint DOES NOT SET the current directory to the one which
contains the file -> relative path might not work and user will be
prompted to locate the ICB file unlessfile is found in absolute
location)

Toview thedidesyou must bein Slide Show mode

» Pressthe F5 button to start the Slide Show. In edit mode (i.e.
not presentation mode), the control is shown as a static image ¢%o
it isnot possible to interact with the ICB file. Therefore, to
prepare the presentation so that the control shows the correct
initial visualisationsiit is necessary to run the PowerPoint
dide(s) in presentation mode

Change Slides
» Usetheleft and right cursor keysto change slides.

A number of other options can be accessed by right clicking on the
dide. These optionsinclude:

Select Slide

Auto Play

Set on/off rocking
Center

Load anew ICM File

6.11 Embed in Web Browser
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ICM Embedded Into PowerPoint
in Slide Show Mode (F5 button)

You can also add multiple Activel CM 3D displaysin one dlide:

e Todisplay mutliple ActivelCM 3D displaysin one slide just copy
the original display or repeat the steps described above. All
powerpoint slides should point to the same ICM file (.icb) but
they can point to different dlides.

6.13 How to Change ActivelCM Component
Properties

A number of properties of Activel CM can be changed once embedded in
powerpoint. The optionsinclude:

210 6.12 How to Use Activel CM in Power Point



Select thefirst dide to be displayed.

Set slide auto play.

Set auto play of ascript.

Embed the powerpoint file and the icb file all into one file.

To change these options:

¢ Right click on your embedded activel CM in Powerpoint.
¢ Select Properties and click on the button shown below.
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1. Right click here '
3 2. Select properties
3. IMPORTANT — CLICK HERE
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* A Property Pages window will then be displayed as shown below.
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To changethe file name of theicb filelinked to activel CM: Simply type
in the path to the file or use the browse option.

To changethecurrent ICM dlide: Use the drop down button next to
Current ICM Slideto select the slide you wish to display first in your
presentation.

Toauto play dlides: Check the Auto Play Slides box and select the
interval between slides option. A range of dides can be played by
entering the number of the slides separated by a comma.

Toauto play a script: Select whether you want the script to run On
Click or On Slide then select the script from the script to play drop
down button. Y ou should first save your script in theicb file.

To embed theicb filein the ppt file Click the Embed Fileinto Control
option. Important - Please save your PowerPoint filein thet 1997-2003
ppt format not pptx.

6.14 Advanced use of activelCM: Macros
to direct visualisation changes

Documentation kindly provided by Dr. Brian Marsden (SGC Oxford
http://ww. sgc. ox. ac. uk/ peopl e/ bri an/ )

It is possible to write simple VisualBasic scripts to avoid having to

use the right-click menu approach to changing activel CM control slides
within the control itself. This allows one to place buttons outside of

the activel CM control, but in the same PowerPoint slide, which controls
the control’ s behaviour. Below are a couple of useful examples of this
approach.

Creating a button to set the control’s active dide:
Insert a button Office 2003
* In edit mode, make sure the control toolbox toolbar is shown by

right-clicking the blank area at the top of the top bar and
ensuring Control Toolbox isticked.

21%.14 Advanced use of activel CM: Macrosto direct visualisation changes
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¢ Click on aniconin the Control Toolbox which correspondsto the
sort of button you wish to use. Then click and drag in the
PowerPoint slide to generate the button.

Insert a button Office 2007:
¢ Inedit mode, click on anicon in the Devel oper menu or ribbon

which corresponds to the sort of button you wish to use. Then
click and drag in the PowerPoint slide to generate the button.
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* Double-click on the new button to open the VisualBasic editor with
two empty functions pre-defined. The first one pertains to the
control itself and can be ignored in this context * For the second

function (which isfor the newly-created button), copy the

following into the editor, between the two lines of function code:

ActivelcnCtl1l.currentSlide = 2

» Thissetsthe current activel CM control’ s slide to be number 3
note that the value placed in this code needs to be 1 less than
the actual slide number (confusing, no?). Obviously, use avalue

here that makes sense in the context of your ICB file.
» Thisshould leave the editor looking like this:

| 4 Microsoft Visual Basic - Presentation? - [Slide? (Code}] okd
(M FEe fet wiew  nsert  Format  Dedug  Bun  Jook  Adddas v . B X
BaE-d s L 0 pono@ b B | iné, Col3
X |cammamaumn1 :j
] 3 ol = Private Jub ActivelcomCtll MouseClicked(}) ".“'
- # VBAProject (Presentatio
= 25 Microsoft PowerPunt OB End Sub
1] shde2
BErivat
Recivelemiell . eurs
End Sub
£ > 1= v

» Closethe Visual Basic editor

» To changethe physica properties of the button e.g. text, colour
e.t.c.right-click on the button and select the Properties menu
option. This opens up a dialogue as below, where many properties

of the button can be changed:

Properties [:}
;Commandﬂuttanl CommargiButton _-J

Alphabetic Ic.;tegm'zgd |

| {Blame) CommandButtonl ™

Aecelerator [

AutoSize False

SackColor [ smso000008 %

BackStyle 1 - fmBackStyleOpague

Caption CommandButtonl

Enabled Trus

Font Arial

ForeColor B =+300000128

Height 35.75

Left 53.875

L ocked False

Mouseloon {(Mone}

tMousePointer 0 - fiiMousePointerDefault

Piciure {(None}

FicturePosition 7 - fmPicturePositiondboveCentar

TakeFocusOnClck Trug

Top 321

isible True e

Width 153 >

» Using thisdialogue, it should be possible to disguise the button
to look like normal text (for example) which can be clicked on

during the presentation to change the visualisation of the
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control, apparently magically. Note that the button will only work
in presentation mode.

* IMPORTANT: In Office 2007, remember to save the PowerPoint
presentation now as a pptm file that is, a macro-enabled
PowerPoint file otherwise the macros will not work next time you
load the presentation.

Other code examples: Just copy and paste the example of interest inside
the function for the button in the Visual Basic editor. Code that

enables a button to cycle through the ICB files didesin order

(including wrap-around)

currentSlide = ActivelcnCtl 1. current Slide
nunsSl i des = Activelcntl 1. nof Slides

If currentSlide = nunSlides - 1 Then
ActivelcnCtl1l.currentSlide = 0

El se

ActivelcnCtl l.currentSlide = currentSlide + 1
End I f

6.14.1 PowerPoint Cache Errors

PowerPoint caches some information about active controls. Sometimes
after an Activel CM upgrade you may get an error when trying to access
some property or method: "Wrong number of arguments or invalid property
assignment" or something similar.

In this case you need to close PowerPoint and remove all files from the
location below:

C:\Documents and Settings\sevalLocal Settings\Temp\PPT11.0

6.15 Background Images

In Activel CM version 1.1-5 and higher you can add background images to
your icb file and display in PowerPoint and the web using ActivelCM. The
documentation on how to insert background images can be found her e.

6.16 ICM JavaScript (IcmJS)

IemJS (formerly known as ActivelcmJS) is a JavaScript/HTML5 version of
the Activel CM plugin. Y ou can read more about IcmJS her e.

To make afully interactive 3D molecular web page from ICM and embed
using lcmJs:

* UseICM vesion 3.8-5 or higher. If you do not have access to this
please contact Mol Soft to request it.

* Makeasetof slides.

» Goto File/Export as Activel CM Html and then select the IcmJS
check box.

e ThelcmJSfile will then be saved to your computer which you can
open in any modern browser e.g. Chrome, FireFox or Safari.

6.14.1 Power Point Cache Errors
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seguence manipulation tools are contained within ICM. In this chapter we
will describe some of the bioinformatic manipulations you can perform
with sequencesand al i gnhment s.

Chapter Contents:

Read and Save Sequences

Sequence Secondary Structure

Bi oi nfo Menu Opti ons

BLAST - Sequence Search and Align
Sequence Alignnents

Al ignnment Editor

Color Structure and Surfaces by Alignment

7.1 Read and Save Sequences

Availablein the following product(s): | CM Pr o

There are a number of different ways to load a sequence into ICM viathe
Graphical User Interface.

7.1.1 Read a Sequence from UniProt

Uniprot is a curated protein sequence database which provides a high
level of annotation (such as the description of the function of a
protein, its domains structure, post-translational modifications,
variants, etc.).

Toread a sequence from UniProt:

File/Load/UniProt
Enter UniProt ID

or usethe option inthe Sear ch Tab.

7.1.2 Cut and Paste a Sequence

Paste your own sequenceinto ICM

File/New/Sequence
Paste the Sequence into the box provided.

7 Working with Sequences and Alignments

Many powerful
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€ New molecule/sequencefgrob

Feptide l Compound ] DNAFRNA | Sequence lScript ].-’-‘«rraw ] Box ] Sphere ] 3D Label ]

Sequence Name ]newseq L] f* auto " protein " nucleic acid

Help

Faste fasta-formated zequence|z]

—Sequence

AAGCGOVGELGAGAGCGGAGAGCGAGCYTREN

Ok | Cancel Help

7.1.3 Extract a Sequence from a PDB File

Extract a Sequence from a PDB file
» Right click on amoleculein aloaded PDB filein the ICM
Workspace.

» Select Extract Sequence(s) and the sequence will be laoded into
the Sequences section of the ICM Workspace.

7.1.4 Read directly from a Sequence File

Toread a sequence from afile:

If you have a sequence file saved in FASTA format it can be read into
ICM by:

» File/Open

7.1.5 Save Sequence

Tosaveasequencein FASTA format:

* Right click on the sequence namein the ICM worksapce.

» Select the option Save As.

* Choose FASTA format from the Windows " Save as type:" drop down
menu option.

7.2 Sequence Secondary Structure

If a sequence has assigned secondary structure then colored lines will
appear under the sequence in the ICM Workspace. Regions underlined in
red = apha helix, green = beta sheet, blue = pi helix, magenta = 3/10
helix.

218 7.1.2 Cut and Paste a Sequence
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7.3 Bioinfo Menu

Availablein the following product(s): | CM Pr o

Note: Click Next (top right hand corner) to navigate through this
chapter. Headings are listed on the |eft hand side (web version) or
by clicking the Contents button on the | eft-hand-side of the help
window in the graphical user interface.

Bioinformatics Menu

Wiew | Biorfo Tool: Homology Chemisty  Docking
] % Residue Content... B §

Tight Predict S econdary Structure... MOviE

J ’, Sis Frame Translatior. . 01
e Set Sequence Type... —

| Align Two Sequences...
ction

des
desh

Sequence to Structure. .. i
Align Dna ws Pratein...

Multiple Sequence Alignment...
Link. to Structure...

Extract Sub-alignment Az [s...
Cut*ertical Alignment Block. ..
Reorder Sequences..

Eutract Unique Sequences...

Search And Align...

e B e R ARG
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7.3.1 Residue Content

To determinetheresidue content of a sequence.

 Bioinfo/Residue Content and a data entry box as shown below will
be displayed.

» Enter the sequence name. Seethe Load Sequence section for more
information on how to load a sequence into ICM using the Graphical
User Interface.

» A table and graph of residue frequencies will be displayed.

9 Residue Content
| 2phk_d ]|

Cancel I Help ‘

7.3.2 Predict Secondary Structure

To predict the secondary structur e of a sequence:

» Bioinfo/Predict Secondary Structure

» Enter the sequence name. Seethe Load Sequence section for more
information on how to load a sequence into ICM using the Graphical
User Interface.

» Anoptionis provided to ignore currently assigned secondary
structure.

To view the secondary structure prediction click on and expand the
sequence in the ICM workspace. Regions underlined in red = alpha helix,
green = beta sheet, blue = pi helix, magenta = 3/10 helix.
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7.3.3 Six Frame Translation

This options returns the translated DNA or RNA sequence (*-' for a Stop
codon, * X' for an ambiguous codon) using the standard genetic code.

* Readinto ICM aDNA segquence from afile (eg File/Open FASTA) or
use the File/New option and cut and paste a DNA sequence.

» Bioinfo/Six Frame Trandation

e Trandate all frames or use start codon.

7.3.4 Set Sequence Type

This option allows you to define whether a sequence that is read into
ICM isaprotein or nucleotide sequence.

* Readinto ICM asequence (eg File/New and cut and paste sequence
or File/Open FASTA)

» Bioinfo/Set Sequence Type

» Select the sequence name using the drop down button

220
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» Select sequence type protein or DNA.

7.3.5 Align Two Sequences

Please seethe Al i gnnment Chapt er.

7.3.6 Sequence to Structure alignment

Please seethe Al i gnnent Chapt er.

7.3.7 Multiple Sequence Alignment

Please seethe Al i gnment Chapt er.

7.3.8 Alighment Strength Profile

To view afully interactive alignment strength profile:

* Creat e analignment.
e Bioinfo/Alignment Strength Profile
¢ A fully interactive table and plot will be displayed.

® [ Select Bioinfo/Alignment Strength Profile ]
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The profile can be plotted onto the alignment:

» Open the alignment editor panel.
» Select the plot checkbox and choose either bars or line plot.
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7.3.9 Link to Structure

Tolink astructureto an alignment:

¢ Double click on the structure in the ICM workspace to select it.

222

7.3.8 Alignment Strength Profile




Bioinfo/Link to Structure

NOTE Links are described in more depth inthe Maki ng Li nks Secti on of
the manual.

7.3.10 Extract Sub-Alignment As Is

On occasion you may want to extract a sub alignment from a bigger
alignment. For example you wmay only wanto extract the alignment for the
seguences linked to a structure.

To extract a sub-alignment:

Aninitial nul ti pl e sequence al i gnnent must first be displayed in
the graphical user interface.

Bioinfo/Extract Sub-Alignment Asls

Enter the name of the algienment from which you wish to extract a
sub-alignment from.

Specify the sequence order numbers you wish to extract - enter
each number separated by a space.Y ou can see the sequence order
alignment number by selecting the order option in the alignment
view options panel. See image below below.

Click OK and the extracted sequence alignment will be displayed in
a separate alignment tab.

If you do not see the € Extract Sub-Alignment s Is 2l

alignment view option

panel - click here Hep Sequence order display option

by ‘coche b Frov panert alorment
Seqilah Y sig 1 Y sl )
i v 2| View optor

11-?”,]_2 3 17 GA Akornnen |8'D ﬂ PFQ I e W conseribus B onder
1p19 A 17 17 G  specily sequence order rmbers (1357 =l yeFQ ¥ sguncooliest [ inber
IWFC_ & 35 GA [ ok Cancel PFQ Commerk: [~ 1 2 r3
ITKI_A 4 13 GH Q = | TDO Toes UPGMA
2phk_a 15 GVSSVVRREIHKPTCRKEYAYKIIDVTGGGSFSAE Syric: walh work space
quﬁ_a 18 GVSSVVRRBIHEPTCKEYAVKIIDVTGGGSEFSAR e criy I undligned
TATE B A e 34 EVE S D DA T TR ST YR T T TR SO S TER T -

Sequence order

7.3.11 Cut Vertical Alignment Block

To cut avertical alignment block:

Aninitia al i gnnment must first be displayed in the graphical user
interface.

Bioinfo/Cut Vertical Alignment Block

Enter the alignment from which you wish to cut from.

Enter the region of the alignment you wish to cut (from: to:). The
easiest way to determine the region to cut is to display the ruler

in the alignment. Thisisan option in the alignemtn view panel -
see image below.

Click OK and the cut section will be displayed in a new alignment.

7.3.9 Link to Structure
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7.3.12 Reorder Sequences

Toreorder sequencesin an alignement

Aninitial nul ti pl e sequence al i gnnent must first be displayed in
the graphical user interface.

Bioinfo/Reorder Sequences

Enter the alignment name

Enter the new sequence order.Y ou can see the sequence order

alignment number by selecting the order option in the alignment

view options panel. See image below below.

If you do not see the €3 Reorder Sequences
alignment view option
panel - click here Heb Sequence order display option
kck on 'order” in Alignment Tool Panel
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gquence order

7.3.13 Extract Unique Sequences

To extract unique sequences from a group of sequences:
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Read into ICM the sequences you wish to make unique.

Select the sequences. A sequence can be selected by double
clicking (highlighted blue in ICM workspace) - arange of
seguences in the ICM Worskpace can be selected by holding down the
SHIFT button and double clicking. A non-contiguous selection can
be made by holding down the CTRL button and double clicking.
Right click on the sequence selection in the ICM Workspace and
select Group sequences

Bioinfo/Extract Unique Sequences

Enter the name of the sequence group.

Enter the number of residue mismatches necesary to determine that
a seguence is unique or not.

Select whether you want to keep the redundant sequences or delete
them from ICM.

7.3.11 Cut Vertical Alignment Block
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* keepiedunant sequences

7.3.14 Load Example Alighment

To seean example of an alignment select:

» Bioinfo/Load Example Alignment
7.4 BLAST Search

Availablein the following product(s): | CM Pr o
ToBLAST the NCBI sequence database (including PDB sequences):

* Gotothe Search tab
» Choose the drop down option for BLAST and follow the instructions
her e.

To BLAST search alocal BLAST formatted file:

ICM provides afast tool to search any Blast-formatted database with a
guery sequence and generate an alignment on the fly. For example you can
use this option to find template structures for homology modeling.

1. Select Bioinfo/Search and Align (or right click on a sequence)

2. Enter the sequence name you wish to search against the database
with.

3. Locate the blast-formatted database to search. Y ou can download
Blast formatted databases from here
ftp://ftp.ncbi.nih.gov/blast/db/ eg. pdbaa- PDB sequence
database.

4. Specify the speed parameter (0 is the slowest, but the most
detailed, 100 is the fastest search for nearly identical
seguences).

5. Enter the number of hitsyou would like to view

6. Enter anidentity threshold filter to narrow down the number of
hits.

7. Thetop hitswill be displayed in atable.

7.5 Sequence Editor
The sequence editor alows you to easily display and create sequence
sites. To open the editor:
* Read inaseguenceinto ICM.
» Right click on the sequence in the ICM workspace and choose
"Sequence Editor".
To toggle site display on and off and change view options:

7.3.13 Extract Unigque Segquences
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To save your changes or export an image:
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7.6 Sequence Alignments

Availablein the following product(s): | CM Pr o

7.6.1 Default Alignment

To make an alignment using the default parameters:

7.6 Sequence Alignments
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* Read in the sequences you wish to align.
» Select the sequences in the ICM workspace.
» Right click and choose "Align Sequences".

Alignment parameters (such as alignment method) can be changed using the
optionsinthe Bioinfomenu (eg. Al i gn Two Sequences andMul ti pl e
Sequences).

7.6.2 Align Two Sequences
Toalign two sequences:

¢ Read into ICM two or more sequences.
¢ Bioinfo/Align Two Sequences
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Select two seguences of the same type @S|

Sequencel = | Sequence? 11695 _a -]
alignrmentM anme | Ttms ﬂ
comp matriz ||:Iefault ﬂ
alignrmentalgorithrm |ZE|3,.’.-._ ﬂ
Gap Open |2.4 ﬂ
Gap Extension |EI.1 5 ﬂ
maxPenalizedG ap |SS il
Help
maxPenalizedGap iz ignored by the "ZEGA" method
lTl Cancel Help

» Enter the name of your first sequence in the’ Sequence 1' data
entry box.

 Enter the name of your second sequencein the’ Sequence 2’ data
entry box.

NOTE: Any sequences aready loaded into ICM can be seen by clicking
on the down arrow next to the ' Sequence 1 and 2’ data entry boxes.
This can save typing and trying to remember what you called your
sequence.

» Enter aunique alignment name in the ' alignmentName’ data entry
box.

» Select acomparison matrix from the list shown below by clicking
on the arrow next to the’ comp matrix’ data entry box.

comp matrix ||:|Efau|t bl

alignrmentalgorithnn gonnet

blosumd5
blogum&0
blogumE2

_ dna
Gap Extension hssp

Gap Open

ident

» Select the alignment algorithm you wish to use from the list shown
below by clicking on the arrow next to the ’ alignmentAlgorithm’
data aentry box.

alignmentalgorithm [zEGA |

Gap Open H-align

ZEGA - aZero End-gap Glaobal Alignment, that is a pairwise alignment
method based on the Needleman and Wunsch algorithm modified to use zero
gap end penalties. Thistype of alignment was first described by Michael
Waterman, who called it the "fit" alignment. The paper of Abagyan and
Batalov, 1997 describes the statistics of the structural significance of

7.6.2 Align Two Sequences 229



the alignment score and optimization of the alignment parameters for the
best recognition of structurally related proteins.

H-Align - alignment method used in the Align and Score functions and
find database command (as described in Batalov and Abagyan, 1999)

» Enter the values you wish to use for Gap Open, Gap Extension and
the maximum penalized gap penalty.

Gap Open The absolute gap penalty is calculated as a product of gapOpen
and the average diagonal element of the residue comparison table Y ou may
vary gapOpen between 1.8 and 2.8 to analyze dependence of your alignment
on this parameter. Lower pairwise similarity may require somewhat lower
gapOpen parameter. A value of 2.4 (gapExtension=0.15) was shown to be
optimal for structural similarity recognition with the Gonnet et. al.)

matrix, while avalue of 2.0 was optimal for the Blosum50) matrix (
Abagyan and Batalov, 1997).

Gap Extension The absolute gap penalty is calculated as a product of
gapExtension and the average diagonal element of the residue comparison
table.

maxPenalizedGap The maximum penalized gap which is used for Gap Open and
Extension

e Click OK and the alignment will be displayed in the alignment
editor window at the bottom of the graphical user interface.

* Remember to save the project or write the alignment if you wish to
keep the alignment for use at another time.
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v sequence offset
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—GEQHPIYWARYADWLFTTPLLLLDLALLUDADQGTILALUG————- ADGIMI ™ Show cluster ree
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[ Sync with workspace
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UASTF———- HULRHUTUULWSAYPUUULIGSEGAGIUPLHIETLLEHULDUS
IAASATTOKAEKEUTRMUI IMUIAFLICWL———-—————— PYAGUAFYIFTHQ ﬂ Color scheme | icrn-combo =

7.6.3 Sequence to Structure alignment

This option alows you to align a sequence to a template structure
seguence using secondary structure weighting.

* Read into ICM the sequence (M odel Seq) you wish to aign to the
template sequence.

* Read in the template (TemplateSeq) structure and ext r act t he

sequence from this structure

Bioinfo/Sequence to Structure Alignment

Enter the Model Seq and the TemplateSeq name

Enter the name you wish to call the alignment.

Enter the weights you wish to use for apha and beta secondary

structure. The default values have been very well tested.

» Thisfunction uses a dynamic algorithm to find the alignment of
the locally structurally similar backbone conformations. The RMSD
is calculated within a certain residue window. The default is 3.

» Press OK and the alignement will be displayed in the bottom of the
gui interface.
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7.6.4 Align DNA vs Protein

To align DNA to protein:

Select the ' Bioinfo' menu.

Select the option Align DNA vs Protein

Follow the data entry instructions shownint he previ ous section
entitled "align two sequences" but enter one DNA sequence and one
DIOLC! ] SeAUCCE

. Select two sequences of different types

DnaSequence || ﬂ FroteinSequence ﬂ
alignmentM ame | framedli j
COMp Mmatris |default j
Gap Open |2.4 ﬂ
Gap Extension |EI.'| g ﬂ
maxPenalizedG ap |1 o il
Help
maxPenalizedGap iz ighared by the "ZEGA" method
Ok, | Cancel Help

7.6.5 Multiple Sequence Alignment

Toalign morethan 2 sequences:

Read into ICM the sequences you wish to align.

Select the sequences you wish to align in the ICM workspace. A
seguence can be selected by double clicking (highlighted bluein
ICM workspace) - arange of sequencesin the |ICM Worskpace can be
selected by holding down the SHIFT button and double clicking. A
non-contiguous selection can be made by holding down the CTRL
button and double clicking.

Bioinfo/Multiple Sequence Alignment

Enter the name of the sequence group. If you selected the
sequences as described above then the name of the group is
selection. Other named groups of sequences can be made by right
clicking on the sequence selection.

Select the comparison matrix you would like to use.

Enter Gap open and extension values.

Gap Open The absolute gap penalty is calculated as a product of gapOpen
and the average diagonal element of the residue comparison table Y ou may
vary gapOpen between 1.8 and 2.8 to analyze dependence of your alignment
on this parameter. Lower pairwise similarity may require somewhat lower
gapOpen parameter. A value of 2.4 (gapExtension=0.15) was shown to be
optimal for structural similarity recognition with the Gonnet et. al.)

matrix, while avalue of 2.0 was optimal for the Blosum50) matrix (
Abagyan and Batalov, 1997).

Gap Extension The absolute gap penalty is calculated as a product of
gapExtension and the average diagonal element of the residue comparison

table.

7.6.4 Align DNA vs Protein
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7.6.6 Drag and Drop

0 Multiple Sequence Alignment

Help

?X

First, you need to select sequences in the
‘whorkzpace menu and right-Click to form a group

Sequence Group | selectior] |
comp matrix | default |
Gap Open |2.4 |
Gap Extension |05 |
lTl Cero?] ‘ Help ‘

An easy way to add another sequence to an alignment is to drag and drop
aloaded sequence from the ICM workspace panel to the alignment window.
The sequence automatically becomes part of the alignment.

Click here

Drag to here
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" ]
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7.7 Alignment Editor

Availablein the following product(s): | CM Pr o

The default position for the alignment editor is at the bottom of the

graphical user interface. If you have made an alignment and you cannot

see the alignment you can select Window/Alignments ( See W ndow Menu
section of this manual )anditwill bedisplayed.
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ICM has an easy to use editor for pairwise and multiple alignments. ICM
alignment editor isrobust and always protects the integrity of your
alignment by protecting you from making unintended changes in the
alignment.

NOTE: To increase or decrease the size of the font in the Alignment
Editor pressthe CTRL key and the’+" or ’-" keys.
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7.7.1 Edit an Alignment

To edit an alignment one only needs four types of operations:

» select ablock with one or several sequences to be moved (press
Ctrl to add blocks). Important: since you can only move the
selection to the gapped space, the moving front of the selection
must be next to the gaps.

 (optional) create space on both sides around a vertical section of
the alignment

 usethe keyboard arrows to move the selected block with respect to
the other sequences

* sgueeze out the excessive gaps (an item in the alignment popup

menu)
OPERATION KEYS
set avertical selection for ALL sequencesin ;
the alignment Double-Click
add white space by hitting the Space bar SpaceBar
remove white space Backspace
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Drag

select a sub-block for shifting L eft-M ouse-Button

shift the selected block next to a gapped

area Right and Left Arrows

7.7.2 Save Alignment Image

Tosaveyour alignment asan imagefile:

* Right click on the alignment and select the Save/Export image
option.

» Choose the option save asimage.

 Enter the filename you wish to call your alignment. We advice you
to keep the .png file extensions.

» Select the style you desire from full-width, asis, or 60.

e Select the resolution for the image. We recomend 3.0.

» Select the browse button if you wish to save the picturein a
directory other than the one you are running ICM in. If you decide
to change directories you will have to reenter the desired file
name and click ok. The path of the file will then be entered in
the save options data entry box.

* Click OK.

To saveyour alignment to the clipboard:
* Right click on the alignment and select the Save/Export image

option.
e Choose the Save to clipboard option.

7.7.3 Save Alignment

Tosavean alignment or tree:
* Right click on the alignment or tree and a menu will be displayed.
» Select the save as option.
* Inthewindows"Save as Type" dialog box you can chooseicb (ICM
format), ali or FASTA.

7.7.4 Print Alignment

Toprint an alignment or tree:

* Right click on the alignment or tree and a menu will be displayed.
» Select the print option.

7.7.5 Delete Alignmnet
To deletean alignment or tree:

* Right click on the alignment or tree and a menu will be displayed.
» Select the delete option.

7.7.6 Annotate Alighment

Toannotate an alignment:
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» Click and drag over the region of the alignment you wish to
annotate. The selected region will be highlighted in blue.
* Right click on the blue selected region and select ' Annotate’ .
 Enter your comment text and color of font.
» Unselect by clicking away from the selection.
To Edit an annotation:
¢ Right click on the annotation and choose Edit}
To Delete an annotation:

* Right click on the annotation and choose Delete}

7.7.7 Box, Shade, Change Font

Todraw a box, shade or change the font around a segment of the
alignment:
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Shade or Font.
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» Click and drag over the region of the alignment you wish to box
or shade. The selected region will be highlighted in blue.

* Right click on the blue selected region and select either font,
shade or box.

» Unselect by clicking away from the selection.

7.7.7.1 Undisplay box, font or shading

Toundisplay a box, font or shading:

» Click and drag over the boxed or shaded region of the alignment.
* Right click and choose the option "Clear Font/Color/Border".

7.7.8 Phylogenetic Trees

NOTE: Before constructing a phylogenetic tree you need to align the
sequences as described inthe al | gnment secti on

Toview atree
» Check the’Tree' option in the alignment editor.

The tree will be displayed in the editor as shown below:

6.8 0.6 0.4 0.2 8

IIIIIIIlllllllllllllﬁqlﬁ—a ——————————————————————————————————
Pk as8 e
4* | 10L6_A_4 THEFYENYEPKEILGRGUSSUURRCIHKPTCKEY
' 1TKI_A_4 ————YEKYMIAEDLGRGEFGIVHRCUETSSKKT!
| AIAN_ 23 IMEUPERYQNL SPUBSGAYGSUCAAFDTKTGLRL
, DI9 A _17 IWEUPERYONLSPUGSGAYGSUCAAFDTKTGLRL
i hwre_ 5 IWEUPERYONLSPUESEAYGSUCAAFDTKTGLRL

|
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Todisplay thetree alone without the alignment:

» Check the'tree only’ option in the alignment editor.

Tree functionality:

 thetree-section in the alignment isresizeable, just grab the

rightmost end of the top ruler and drag it

» branch swapping : the sequences can be reordered by swapping the

tree branches. Just do the following:

+ Right-click on atree-node to get a popup-menu

¢ swap the branches

» selecting a branch: double click on atree-node to select the

sequences belonging to it.

7.7.9 Coloring an Alignment.

How to color an alignment:

There are awide range of default coloring schemes.

* Click on the drop down arrow beside the "Color" data entry box and
anumber of color schemes will be displayed.
» Select the color scheme.

5 e shgrement s Moot 438 884D OV (€S s ok UM How to change the coloring of the
Ee [Ed  View Bioinfo Took Homclogy Chemistry  Dockimg  Wollarhanics ﬂli ll “ment
£ o alig . )
Lamvi_ & 7 ] 15 LA OAELS L 3T L LD Y L L ol L L CLERLE W i 2| e cplons
2phk_a 23 EILGREVSSVYRREIHKPECKEYA¥KIID g 5 comers [ oot
1qlé a 23 EILGRGVSSVVRREIHEFPICKEYAVELIID ¥ sequence offser [ order 77 hide body
iQLE A 4 20 EILBREVSSVURREIHKPICKEYAVRIID -é;: ’ : s
Zphk_a N -
1glé a [ 1. Click on the drop down arrow, }
- o8 oy

- [ Vi Tifararns Hettudetad grrodl

LCH Strergath {50

UfLrper =
iIAN 23 35 LL‘R—:——PFQ*I I[—*AKR TYRELRLLHHH
ipis_A 17 39 LSR----PFOSITHAKR-EYRELRLIKHM
IWFC _ 5 57 LSR--=--PFRSIIHAKR-TYRELRLIKHM e o ey Siuchre -
1TKI_A 4 37 VKG----TDQVLVK~~==~~ KEISILNIA e mconn
2phk_a 52 VTGGGSFSAEEVOELREARLKEVDILRKY Pl
1g9lé_a 52 VTGGGSFSAEEVQELREATLKEVDILREV Prafarences
10L6 A 4 49 VTGGGSFSAEEVQELREATLEEVDI e
2§hk_a_ ) = 2. Click here for color definitions
14l6_a and change color.

¥ Malfoal taminas ko Tt Sk gty strithre e

n.; 719 ML 2B AR mmr "

s LAUHLUY] DL UYL LY g

1IAN 23 63 K-BENVIGLLOVETPARSLEEFNDVYLUT o
1019 A 17 63 K-BENVIGLLOVFTPARSLEEFNDVYLYT
IWFC_ 5 Bl K-BENVIGLLDVFTPARSLEEFNDVYLYT
o o E i:] g Cl ﬁ E '&. 2 sun-ICH Oty !

NOTE: The colors are shaded from pale to bright where the brighter
color represents higher conservation at that point in a multiple

alignment.

Toview thealignment color key:

* Click the pencil icon next to the color scheme selection tools and

atable will be displayed.
To edit the alignment color key:

7.7.8 Phylogenetic Trees
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 Click the pencil icon next to the color scheme selection tools and
atable will be displayed.

» Click on the "Edit Cells by Double Click" button on the right hand
side of the table.

» Doubleclick on acolor panel in the table to change the color.

To color by strength of consensus:

To color your multiple alignment by the strength of consensus at each
point in an alignment:

* Choose the Color option "Consensus Strength"
» Click and drag on the consensus strength button shown below:

Shength(42%] @ —— F——

Consesnsus Click and drag for
strength is desired consensus
displayed here strength

7.7.10 Alignment View Options

The alignment view options are located on the right hand side of the
alignment editor.

Wiew optiohs

[ title [ conzenzus [ profile

v zequence offset [ ruler [~ order
Comment: [ 1 2 | g

W Tiee | UPGM& -]
v Sunc with work zpace

[~ Tree only [~ Unalighed

[~ Yiew Differences [~ Hornzontal scrol
Strength [BO%E]

I
-
1 1 1 1 1 1 1 1 1
Calor | consensus-strength s

To add or remove the alignment title:

» Check the title box in the view options.
Torename an alignment:
* Right click anywhere in the alignment or on the alignment tab and
amenu will be displayed.
» Select the’Rename’ option.

» Typethe new name for your alignment in the data entry box which
becomes activated in the ICM workspace (See below).

+-10LE_A_4  len=28G
4--{5 alignments (1 items

a s ] =]

Rename your alignment
here

Toadd or remove the alignment consensus display.
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» Check the box labeled ' consensus’ in the view options.

id-57 nSog-7 SO e T L2 PE P TR S S+ % T S 3 S

The alignment consensus line

If you have a large alignment it may be convenient to show the number of
each sequence

To number your alignment:
» Check the 'order’ box in the view options.

Id=867 n¥og=7
1qlé_a
2PHE_n_58
10L6_A_4
1TKI_f_ 4
1IAH__23
1019_a_17
1WFC_ 5

b= T Y O L B

\— Alignment order number
displayed here

Horizontal Scroll

To view the alignment in Horizontal scroll click on the "Horizontal
scroll" button in the View Options panel in the Alignment tool bar.

To view the sequence offset number for each of your sequencesin an
alignment:

» Check the’offset’ box in the view options.

..
1q16_a 106 TEK!
2PHK_A_58 6 TEK
10L6_A_4 113 TEK
1THI_A_4 91 TSAl
1IAN_ 23 183 coR-
1DI9_A_17 183 coK-
1WFC__ & 121 col-

Sequence offset number

Toview the sequenceruler:

* Check the'ruler’ box in the view options.

—————————————————— IWEUPERYUNLSPULSLEAYESULARL
—————————————————— Il'.'EUPIH?QHLSPUGSGH?GSUEHHF
LEMSQERPTFYROELHKETIWEUPERY(JHLSPUGSGAYGSUCAAF
] 10 0 a0 40

Alignment ruler

To view the sequence consensus.

* Check the consensus option in the view options.

7.7.10 Alignment View Options

. Z+ER.HL+

239



ENVIGLLDV
ENVIGLLDV
ENVIGLLDV

Toview secondary structure.

If one of the sequences of the alignment islinked to a structure then
you can display the secondary structure by:

» Check the "show secondary structure for" box.

The secondary structure will be displayed at the bottom of the
alignment. The color codeis: red cones = alpha helix, green arrows =
beta sheet, blue cones = pi helix, magenta cones = 3/10 helix.

SHLUL LM, . .-L.d%E. . K..
-FLUFDLHKKGELFDYL-TEKUT
-FLUFDLHKKGELFDYL-TEKUT
—-FLUFDLHMKKGELFDYL-TEKUT
-UMIFEFISGLDIFERINTSAFE
UYLUTHLH-GADLHNIUKCOK--
UYLUTHLH-GADLHNIUKCOK--
UYLUTHLH-GADLHNIUKCOK--
o

sheet helix

7.7.11 Alignment Gaps

To make an alignment clearer you may wish to HIDE gap regions.
Tohideall gap regions:

* Right click on the alignment and a menu as shown below will be
displayed.
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A

Colar 3
o . s
-NIARF  Alian FI
HHK-F Urnique subszet Tl
HHK -} Tl
HHK-}  Select Tl
Clone
%+ %DE -
SBQLDFX Delete HI
SCOLDF Renarne HI
SCOLDF R
AROLKF Hide gapz
ARHTD- Show gaps -
ARHTD- Remove gap columng B
ARHTD- -

Hide tool: panel

----- @ Searchin glignment ... Chil+F Ti

—————— Ti

______ & Frirt .. Chl+F Ti

—————— : TI
5

______ ave as Image i

KHNFak [ Savess .. Ti

KHHF ANUF TGRRPCAVDCCERACUCDSTRRT T1
» Select the "Hide gaps" option.

The gaps in your alignment will be hidden according to the preference
made in the alignment tools panel shown below. Click on the drop down
arrow in the "Hidden block format" data entry box.

Two parameters can be specified directly from the Tools Panel in the
alignment window:

1. the"H dden Bl ock Format can usethefollowing specia symbols:
¢ %Il number of hidden chars
+ %L length of the hidden block
¢ %f hidden from
¢ %t hidden to
eg." % .. % "or" % "
2. the"Hi dden bl ock w dth" which definesthetotal length of the
hidden section.

Hidden block format  [Hlean1 -

<lengthx
length
clean [
clean 1

clzan 2

Hidden block length

Show secondary struch

Some predefined hidden block formats are shown here:

length: displaysthe length of the gap

S.. 27 #%D
SDT UKD
SDT UKD
SDT UKD
SIE  AMD
SSE 27 AUD
SSE 27 AUD
SSE 27 AUD

length: displaysthelength of thegapin.
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IS..< 27 >H%D
'SDT< UKD
'SDT<  DUKD
'SDT<  DUKD
SIE<  >AMD
SSE< 27 >AUD
SSE< 27 >AUD
SSE< 27 >AUD

clean0: displays no indication of a gap

1S. . #%D
'SDTUKD
'SDTUKD
'SDTUKD
SIEAMD
SSEAUD
SSEAUD
SSEAUD

cleanl: displays grey panel in the gap position.

IS.. #%DI
iSDT UKDI
'SDT UKDI
'SDT UKDI
SIE AMDI
SSE AUDI
SSE AUDI
SSE AUDI

clean2: displaysawider grey panel in the gap position

IS..  #%D
iISDT UKD
'SDT UKD
'SDT UKD
SIE  AHMD
SSE  AUD
SSE  AUD
SSE  AUD

NOTE: The width of the hidden panel can be changed as shown below.
Hidden block length |3 3:

Enter length of hidden block here

If you have hidden all the gapsindividual gaps (or blocks) can be
displayed by:

* Right clicking on the gap and select " Show hidden block™" option.

5.,
'SDT
'SDT
'SDT
SIE
SSE
SSE
5SE

HEDLH#.+H#HLUK. . _KRI

To show all gaps:

» Right click on the alignment away from a gap region and a menu
will be displayed.
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» Select the "Show gaps option.
7.7.12 Searching an Alignment

If you have alarge alignment and you wish to find a specific group of
amino acids within that residue the you can use the Alignment search
tool.

* Right click on the alignment away from any hidden gaps and a menu
will be displayed.

» Select the "Search in alignment option” and a data entry box as
shown below will be displayed.

i, Find in alignment

|GVSEYR [~ Find Nest |
Select Al
Cancel

Type search sequence Previous search queries
here can be found here

NOTE: Another way of searching an alignment is to use the alignment
selection tools which are linked to the ICM workspace and 3D
graphical window. Thisis described in the section entitled Maki ng
Sel ections in Alignnments.

7.7.13 Making Alignment Selections

ICM has avery powerful alignment selection tool which enables sequences
and structures to be interlinked with the 3D graphical window, the
alignment window and the ICM workspace.

7.7.12 Searching an Alignment
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File Edit “iew Toolz Bicinfo Homology Docking MolMechanics Plot Windows Help
hDeaann B BoEs WL B EHD K

W analysiz W pdb search Y meshes Y movie
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: 88 Resol,10bj B fﬂg} l{“"‘*)\ 3 g

.1  STHEFYENYE PKEILGRGL
21 SUURRCIHKP TCKEYAUKI
41 DUTEGGSFSA EEVOELREF
61  LKE[TIGTAT
81
181 L SEKETRK
121 '
111 EMIKLTDFC

<

161 YCOLDPGEKL RSUCGTPSY
181 APEIIECSHMH DHHPGYGKE
281 DHWSTGUIMY TLLAGSPPF
221 HREQWLHLRHM IMSGHYQFC
241 HEWDDYSDTU KDLUSRFLL
261 (POKRYTAEE ALAHEFFQOC
281 | -
a g | = ||E |
Y ]
HI.L.D.#..... #...... HLU. LKW, . _-L.d%#. . ﬂ Yiew options
1q16_a a1 10LKDTYETHTF Febandy il .
10L6_A 4 82 IIQLKDTYETHTFF———-—- FLUFDLHKKGELFDYL-T [ tile v consen
2PHE_A_58 16 IIQLKDTYETHTFF-————- FLUFDLHKKGELFDYL-T V¥ sequence offset
1TEI A 4 68 ILHLHESFESHMEEL--—--- UHIFEFISGLDIFERINT || Conpent [ 1

Selection is displayed in the ICM workspace (blug) the alignment
window (blue) and the 3D graphics display (green cross),

To select a single column of an alignment:
» Doubleclick.

B..€ 27 >H.DLE
SDTL
SDT<L
SDT<
SIEL
SSEL 27 >AUpLLI
SSE< 27 >AUplLLI
SSE< 27 >AupLLl

One column selecLed by double
clicking

To select parts of an alignment:

» Click and drag over the region you wish to select.

244 7.7.13 Making Alignment Selections



B..4 27 >H.DLH#.+HLWY
SDT< HUKDLUSRF(RY
SDT< HUKDLUSRF(RY
SDT< HUKDLUSRF(RY
SIE<S HAMDFUDRL{RY
SSE< 27 >AUDLLEKHLUY
SSE< 27 >AUDLLEEMLU
SSE< 27 >AUDLLEKMLUY

Click and drag over to select

To select multiple discontinuous parts of an alignment:

¢ Click and drag whilst holding down the control key.

JH.DL#.+HLUZ . . _KRHTA. .ALAHH
(AR UUOPOERY TAEEALAHPI
ALOIRTN 131 uIOTNTHEY TREES]LAHPI
LA RIRY gl UL Y TAEEALAHPI

0
*AUVDLLERHLUR BT TAGOGINGL
*AVDLLERHLULDSDER I TAGUGIN:L !
*AVDLLEKEHLULDSDERI TAGIIN:E !

Click and drag whilst holding down the
control key.

To enablethe easy selection of all sequencesin an alignment:
» Check the box labeled "Select by mouse in all sequences”.

Selection

[v Select by mouse in all sequences

By Conzensusz | h

Sehct| Ikt | Hide

S..< 27 >H.DL#.+HLUZ,
SDT< HUKDLUSRFLUWLY
SDT< HUKDLUSRFLUWLY
SDT< HUKDLUSRFLUWL
SIEZ pAHDFUDRL LU
SSE< 27 >QUNIRES {UIRLL [
SSE< 27 >QUNIRNIAUIRLL [
SSE< 27 >lNINN iR

All sequences are selected
using the mouse

NOTE: All selections made in the alignment window are linked to the
3D graphics window and the ICM workspace if a structure isin the
alignment.

7.7.14 Select by Consensus

Thisisavery useful tool, for example, you may want to color the
consrved regions of your structure in the 3D display windowa different
color to the rest of the structure. Thistool alows you to select the
conserved regions in the sequence alignment. Once the selection has been
made it can be used for a number of different ICM operations such as

col oringanddi spl ayi ng secondary structure.

7.7.14 Sdect by Consensus
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A selection can be made based on the alignment consensus. The buttons
relating to this are in the alignment tool panel.

Shength(50%] @ —— F——

Selection

v Select by mouse in all sequences

By Conzensuz | -

Select | Inwert | Hide ‘

Before selecting by consensus you first need to define a consensus
strength:

 Click and drag on the bar labelled " Strength" and select your
desired percentage.

» Enter which elements of the consensus you wish to select separated
by comma. Refer to the language manual for definition of each
consensus symbol.

Selection

[T Select by mouse in all sequences

By Conzensuz | 4% 2

Select | Inwert |‘ Hide ‘

Enter which elements of the consensus
you wish to select seperated by a
comma.

* Click the Select button and your selection will be highlighted in
blue in the alignment windown and ICM workspace and as green
crossesin the 3D graphical display window.
Once the selection has been made it can be used for a number of
different ICM operationssuch ascol ori ng anddi spl ayi ng secondary
structure.
Toinvert a selection:
» Click on the invert button.
Tohideaselection.

» Click on the Hide button

NOTE: All selections made in the alignment window are linked to the
3D graphics window and the ICM workspace if astructure isin the
alignment.

7.7.15 Calculate Sequence Identitiy and
Similarity

To calculate the sequence identity and similarity between one sequence
and other sequences in an alignment:
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PIPIE ;-1 - PRPIL " DR . R DT Byomens % -
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1WFC__ 5 sglection or --CAAFDTETGLEV FGL I
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Zphk a IHEPTCKETBY [ .
1q16_a you wanta RECIHKPTCKEYAY | rewmsoscws :
10L6 A 4 global ERCIRKPTCKEYAV e ————
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lglé a . MR
08 BEoo csa= 12 pns. B=3025%)
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e Make an aignment.

 If you wish to calculate local sequence identity you need to

sel ect theregion of interest.

» Right click in white space in the alignment and choose the option

"Cal culate Sequence Similarity from Alignment"”.
» Choose the reference sequence from the dialog box.

« If you wish to calculate local sequence identity you need to

select the option "Add info on Selected Positions".

7.7.15 Calculate Sequence Identitiy and Smilarity
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A table of sequence similarity and identity will be displayed. A guide
to the columnsin the table:

Ref = name of reference sequence.
Seq = name of comparison seguence.
I dent = identity percentage

Sim = similarity percentage

order

IDSel = identiy percentage for selection
SimSel = similarity percentage for selection
p.. = residuesin selection.

7.7.16 Alighment Secondary Structure

If the one or more of the sequences contain secondary structure
annotation then you will see colored cylinders and arrows under the
alignment. Red Cylinder = alpha helix, green arrow = beta sheet, blue
cylinder = pi helix, magenta cylinder = 3/10 helix.
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Use the alignment tool panel to toggle the secondary structure display
on and off.
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7.8 Color Structure and Surface by
Alignment

To color your protein molecule by the color of the alignment e.g. color
by conservation.

Ext ract the sequence from the PDB structure.

Make the alignment.

Col or theaignment.

Propagate the alignment coloring to the 3D structure by clicking
and holding on the representation button (e.g. ribbon) in the
display tab. Select Color by Alignment.

REQG | Rk F
{ search \{ igedt \

Hal fall_

oo (] 6 gu Lt A

e eiiE 4] secondary structure
. /iﬂ«p f;;l Unlink Color from Alignment m.ﬂ"dﬂ"f structure segment I—_:-ﬁ
Link Color to Alignment residue
hain A assign sec. structure ::;::uie b
b han A
| Structyn  "beon object
<uman F  moothribbon b e
L Mhain A thick nibbon DCCUPAncy
ssphoryla wide smooth ribbon residue order w
sphoryl cylinders accessibility
' ::]— protein worm hydrophobicity
V DMNA worm polarity
MtoC L
Display Chain Breaks L] uver fickd
Display Chain Break Labels ¥

undisplay other representations
display complete residues
select

transparent

oo b b ok

To color asurface by the alignment conservation.
e Makeapl ain solid surface using the meshestab.

* Make a selection in the alignment by using the optionsin the
Alignment Editor panel and select by consensus.
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* Right click on the surface in the ICM workspace and choose Color
by Selection.
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7.8 Color Structure and Surface by Alignment
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8 Tutorials

Molecule Representation, Coloring, Labeling

and Annotation

Creating Fully Interactive Slides for
PowerPoint and the Web

Read Sequences and Align
Link Sequence to Structure
Alignment Annotation

PDB Search

Convert PDB to ICM Object
Superimpose Proteins

Structure Analysis

Calculate contacts

Display hydrogen bonds

Identify ligand binding pockets

PDB Preparation: Symmetry

PDB Preparation: Occupancy & B-Factors
PDB Preparation: Alternative Orientation
PDB Preparation: Biomolecule

Building an Homology Model

GPCR Modeling Example

Loop Modeling

Predicting the Effect of a Mutation on
Binding

Predicting the Effect of a Mutation on
Stability

Chemical Sketching using the Molecular
Editor

Chemical Search

Chemical Clustering

Working with Large Chemical Space
3D Pharmacophore Search

2D Pharmacophore Search

How to Create a Markush Structure
How to Enumerate a Markush Library

How to Decompose a library based on a
Markush Library

How to Enumerate alibrary by reaction
Detecting Activity Cliffs

APF Superposition, Score, Consensus,
Screening and Clustering.

Working with the ICM Interactive 3D Ligand

Editor

Dock Biotin to the Streptavidin Receptor

Re-Dock an Inhibitor to Ricin Crystal
Structure

8 Tutorials

HTML
HTML
HTML

HTML

HTML

HTML

HTML,
HTML,
HTML,
HTML
HTML
HTML
HTML

HTML

HTML
HTML

HTML

HTML

HTML
HTML

Ref erence Cui de |
W\ebi nar

Vi deo
Vi deo

Ref erence Qui de

Ref rence Cui de

Vi deo
Vi deo
Vi deo
Vi deo

Vi deo
Vi deo

Reference Guide.

Vi deo
Vi deo
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Covalent Docking HTML

Protein-Protein Docking using FFT Method HTML
Virtual Ligand Screening to Ricin Receptor HTML
Virtual Ligand Screening to Cyclooxygenase HTML
Docking a Markush Library HTML
Multiple Receptor Conformation Ensemble HTML
Docking Example

Explicit Group Docking HTML
2D FingerPrint QSAR Model HTML
2D 3D Pharmacophore QSAR Model HTML

8.1 Graphics Tutorials

Introduction

The following examples are focused on the structure of the kinase
catalytic domain. The catalytic domain is nestled between the N- and C-
terminal and has high sequence conservation between kinase families. The
adenine moiety of ATP interacts with the hinge region which links the N-
and C-terminals of the catalytic domain. The ATP sugar binding regionis
on the "floor" of the pocket where ribose makes a hydrogen bond with a
polar residue. A conserved lysine residue on the beta3 strand is part of

the "roof" of the pocket where the triphosphate group of ATP binds. A
flexible glycine-rich loop movesin and out of the pocket depending on
the ligand bound state of the PK and is regulated to some extent by the
movement in and out of the pocket by the AlphaC helix. A buried region
at the "back” of the pocket is protected by a "gatekeeper residue’

forming a variable hydrophobic cavity. The hydrophobic cavity along with
the DFG not i f region are of interest for drug design because it opens up
regions of the pocket which are not conserved and do not bind ATP.

To learn the basics of the graphical user interface we will annotate the
key structural regions of a protein kinase.
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8.1.1 Change Molecule Representation and Color

Thistutorial shows you how to:

¢ How to load a PDB structure into ICM.

« How to change the background color.

¢ How to display and undisplay a molecule.
* How to color ribbon representation.

Introduction
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Load a kinase structure from the PDB.

1. Click on the
, "Search” tab

&

3. Click on the search button
and a table of hits will be
displayed

sodr Wod e

2. Enter
search string
“2vze”

IsoDoooon: ¢ o§
ESCFERENTE {

4. PDB stucture is
automatically listed
in the ICM
Workspace and

displayed

Step 1: Click on the search tab to load and display the PDB structure
2vz6

Change the background color.

" _ﬁ' =) (7 | . e | T o ) al= ?
rrnzma Lawt FE: +"
Cpes 1. Right click g
" £y
E _ here °
8 :
b
H
=
Step 2: Change the background color by right clicking on the color
palette.
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Display the “a” subunit and ligand.,

Fh DR e Bonis Lok Moeoop Oy eong  Mielens  eedes 0

D@EEAe TR0 AR cf i mEBsELGA 2% TTEEE8L

A TR W U s i Ve L L
H & FeE e |
Srai e Farmi =

= it
-dyﬁh.

(| @) | el # | (i | [=]

2. Use these
buttons to

"% 1. Click in the
hoxes to display]
and undisplay

rotate molecule

GHLES DAMe-- peodd bt WDt B

Color ribbon by secondary structure
| segment.

Note: All
representation [~
buttons have
similar coloring
options

= il Bl aa ok |
e A gEEpL

B

=R
b riskeatotariylaeTEned®

s B4 v b T B
]! - s

o e 0| m a8 me——— T

BAMen= Godd P dod

B IS

Step 4: Usethe optionsin the "Display Tab" to color the ribbon.

8.1.1 Change Mol ecule Representation and Color
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T G e s ek Gy toany M e Color Beta 3 strand yellow.

DaEEAr TG0 ERclin mEBsEDi0%: TTEEE0L

e

512 13- Click on Yellow gy - sgicie | | 212 .
otrnzmn Farmd #p =+
- J TR 2. Click and drag 2
B A, to select Beta 3 &
stand (residues 37 2
i B to 43) B
1. Expand to i
see sequence 2
-]
here .
S [ |
{hee z
E:&“ ] B
IE::unzmwapw— e
I=
ﬂ - o i I :EJ_- - ELEE
Step 5: Select the beta 3 strand (residues 37:43) and color yellow.
8.1.2 Annotation
Thistutorial shows you how to add user defined annotation to a
particular region of a protein structure.
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5. Left click to
change level of

[ o= (TR i
i M 3 i e detail
Hals .

et

e

apond

[

gt ‘

gt Cllmeduin drperdirl priien ke 1]

2. Right click
and select
“Annotate
Selection”

1. Use the lasso
= 1| toselectthe
; helix

3. Enter
annotation

o KOS

Oof dodnd

S NS DA

Step 6: Select the region you wish to annotate and right click on the
selection for options.

8.1.3 Labels

Thistutorial is a continuation from the previous tutorialsin this
section and shows you how to:

How to select individual residue types.

How to propagate a selection from one atom to all.
How to use the residue label button.

How to make a spherical selection.

How to label aresidue selection.

8.1.3 Labels
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1, Click on
“Filter
Graphical
Selection”
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Display and Label Beta 3 to Alpha C 5alt

2.Click “by f ©
type” | 3

Bridge (1)

2, Check the
charged
residues (Asp,
Glu, Arg, and

GHEEE DAMESe DR RS

residues.

:‘:‘:“ml _
'-’Iﬁf-ﬂ 3 -
ol R
= 2. Click here
w1 displayall

charged

residues in wire

propagate
selection to all

atomsin
residue

to

et

Display and Label Beta 3 to Alpha C Salt

Bridge (2)

GHBES DAMELs  EEED P RDE S

Step 8: Propagate selection to all taomsto display all atoms of the

side chain.
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Ch gt makmati £ LT fn (b 7] {1 gt

q.fﬁ- mEBsyBEBA0%% T
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R e \

1. Undisplay all
xstick
representation:

for clarity

- 5. clck and
hold on the
residue label

coloring and

button for label

Display and Label Beta 3 to Alpha C Salt
Bridge (3)

TERELL

2. Use the zoo
in button to
locate alpha C
to beta 3 salt
bridge

3. Click on the
residue label
button

style options

@ e (N[0 = [G)al=])

4. Click on each
residue to label

MR T LT

Step 9: Locate the B3 to AlphaC salt bridge (K42- E60) and label using
residue label button. Note: Once you have selected the two residues you
can invert selection (click on invert selection button) and then

undisplay all the other charged residues.

Display and label the residues near the
.- ligand binding pocket (1).

P LR ves B bon Mo Oweny Coden Mofetawn  svdoes

LFHE Ae TR0 ER
e

E e e

4. Propagate
selection to all

— S | =

M T [EEEEH]
1. Undisplay wire and other
label annotations from

previous examples

atoms

Degdend P bele T

2. Right click on
the "a” subunit
ligand and choose

F s
3. Enter the
parametersas

‘e (W0j= Glalals)

A= neodl Bods

eHBSS

Step 10: Select neighboring residues to the ligand.

8.1.3 Labels
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Display and label the residues near the
ligand binding pocket (2).

s
residue labels

MDA oedd Pt dBDds

L R

Step 11: Display the residues and label them.
8.1.4 2D and 3D Labels

Thistutorial is a continuation from the previous tutorialsin this
section and shows you how to:

Create and display a 2D label.
Delete and move a 2D label.
Create and display a 3D label.
Delete and move a 3D label.
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m_ Createand display a 2D label.
LEEG A TRO AR A IN mEvERAO®S TTEIREEL

|| DE | =i

1. Select the
labels tab

2. Select the 2D|
label button

Calcium Calmodulin Depgige

EESTE
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e
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middle mouse
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ELETE
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Step 13: Right click on the 2D label to edit or deleteiit.

8.1.4 2D and 3D Labels
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Create and display a 3D label. A 3D
label will move with the object when
rotated or translated.
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Calcium Calmodulin De
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labels tab
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2. Select the 3D|
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Step 14: Create a 3D label using the options in the "labels" tab.
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1. A 3D label
object is
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Connect to 3DMesh will

enable you to move the

3D label. Press “escape”
button to disconnect
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Step 15: Right click on the 3D label to edit or deleteiit.
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8.2 Creating Fully Interactive Slides
for PowerPoint and the Web Tutorial

Introduction

A dlide enables you you to conveniently store alarge number of

different 3D visualization properties (e.g. color, viewpoint,

representation etc...) along with text and window layout. Act i vel CM
enables you to view and display ICM graphical sl i des and ani mat i ons
interactively inside Windows Microsoft PowerPoint and web browsers such
as Internet Exporler and Mozilla Firefox.

In this example we are going to look at the effect of an agonist binding

to the Beta-2-Adrenergic GPCR (B2AR) and prepare a molecular document. A
prepared ICM file containing three B2AR GPCRs superimposed can be
downloaded heref t p: / / ft p. nol sof t . com pub/ wor kshop/ (1. cut and paste
the address into aweb browser. 2. Right click on GPCR_dlides.icb and

choose "Save Link As". 3. Open the.icb in ICM File/Open). Thefile

contains pdb files 2RH1 (R inactive state), 3POG (R* active state, with
G-aphamimic), and 3SN6 (R*G G-protein signalling state). The agonist
ligand causes Helix 5 to shift inwards and Helix 6 to swing outwards.

This agonist binding poses were predicted using ICM ayear before the

crystal structures were solved, you can read about thisher e and a good
review of the structure and function of GPCRs her e.

Tutorial

In this tutorial we will build a series of slides and then annotate them
using HTML to create hyperlinksto the slides. The resulting molecular
document can be exported in movie format or in fully interactive 3D

files.
3 GRCR_Shdevich Mol wm 38-3 [HsrdrnasGRCH Shdetach [ (3 ﬂb,uc:'l)lall{ Make a SlidE b‘!‘ flifking on the camera butttll'l.
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mEra 1. Click on the camera |
. “’q |¢v @. button to make a slide. |
&5 @ ﬁi.rf' = * § 486 dtremns 1184 Res,7 Mol 3 Dby

Step 1. Download the example file here
ftp://ftp.nol soft. con pub/workshop/ (1. cut and paste the address into

8.2 Creating Fully Interactive Sides for PowerPoint and the Web Tutorial
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aweb browser. 2. Right click on GPCR_dlides.icb and choose "Save Link
As'. 3. Open the .icb in ICM File/Open). Make a slide by clicking on
the camera button at the bottom of the GUI.

5 GPCR.Shdenicl Mool om 383 mAmariGPC3, S5ams 2 16 2= 14 Thee slide will be stored in the ICM workspace.
LEE0 90 TGO AR FISH MO«BOEFE TEE381
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11| L~ 1Side1 | g
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N - amly (1R 27 .
=Sl . 3snb 0 e
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-
$
¥
2
-]
o
4]
&
;‘-I
#
a | = § @
oe EDzo@a s = = |iSe - Q] 565 Abom 184 87 Mok 084

Step 2: Thedideis stored in the ICM Workspace panel (left hand side
of the GUI). Y ou can make changes to the 3D display and return to the
display in the slide by clikcing on the slide in the ICM Workspace.
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) GRCR Shdesich Moliaft om 383 IMknd] Edlie the name of the slide and enter smooth and blend transitions.
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Step 3: Properies of the slide can be edited by right clicking on the
slide in the ICM workspace.

?M"'[ You can also save viewpoints to help make other slides in the same orientation.
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Step 4: Saving aviewpoint is useful if you are making many slides from
the same viewing position.

Tutorial
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s

@ “"““""“’_""‘“"’“ . '“f { Make another slide of the inward shift of Helix 5 when an agonist binds,
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Step 5: In this slide we show that Helix 5 makes an inward shift when

an agonist binds.
b “*‘“”""“‘""“mm{m%ea slide of the side chain changes of 1121 and F282.
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Step 6: In this slide we show that upon binding an agonist 11121
switches its rotameric state and Phe 282 moves.
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Step 7: In this slide we show that agonist binding causes Helix 6 to
swing out.
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Step 8: You can export the slidesasanovi e or you can browse through
them using the arrow buttons.
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® (FCRSesb Mebeh cm 343 [Ruend e Now annotate your slides and create hyperlinks using HTML.
@sno o 1&@ Ra:siam fEeaBBAGS TEfs258
1. File/New “"“[?"’“ o= =
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3. Click OK. o o ][ cews |
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Step 9: To build amolecular document you can annotate the slides using

HTML.

| Edit the HTML document.
IDeEe 9 TR0 ER:PIi LB ABaBRlEGeE T35 8

H | Eee el | R 08 | Phe | o xaea “ﬁ”@%ll
¢ 1 b

- 8 % : e

1. Right click and
choose Edit,

Fiesth i Tt Cedaf

& GoBsk

& Eda CirisE

Step 10 Edlt the document by rlght C|ICkI ng on the HTML panel and
choosing Edit.

270 Tutorial



5 GPCR S Motioh km 353 [t manGICR Shen i Dot L wigeeer) et

Eile  Tocds fda View Bwele Homology Chemity Oochmg  MolMechares  findows  Help
DEELs O 10 Ef i N FMO«EoAfes TEETEEER

o
M| 2 EE e =S | EEE IEi_.I“ M ]t

& =

T EE # 8 % ek £ SpewlOw
EEEE _ iaow ) Comment
Cunges | Cobowd | Fot | oL [ (e 7] Chackbon =

= = * ihide
Agpordsts thal bind to the Beta 2 Adrenenic receplon Cause &
conformaticnal Sheft in

== B em e St ek
D8 Eﬁ |ﬂ Q i &j:] 1[4 0ut5mmg ot i ’E]E 485 Aboens LS4 ResT Moll3 Obj

Step 11: Hyperlinks can be made to the slide. Other f unct i ons such as
adding check boxes, ICM scripts and external links are also available.

st MSW& the Molecular Document as an icb file. The fite can be

H’__‘:‘; :‘ ;: :"1; m ‘c .1 exported to a web browser or into Windows PowerPoint.
J Sl

" search A/ Bgedit |
1. FliEfSﬂUE‘AS,.. ‘ ,Eljﬁ-‘ l ,:}[a;: F -?;- ﬂ ¥

st et | | (@)

| GPCR Activation

:  Agomists that bind to the Beta 2

| Adrenergic receplor cause a

| conformational shift in Halix 6. Agonists

| interact with Ser203 and Ser207 on Helix _ _
| 5which causes the extracalldar saction of BF REEE 2 T ppgg
§  Hebix 5 1o shalt inwards. This resultsin g

| rolarner change of Be1219 and a

| movement of Phe262

LI EALEL, L

G e s

mwm it Bouments

Step 12 Savethe molecular documentmlcb format and view in ICM Pro
or ICM-Browser. Y ou can also export to aweb br owser or view the fully
interactive slidesin W ndows Power poi nt using aplugin called
Activel CM

Tutorial 271



8.3 Protein Structure Tutorials

Introduction

The positioning of the DFG motif in the activation loop of a protein
kinase has an effect on the size and properties of the ATP binding
pocket. Most kinase inhibitors target the kinase with the DFG inwards to
the ATP binding site. Type-ll inhibitors target the site where the DFG
motif isin the out position which opens up the pocket and provides
additional hydrophobic binding sites. Targeting DFG-out conformations
can improve inhibitor specificity and slower-off rates.

PDB lkeg
P08 lepk

Comparison of the crystal structures of Abl kinase with DFG-IN and
DFG-OUT (Left). Imatinib (Gleevec - right) binds to the DFG-OUT
conformation.

Tutorial

In this example we will look at two kinase structures and compare their
binding pockets. One of the structuresis bound to the Type-11 inhibitor
Imatinib (Gleevec) a drug used to treat Chronic Myelogenous L eukemia. We
will use ICM toolsto look at the side-chains that interact with the

inhibitor and compare the pocket with a DFG-in structure using

| CMPocket Fi nder . Please click on the links provided to learn more about
the methods used.

8.3.1 PDB Search
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i

e e L _| Read in two kinase structures liep and lopk.

'Bbﬂnﬂﬁ im0 'ilﬂﬂﬂd'ﬂ fi@ecBOlddes TEEFLIEE

daplsy \f Bght Idbd.-r mashes ) weere \[ Bgedt | -
[P eman *—41 1. Enter PDB code. }"

2. For clarity color each
object a different color
using the display tab.

4
e

uECE P Bo+E e

BT T L L EL
g
&=

vE]’t;i' {172 waler molecyules

GHRLL DAMHEHEN

W (270 waler moleciiss

0 @ MD)n [0)@]a]8] v w0

Step 1: Click onthe Sear ch Tab and choose "PDB Search” and oad the
PDBs structures liep and 1opk. Y ou can color each object a unique color
by clicking on the Display Tab and clicking and holding on the ribbon
button and selecting Color by>Object.

8.3.2 Convert PDB to ICM Object
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|9 topk Moo cn 383 PlenPrjct 12 oyt Convert each object from PDB to ICM object.
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Step 2: Convert each PDB fileinto an ICM object.

8.3.3 Protein Superposition

chibide bl el [ Superimpose the kinase structures.

Fde Tools Edit View Beoindfn Homology C{hemistry Doching Bdc A
DERO O TR0 KArRFiFe oD TEt#288
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Tem~ g 1. Double click to p:;m o‘r::
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U and click.

GH%LE RBAMEA- 2edD b BokE O

M k3 '
Ge BEMe o8 as % 2333 Atoms 551 Res 2 Mol 2 Oy

Step 3: Super i npose the two kinase structures.
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8.3.4 Protein Structure Analysis

[ B topk Moksoticm 5.3 Mewrojct ) 2 bt | Locateand display the DFG motif in liep.
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Step 4: Search the "a" subunit of liep for the "DFG" motif. Y ou can
press Ctrl F and expand the sequence in the ICM workspace. Display the
DFG region in xstick.
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‘9 b b e Tl I Locate and display the DFG motif in lopk.
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Step 5: Search the "a" subunit of 1opk for the "DFG" motif. Y ou can
press Ctrl F and expand the sequence in the ICM workspace. Display the
DFG region in xstick.

6' e Observethat liep has DFG out and 1opk has DFG in.
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Step 6: Observe the DFG location in both structures.
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8.3.5 Contact Areas
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Step 7: Use Tools/Analysis/Contact Areas to display the contacts with

the Gleevec ligand.
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8.3.5 Contact Areas
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Step 8: Tag the residues surrounding the ligand. Repeat Steps 7 and 8
for the 1opk structure and ligand.

8.3.6 Hydrogen Bond
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Step 9: Comparethe hydr ogen bond interaction of the Type | and Type |l
inhibitors with the hinge region (liep - residues 317:322) of the
kinase.

8.3.7 Pocket Identification
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Step 11: Usel CMPocket Fi nder to compare the pockets of DFG-IN and
DFG-OUT. Run ICMPocketFinder for each structure - rename the pocket so
as not to overwrite it.

8.3.8 Protein Preparation and Crystallographic
Analysis Tutorial

8.3.9 PDB Preparation - Symmetry

Background When inspecting a ligand binding pocket it isimportant to
check that the true pocket is formed by chains which are not explicitely
present in a PDB entry. Thereforeit is necesary to use Tools/X
Ray/Crystallographic Neighbor to find all molecules/subunits or chains
involved in the interaction with the ligand. Molecular objects and 3D
density maps may contain information about crystallographic symmetry. It
consists of the following parameters:

1. Crystallographic group eg. P2121 that determine N (depends on a
group) transformations for the atoms in the asymetric unit.
2. Crystdlographic cell parameters A, B, C, Alpha, Beta and Gamma

To generate the coordinates within one cell one needsto apply N
transformations and then to generate neigboring cells the content of one
cell needs to be tranglated in space according to the cell position.

Example As an example let uslook at Cycloldextrin glycosyltransferase
(PDB Code: 1CDG). The problem with docking to this receptor isthat the
true pocket is formed by chains which are not explicitly present in the
PDB entry. Site mb1 includes serine 382. This cannot be predicted just

by looking at the structure. Therefore we need to identify symmetry
related molecules to this protein.

» Usethe PDB search tab to load the crystal structure 1cdg.
* Inspect the ligand binding pocket of maltose (mal)
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» Toidentify if there are any other chainsinvolved in the
interaction with the ligand select the whole structure in the ICM
Workspace.

File Edit View EBioinfo | Tool: Homology Chemistry Docking Moldechanics Wind

NESEE 9 '

Cruztallographic Meighbar... Select:
izplay light labe 30 Predict 3 Crustallographic Cel ToolsiC I"_',‘Stﬂ"ﬂ!
ﬂ //. ﬂ x" Analysis » BiotMolecule Generator Neighbor
= Superimpose b Get Electron Density Map...
_ Table bap'z Original Cell...
o5 1 non-ICM Obj S
: - — = Cantaur Electron Denzity...
=8 & lobjiects (1 itermn)
i Corveert Xray Density to Grid...
Double click here to select "
the structure 7
» Tools/Crystallographic Neighbor
» Select a7A radius
» Check "create symmetry related molecules’ and "display symmetry
neighbors".
* Ingpect the neighbors surrounding maltose(mal). Each symmetry
related subunit can be colored by object by clicking and holding
the representation button in the display tab and selecting
color-by.
site mb [ includes residue ser 382 for symmetry relsfed molecwle. sie mb3 includes the following residucs for symmet
¥ & M
#yiﬁ;r:?i* "Symmetry related subunit

8.3.10 PDB Preparation - Occupancy and B-Factors

Background When preparing a PDB for analysis (eg docking or modeling) it
isimportant to check the reported occupancies and b-factors. The

occupancy is afraction of atimic density at a given center. If there

are two egally occupied conformers both will have an occupancy of 0.5 -

the normal valueis 1 range 0-1. The *{ B-Factor} isthe mean-square
displacement of atom from its position in the model - the normal range
is5-50.

One way of visualizing the occupancy and b-factor is by coloring the

structure by these values. Y ou can do this by clicking and holding on a
representation button in the display panel and selecting Color-by.
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Asan examplelet uslook at the crystal structure 1ATP

» Typeinthe PDB search tab latp and the structure will be
displayed in the graphical display.

» Usethe |ICM workspace to undisplay everything except for the "e"
subunit. Y ou can do this by clicking in the blue boxes in the ICM
Workspace.

» Display the"€e" subunit in wire representation using the wire
button in the display tab.

* Click and hold on the wire button and select Color-by B-Factor.
Regions of high B-factor are colored red.

Click and hold
£ display IiI ht % labels % pdb zeaich % meshes % movie
o] 161 2] @] @l af | 2 T
— mmm L |
no sele @ color.. E
= n 0 by > atamm type
£ I wire residue sc
chemsitry residue
tree molecule
thik molecule_C
narmal object
thick bfactar

undizplay ather representations OCCUPEnCY

rezet to default accezzibilit

zelect hydrophobicity

polarity

zec. structure
ol

uzer atom field
uger res. field

alignmment

8.3.11 PDB Preparation - Residue Alternative
Orientation

For some very high resolution structures two alternative conformations
for aresidue are provided. Therefore for docking you need to decide to
use one conformation of the residue or generate seveal separate docking
models. This could be performed using multiple receptor conformation
docking.

Here is an example of alternative residue orientations found in a

crystal structure of a Fatty Acid Binding protein in complex with
stearic acid.

8.3.10 PDB Preparation - Occupancy and B-Factors

Residues with high
B-Factor are colored red
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I Load and display the PDB structure
— 1HMT.

= E | ) | e

g0 Wod;

2. Undisplay xstick,

residue and variable 3
labels ]
e B0 = alel=
. = N —— Display alternative conformations for
R e e e —— _' - — V32 and T36.
ol Whe e 3, Click the xstick button
Ta T T 2. Hold the control key
ar e .
N Ty . and click and drag over S CHCK Cattar Eution
',I B V32 and T36 1
' A

1. Click here to
expand residue level

8.3.12 Biomolecule Generator
Objective
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Here we will investigate the biological environment of avirus protein .
PDB code 1IDWN.

Background

It isvery useful to know how a protein from the PDB may look in a
biological environment. The PDB entries solved by X-ray crystallography
and deposited in the PDB contain the information about the crystal
structure rather than the biologically relevant structure. For example,

for aviral capsid only one instance of capsid protein complex will be
deposited and only one or two molecules of haemoglobin that isa
tetramer in solution maybe deposited. In some other cases the asymmetric
unit may contain more than one copy of a biologically monomeric protein.
ICM reads the biological unit information and has atool to generate a
biological unit. Not every PDB entry has the biological unit

information.

Instructions

* Read and load the PDB file IDWN

» Toolg/Xray/Biomolecule Generator

» Tick the makeAllBiomolecules box (Warning this may take afew
minutes to generate)

» The generated molecules will be listed in the ICM Workspace. Each

one can be selected and displayed. The biomolecule is shown below.

NOTE: Please note that right clicking on a PDB file in the ICM
Workspace will tell you whether there is any Biomolecule information
available for the structure. If thisinformation is not present then

the option will be greyed out.

Manual References (Web Links)

Bi onol ecul e Gener at or

8.3.12 Biomolecul e Generator
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8.4 Sequence and Alignment Tutorials

The key topicsin thistutorial are:

How to extract sequences from PDB structures.

How to load sequences from UniProt.

How to make an alignment.

How to link the alignment to 3D structure.

How to display sequence conservation in ligand binding pocket.
How to color 3D structure by alignment.

8.4.1 Display and Superimpose Protein Kinase
Structures in Preparation for the Tutorial

In preparation for the tutorial we will read in two PDB file and
superimpose them. We will then extract sequences from the PDB structures
and read in additional kinase sequences from Uniprot.

Load a kinase structure from the PDB.

- pedd WD+ B

1. Enter
search string
Hz hkll

S WL =] D] a8 e

Step 1: Load and display the kinase structure 2PHK.
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| Load another kinase structure from the
| PDB.

Sy e r——— S —

eor WOt

1. Enter
search string
o 1 IE”

SEENARIDS T LIAl § §

5=

L LT =] e 00 [ [ | e e e 5 10

Step 2: Load and display the kinase structure 1q16.

FH g koo 3, 7T [oewPonpeci % [ whiurn

——

FiN mEcEGi0%r TTHTE888

1 | @) | S [ | = -
+

T

3. Right click here .

b to change
a: | 1. Display the first RRERground oty 2. Clickonthe |
g to white ; :
! center button B

= subunit of each
‘21 structureand the

ligand. Click on 1
blue box to H
display/undisplay
(.
g
b \
fﬁ’a_ .___-u - &
T |
A b ?a -
L 2\ Y
O NN g

ol LT ] e

Step 3: Display both receptors.
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Color each kinase structure ribbon a

1.Clickand hold [T, s oo™
different color.

e | BEE) ) G | ) | o)« [

£ RN iR ANwBGA0%s ETTEEEE
EI_E'%@@' R

o

b -
\ i
’
-
Ha
- =
wiapiay mtere m_Laid ded -
SRALEPIAR BLSTY 8 L4TN .t
acm! laiér cool w tpkks
AW IAEE EomE B8N, AN
Bomd 1GLE CHMET ALY
Bomt LgLis golor Backgrowsd sl R KHLIEN
] Newd ILE Enlan Rewin_". /B St e
wemi 1o [ -
L= ] F!]h]# m‘il-l“j-—-—u ] O

GHBLE BAWE- me oD WO

Step 4: For clarity, color each receptor adifferent color.

_- LR s o onc Dumary furg e v Superimpose the kinase structures.
DERE AT TGO ARrP iR mEwEDA Q%R TTRRESLE
(e T W s et o e |

B2 el e |E S 0| ) | s | g
e o )
3. Press the
here button
2. Press the
cantrol key and
double click here
z . = ")
Y ] e ==
# i e et ool oy o 4
T T L T L im0, mm st i .54 1 o 4 e 1 0 A Oyt s G i

] amwriaies * .

O T O e

& DAese GeOD WL O

e Ty 2

Step 5: Superimpose both kinase structures using the superimpose button
in the display tab.
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_-. a e Rl ok G o P e e Extract sequences from PDB.
DERE AT TR0 KA AiN mOsEDA 0% TTTEEBL
e TR e L s\ et Bl W e |

Bl Zee e e 05w | w6 o0

Ry =

e ——
'Eh 7 NI 1.Right click and
IR 1o e select Extract
e e == Sequence
*Ea -

5‘:::* e r‘""-J 2. Right click and
A select Extract
Sequence

NB LS DA oD WO

3. Sequences are
listed here

Load additional kinase sequences
directly from UNIPROT

3 ;j 2. Enter uniprot code
ﬁ MK14_HUMAN

GHB LS DA mEO0 b WDd

these codes
KCC2A_HUMAN

PIM1_HUMAN
CHK2_HUMAN ;
Bl- L] E‘ iil:i.-- AN O :

Step 7: Load UniProt sequences.
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Align all the kinase seguences.

WUHQ nee TGO ARcdAIm
Lt et B e |

=T

[ ||’« FeE T | WE

newAli

This indicates that the
structureis linked to
the alignment called

#|@| =[]

pPeaphorylrse knase, chim & Ragrm

rL W
" T @ 1. Double click here to

5 wrasced

2. Right click and
select “Align

.

3. Aligned sequences
will be displayed here.

Wor il n M Banienisans il alaris
ar -

Sequences” g

FINLGT

PR ILBM SV LI AT TV 1 oo T SATT L

'|l-cl.'\+:llm;«i- PRI LIS TTERNTT Y LVT L.
G0N TN B N TR 5 - LA RSB0RL = BEANICHLLE - - NPMIVEL NPT SE LTS EFBLNTG

[—TFrr=T nLu]

e T L

-rra.l:luu:om'\‘lrnllu--mlrr:wl}u:-rrmn--:--uu -
-~ 050 TRATET TS FLL KL - - EEMY SR  T R e LT TLY TEL RSBV L

1 o bduﬂ:n:iuml ~WEWT RSPV TOaR L F B TRESL FVIVERL IR~
"""" A ﬂ LAVGRLL LA B TRL AR - - B LT ST 8 I .'I-HIN“IH'I'P-----lIH‘P:IlH'.’-mI“'\l’l.l.m'F!—'JMI'II.W!.’.’I!I’&[I.IIIIWJUl--- sacassBFITIORGEL
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PR ILL B o BOGLEL K- - EVCERY 1B AR YL

FEETLLTTTY pm‘n:w“‘“.;m'r\'nl.wﬂwrarlrrurnl
TV ERTTLL | BTNV

Aok

ot g

BA=~~ meddr Wotes B

L R

Step 8: Make a sequence alignment.

8.4.2 Linking Sequence Alignment to Structure

An aignment can be directly linked to the 3D structure. If the sequence
has been extracted from a displayed PDB file thiswill be done
automatically. If multiple alignments are loaded you can change the link
using Bioinfo/Link to Structure... menu. This examples continues from

the previous section.
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Color alignment by sequence

o R e\ e o e : conservation.
B0 e e M ) S| | | o

T B e bl ek i Cwesir  alry Mifems ke
DEHR O TSRO R0sFiN mEsrEDa0%% TTEE801

EaUlE WY

SRR LD DA

| 1.Click here to see
alignment tools panel.

Eufur aligmesss Cwwili' (4 s, 11T res wissl crssed

ji=n

e

o @ (S5 = [G[efa1s]
Step 9: Color the alignment by sequence conservation.

1. Click and hold " 6 ess TNTEENN Color structure ribbons by alignment.
| Dark green = fully conserved.

—

e

dHBEZS DAME-E meod WD

& IRI0 aiigmesst CRewRiNC (8 Begesinn, LT e wide) sesies
acmfiqles Rlor ribbom Bawia_ . AEE] aligmessc

] som'labis | =
£ i X

Step 10: Color the 3D structure by the alignment color.
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8.4.3 Identify Sequence Conservation in Ligand
Binding Pocket

In this example we show how to display sequence conservation in the
ligand binding pocket. This examples continues from the previous
section.

e Select residues surrounding ligand

i S — | binding pocket,
| ) | ] | By

D@ Ar TR0 ERcefin mEBsELGA 2% TTEEE2L

B4 FeE ks | WEE

s-+ 1,Right click on ATP ligand in the AN e
-',' first object _ o &

L

+ g #
[T e T T ra—
kLW A S
--augpnﬂ [
} Ml -
- U e
ol 1]
| aﬁmg&ﬁﬁ-‘:.“ Green
: LT rp— crosses=
[rg ST -
graphical
selection

e ol O ..’ .
Notice selection is returned to i i T
alignment — highlighted in blue s T
Ricsnenanl A N R N AT snafaas . | F— e
Taki_s TR P b aba e i .
s e e e il . b e bbb 1 1 | 1 Pt 1 s e
S 5t Brteee o aipeent: Tk R —
; mrea e i prsEsTTe m;ﬂ:--p&wnm... . 11 — 8% | ] .f. | - |
FERI L i Le LU IR VLLL| | B LLE- - VOV | re——
0w NE» [GEea]s] e

DAHESH Baod WD,

e e

Step 11 Select the residues surrounding the ligand binding pocket (or
any other selection of interes).
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) Propagate selection to all sequences in
mwiaﬂ“‘:““ e FAin mBskEG 0% TTTEEEL -
Ve M Ve W) alignment.

||¢ R @ENE | NEE O | ) | SR S | B

tinienin Farud =

- L3 s [}

TR T[N ERSRTL AT TR VIR TR
B EILATAS GERE §UB MA AT I30) &l igeaat

Acw! (qies me_graph = Atosi Basifetare| s Rak.ssupd8L (el dR,SLFE | A SABEL | G tBati m TeakossagbEd 0§
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1. Propagate to
all sequences

Notice selection is propagated to all
sequencesin the alignment—
highlighted in blue

e 112 e =i Bt

=

o & [W0)= [Eal=]s) sz

DAFHS== ol r WDt

auB s

Step 12: The 3D structure and alignemnt are linked, therefore the
selections made in 3D are transferred to the alignment. Only the
sequences that have 3D structures will be selected in the alignment,
therefore we need to propagate the selection to all sequencesin the
alignment.

T T T T T Display only the residues in the ligand
Dala Ar TRO 'I'I-i'll mEwEGHA %2 TTTRE8L L i
binding pocket,

[
D EN H0) Erﬁ?“ﬂ-‘?J B | ) | SRR | Ry

e #e
o 11Oy
8 e

Tk
1 - B E R
#l e 7

e P
tPam H miewdre e
Ll

mmmm char 5 by
el
- b _Z_.
wlla =eizhia [Eneed
¥ W =
b M
oy b
Pl lewed F
vmwa—rm-n than g

A==~ ol r Wod

FHB LS

3. Click again to
restoreview
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i

SACTLEN |

Residue conservation in the ligand binding pocket [

1. Invert
selection

=

o & WiE)= [@elals) i
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Step 13: Display only the residues in the pocket in the alignment.

P Ol B S i oty | bt i Display residues surrounding ligand

DEREac TR0 0 AN Mﬂﬁmﬁdﬂﬁa IGEESER]

i binding pocket in stick representation.
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Step 14: Display the residues surrounding the pocket in stick
representation.

DERE Ac TG0

2. Color by alignment

TR A NS WIRFART ERVIEH TR
g VERILYIS AELEE SLELEE e JUERL

Acw/ Lgaks cobor meick as graph mbigesst
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Step 15: Color stick by the alignment color.
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8.4.4 Alighment Annotation

Introduction

G-Protein Coupled Receptors (GPCRS) all share acommon structural core

of seven transmembrane helices but they lack significant sequence

homology between subfamilies. When modeling GPCRsiit isimportant to get
agood alignmnent between the query and template structure. Each helix

has one or more conserved motifs:

Helix1: GX ;N or GN

Helix 2 N(SH)LX ~ ;DX44 P
Helix3: SX  ,LX,IX,D(EH)RY
Helix 4. WX 4,9P

Helix5: FX  ,PX,Y

Helix 6: FX  ,CW(Y,PXP

Helix 7/Helix 8: LX

sNXN(D)PX ;Y X6 F

The ProSiteclass A dignment ht t p: / / prosi t e. expasy. or g/ PDOC00210 can
be used to guide GPCR alignments. For this example we have prepared an
icb file containing a subset of the class A GPCR sequences from ProSite.

We will use thisfile to annotate the key conserved motifs this will

help with the GPCR modeliing example. The file can be downloaded here:
ftp://ftp. mol soft.com pub/workshop/ (1. cut and paste the address into
aweb browser. 2. Right click on gpcr_ClassA and choose "Save Link As'.
3. Openthe.icbin ICM File/Open).

45 gper_aich Molsaf wm 38-3 [Hismdnamlaper sach | (1 obsect 1 slignment)

Mg ES 9
H,
a1y

id=1E nSeq=ils
SHTLR HUMAN 53 400
SETIE_HUMAN 66 359
Sevip_mosaam 55 336
ADALR HUMAN 43 346
ADRIE_HUMAM 62 348
DRDZ_HUMAN_51_428
DRDZ HimMAH 46 333
ADRB] _HUH..'-!.N_T 5_3-.] 7
ADREZ HUMAN 30 32¢
ADRBE2 HUMAN 34 346
DREL_HIB4AMH 40 331
ARAR HUMAM 286 288
ARZAR HUMAN 23 238

=}

xRl _nomad 56303
CHCRZ HiBEAN 63 314
CHCRI_HU8GAM 70 318
DE‘F.I:-_HU!!J:.H_E 5_31 8
PARL HUBdAM 113 371
FRRE_ HUMAN_32 344
FARZ HIBdAM 111 348
PAR4 HUMAN $4 340
Iplg &

SETIR HUBMAN 53 400

] 1. Windows/Alignment Main, m
chatilay ) bghit \/ bels A/ mesras A ssarch \f bgedt | e

A8 ol i ae) > e 850 %) |I[_'ﬂ.! main window - choose

LEEE. .39 ..
—————————————————————————— GEATVVARIALER
i ——--BHAFVIATVIRTR
= SHAPYLTTILLTR
----GHILVILAVACHR
weee e = GHILV I LAVACKR
"""""""""""""" GHVLVCMAYIRER
o ns s GHGLYCMAVLAER
——————————————————————————— GHVLYIVRAIARTR
--------------------------- GHVLVITAIARFE
~~~~~~~~~~~~~~~~~~~~~~~~~~~ GHLLYIVAIRWTE
--------------------------- GHTLVCARTIRFR
- o = GEYIN THRVEYRG
--------------------------- GHVLVCMATWLNS

wessesGHTTLIRIPCIVE

== GHVLVHMPGITRYT
«e LM IMAIVVEILEM
——————————————————————————— SHGHMALWYFLERT
--------------------------- ASKVTLMMLEFRT
——————————————————————————— ANGLALWYLATOR

23 I[VTOURDEVWVVEHGIVMALIVIAIVFGHVLYITAIREFE

....... £4%..%2. . DE08... 88 ...........H.
sr-gareanyLIcsiivritavavivr- punarygvianiiy

GoB B0 o s e e %

4 @ e theclass AGPCR alignment. To

~

fiead in the icb file containing
make the alignment panel the

Window --> Alignment Main.

i fof h:lﬂﬂbﬂ“.\

1 bded 1 Oky

Step 1: Read in the class A GPCR alignment (gpcr_ClassA.icb - see link
above). Make the alignment the main window (Windows/Alignment Main).

8.4.4 Alignment Annotation
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§ gpopich Mol i 305 Bilicxdmacigpe “{ Display the secondary structure of PDB 3p0G in the alignment, )

B@Enﬂcb"'iai} !l FIFH fExBRa09% TERFL2EL
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BCHE | BB S | e | ek i | @le]
WAL 5 B | M Graphics &%
T Commart: — . fe
id=1E nSeq=2% i ek s =
SHT1R mUMAN 53 400 1 . - 1
SHTIE HIMAM 66 389 1 1. Click here to L] Unfigrned €
SErin moMaN 55 356 1 tool T e )
ADRLR_HUMAN_43_326 1 DPEn tooIs panel. ) J b
ADALE _HUMAN 62 348 1 T
DRDZ_MBGAN_51_32% 1 mmmmmmme- : o
DRD3_HUMAN 4% 333 d emcsscecscscme Sedection a8
J“.Diﬂ-l _HUBGAN 75 3':".’ ] =esssooos 1 1
ADRBI_¥OGW_50_326 1 =------es SR v
ADRB3 HUBMAN 54 346 1 ~=mw—eeee 1 Hubiiche Selection -
DRDL_Fmas_40_331 1 By Cemaros = - £
nm_umma_zs_zn 1 [ Sedect ][ Frriart ]{ Hadie J E
ARZRR MUBMAM 23 338 1 T
GRER BtMAN 57 _322 1 Prefereres ;t
COR1_HUBGAN 51 301 1 3 I
CoRiD HUMAW S8 316 1 mx“"“ﬁ:’ : &
cxcRl mUsaM 56 305 1 e - 1
CHORZ_BUMAM_ 65 314 1 Hiden block format  deans - F
cHeR3 n:mnu ) i 2 cr k h kit ke, il ¥ &l II
OPRD HW 65 " i Efe‘!‘ﬂ
saRt HW::H N Shoy seosrdary struchare for #
it My s &
PABA_HUMAN_ 94 secondary Shor e Dol for 8
3plg, a structure, 7 i
iplg_a 5 o
By By »
=000 110
Step 2: The sequence of the beta 2 adrenoceptor is appended to the
alignment. This allows us to display the secondary structure of the
protein in the alignment.
[ . . .
Secondary structure is displayed colored cylinders and arrows under the alignment. Red
Cylinder = alpha helix, green arrow = beta sheet, blue cylinder = pi helix, magenta cylinder =
3/10 helix.
b o
L | o s B - e o e | G0 eI D B | AR T A 11;!,&:“@
{58 ot . 3D Graphie 8%
SHT1h MUMAM 33 400 14 AL~gNVARYLIGSINTTILMY IVLY L PMARL YT LME E i ﬁ
SHTLE MiRMAM 66363 14 EL-MTPANYLIASIRTPRLIVEILVM-PIaTHYTVTS :;
SHTID HUMAN 3% 3% 14 EL~-HTFANYLIGSIATTHLIVSILVH-FISIAYTITH &
RORIA HUMAN 43 336 14 HL~-HTTEYYIVELAVADLILTSTVL-PFIALFEVLG o
RLRLB HIMAN 62 348 14 HIL-RTPTHYFIVEAMARLILSFTVL-FFIRAALEVLY D
DRD2 _HUMAN 51 -IZG 14 AL-rrIRTLIVELAYANLLYATLYM- FRVVYLEYYE a
Dm}} HURERM 1'5 3B 14 AL~-OTTTHYLVVIIAVARLIVATLVHIFWTTYLEVTIGS
mn.!i m.mn ?5 AT 14 AL~ LN SR S AL THE L LYY - PREAT IV VHG o
M}RBE HUMAM Sl} 26 14 RL~QTVINYPITSIACARLVYMGLAVY-PPGRAAME ,u

.MJ:F.!J MR 51 346 14 AL~gTHINVEVTSRAAABLVHGLLY Y - FPAATLIALTG
DRDL_HUMAN dl:l 31 14 HLRIKVINFFVISIAVITLIVAVLVE=-PHEAVAEIAG
Ml!’c HUBERT 2'5 288 14 AL-PDATFCRIVESIAVADVAVGALVI-FLAILINIGPQTY
RRIAR, HUMAM 23 IBE 14 HL~gMvIEY BT VILAAAD I AVETLAL~ PPA.ETI-BTG!‘CM
GRFRE_HUBRMN 5"‘ 322 14 SH-BNVFNLFIZSIALGELLLLITCR-FYDASRYLADRH

CORL HUMAM 51 3']1 14 AL~EMMIZIYLLNLA T SHLLPLET L~ PFHI DY R LE DY
ccnm HM.H_'SE 310 14 RRARSPTIAELIEALABLLLALTLE---FAAAGALOGH

CHORY MUMAM SE 305 14 PE-RIVIDVLLNIRTABLS FALTTE -~ THAAS KV
LHORD HUMAN 65 _314 14 9PE-RATIDVYLIAERTABTIFRALPLE ~—~~THARAR VHGH
CHCRI_HUMAM 70_318 14 Ta~ Lssrmmﬂvﬂﬂmﬂns———Lﬁmv
LFRD H’U‘HAH_G(: JJ.EI H

N

e i n E l—]i—"-—-} B SIPL  L b LA i o

Step 3: Secondary structure is displayed as colored cylinders and
arrows under the alignment. Red Cylinder = alpha helix, green arrow =
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beta sheet, blue cylinder = pi helix, magenta cylinder = 3/10 helix.

In this example we will box and annotate all 7 of the transmembrane helices.

Teolr o e

CElo 90 TR0 EHBRr i fE fiDaEDa99% TEEFLER
Sy T\ b\ s e\ Tt

M]Z'@%ﬂi@]'l@]ﬁﬂ%l@’iﬂi o | B | e .El’_"iﬁﬂ | G [mle)
- [ Multi-line | i -

annotation i 0 L.Click and drag

SHT1R
SHTiB !Im 663869 i4 :t:r#mummvsmm IE
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ADALR IIW 43 328 1% HL-pSrrHYY IVHEAYARLLL T STVL~ PREA T FEYY
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miﬁ HIBAN 23 _288 14 LA THYFVVELRARRRIAVGVIAI-FRAITISTGICAR
GREPR_HUMAN 57 322 14 a-ERvPNLE TS sLRLGELLLL ITCA - PVDASH

and it will be
highiighted blue,
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CHORL . gE -
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SRR sk
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FARLE  Annotation B
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GHBLE DAME

Step 4: Box and annotate the seven transmembrane helices.

[ ) gper_nich Motsoft iom 38-3 [Hiemdymamigper_ sidh ™| {1 ebject 1 akgnment) I Display the sequence profile.

File  Took dit sw  Bigindo — T—— prking  hnbesh P —

Bhﬂnﬂ&"ﬂﬂi} ilﬂfifﬂ [@IEEIAI)‘& I BB B EE R
m
2| BB r[ 1. Open the tools panel and choose pruf'le.‘g]
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Step 5: A sequence profile helpsto get a better understanding of the
sequence conservation at each point.
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M To highlight the conserved motifs shade the residues that are 100% conserved.
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Step 6: To highlight the conserved sequence motifs - set the consensus
strength to 100% and then color the fully conserved residues. Y ou may
need to lower the conservation strength to pick out all the maotifs.
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Calculate sequence similarity and display residues at each paosition.
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Step 7: Calculate the sequence similarity and display the alignment

residue profile.
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6.5
object, 5. 3. 9
print, 5. 7
printing, 5. 7
stereo, 5. 6
predict local flexibility,
5.12
protein health, 4. 5. 11
toolsidentify ligand

binding pocket, 4. 5. 14

oda, 4. 5. 13

4D docking, 3. 2. 2
ActivelCM, 2. 5. 1. 12
Atom Single Style, 3. 7. 3
Beep, 3. 7. 11

BlastDB Directory, 3. 7. 2

alphas, 5. 8. 3

COLLADA,2.5.1.7
CPK,2.6.1
ChEMBL, 3. 2. 3

Clash Threshold, 3. 7. 10
DNA,3.3,7,7.3.3
Dock Directory, 3. 7. 2

Drug Bank, 3. 2. 8

Editor, 3. 7. 2
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0z,3.7.2
uue, 3. 7. 2

FTP.createFile, 3. 7. 11

keep File, 3. 7. 11
proxy, 3. 7. 11

Filter.zip, 3. 7. 2

Force Auto Bond Typing, 3. 7. 11
GIF, 2.5.1.15,5.16,5.16. 2
GRAPHIC.store Display, 3. 7. 3
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NtoC Rainbow, 3. 7. 4
alignment Rainbow, 3. 7. 4
atomL abel Shift, 3. 7. 7
ballStickRatio, 3. 7. 1
center Follows Clipping,
7.3
clash Style, 3. 7. 3
clashWidth, 3. 7. 3
clip Grabs, 3. 7. 3
Skin,3.7.3
Static, 3. 7. 3
discrete Rainbow, 3. 7. 4
displayLinelLabels, 3. 7. 7

displayMapBox, 3. 7. 3
distance Label Drag, 3. 7. 1
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dnaRibbonRatio, 3. 7. 9
dnaRibbonWidth, 3. 7. 9
dnaRibbonWorm, 3. 7. 9
dnaStickRadius, 3. 7. 9

dnaWwormRadius, 3. 7. 9
font Scale, 3. 7. 7
fontColor, 3. 7. 7

fontLineSpacing, 3. 7. 7
grobLineWidth, 3. 7. 3
hbond Ball Period, 3. 7. 1

Style, 3. 7. 1
hbondAngleSharpness, 3. 7. 1
hbondMinStrength, 3. 7. 1
hbondStyle, 3. 7. 1
hbondWidth, 3. 7. 1
hetatmZoom, 3. 7. 1
hydrogenDisplay, 3. 7. 1
light,3. 7. 3
lightPosition, 3. 7. 3
mapLineWidth, 3. 7. 3
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' oécupancyDispIay, 3.7.3

quality, 3. 7. 3
rainbow Bar Style, 3. 7. 4
resLabelDrag, 3. 7. 7
resize Keep Scale, 3. 7. 3
ribbonRatio, 3. 7. 9
ribbonWidth, 3. 7. 9
ribbonWorm, 3. 7. 9
rocking, 3. 7. 4

Range, 3. 7. 4

Speed, 3. 7. 4
selectionStyle, 3. 7. 3
siteLabel Drag, 3. 7. 7

Shift, 3. 7.7

siteArrow, 3. 7. 7

stereoMode, 3. 7. 3

stickRadius, 3. 7. 1
surfaceDotDensity, 3. 7. 3
surfaceDotSize, 3. 7. 3
surfaceProbeRadius, 3. 7. 3
transparency, 3. 7. 3
wireWidth, 3. 7. 1
wormRadius, 3. 7. 9
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Hydrogen Ratio, 3. 7. 1
Style, 3. 7.1
Vw Ratio, 3. 7. 1
GROB.arrowRadius, 3. 7. 3
atomSphereRadius, 3. 7. 3
contourSigmal ncrement,
3.7.3
relArrow Size, 3. 7. 3
relArrowHead, 3. 7. 3
GUl.auto Save, 3. 7. 4
Interval, 3. 7. 4
enumberation Memory Limit,
3.7.11
max Nof Recent Files,
3.7.11
Sequence Length, 3. 7. 4
splash Screen Delay, 3. 7. 11

Image, 3. 7. 11

table Row Mark Colors,
3.7. 4
workspace Folder Style,
3.7.4
workspaceTabStyle, 3. 7. 4
HTTP.proxy, 3. 7. 11
support Cookies, 3. 7. 11
user Agent, 3. 7. 11
How To Guide, 2
Html, 3. 2. 1.6
Http Read Style, 3. 7. 11
Hydrogen.bond, 3. 7. 5
ICM Browser How To, 2. 1
ProHow To, 2. 2
IMAGE.bondLength2D, 3. 7. 6
color,3. 7.6
compress, 3. 7. 6
gammaCorrection, 3. 7. 6
generateAlpha, 3. 7. 6
lineWidth, 3. 7. 6
linewidth2D, 3. 7. 6
orientation, 3. 7. 6
paper Size, 3. 7. 6

previewResolution, 3. 7. 6

previewer, 3. 7. 6
print, 3. 7. 6
printerDPI, 3. 7. 6
scale, 3. 7.6
stereoAngle, 3. 7. 6
stereoBase, 3. 7. 6
stereoText, 3. 7. 6
lcm Prompt, 3. 7. 10
Inx Directory, 3. 7. 2
JPEG, 2. 5.1.15
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Sigmaleve, 3. 7. 10

FileSizeMb, 3. 7. 11

Mnconf, 3. 7. 10
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quality, 3. 7. 4
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Directory, 3. 7. 2
Style, 3. 7.2

Search,2.5.2.12,2.5. 2. 13,
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convert,4. 1. 2
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color,3.7.8
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Style, 3. 7.7
SEQUENCE.site Colors, 3. 7. 4
SITE.label Style, 3. 7. 7

labelOffset, 3. 7. 7

wrap Comment, 3. 7. 7
SLIDE.ignore Background Color,
3.7.4

Fog,3.7.4
Select Min Grad, 3. 7. 10
Show Res Code In Selection,
3.7.7
SureChEMBL, 3. 2. 4
Swissprot, 2. 5. 1. 7

Dat, 3. 7.2
Temp Directory, 3. 7. 2
USER.email, 3. 7. 11
friends, 3. 7. 11
full Name, 3. 7. 11
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phone, 3. 7. 11
Var Label Style, 3. 7.7
Water Radius, 3. 7. 10
Wire Style, 3. 7. 1
XPDB Directory, 3. 7. 2
Xstick, 2. 6. 1
abright, 2. 6. 2
active, 6. 7
activelCM, 6. 8
activeicm, 6. 7,6. 12, 6. 14,
6.14.1
advanced, 6. 14
background images, 6. 15
control, 6. 13
activeicmjs, 6. 16
advanced alignment selection,
7.7.14
abum, 5. 15. 3
align, 3. 1. 11
dnaprotein, 7. 6. 4
multiple, 7. 6. 5
sequence structure, 7. 6. 3
two sequences, 7. 6. 2
DNA to protein, 7. 6. 4
sequence, 7. 6,7. 6. 6

two sequences, 7. 3. 5,7. 6. 2

alignment, 7. 3.8,7.6.1,7.7. 7,
7.7.7.1,7.7.16,7.8,8.4. 4
annotation tutorial, 8. 4. 4

box shadefont, 7. 7. 7

editing, 7. 7. 1
editor, 7. 7
example, 7. 3. 14
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gaps, 7. 7. 11
image, 7. 7. 2
profile, 8. 4. 4
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secondary, 8. 4. 4
structure, 7. 7. 16

selection, 7. 7. 13

strength, 7. 3. 8

profile, 7. 3. 8
view options, 7. 7. 10
color,7.7.9
comment, 7. 7. 6
consensus, 7. 7.9,7.7. 14
cut,7.3. 11
display title, 7. 7. 10
editor, 7. 7
extract, 7. 3. 10
gaps, 7. 7. 11
horizontal scroll, 7. 7. 10
image, 7. 7. 2
multiple, 7. 3. 7,7.6.5
options, 7. 7. 10
rename, 7. 7. 10
reorder, 7. 3. 12

ruler,7. 7. 10

save, 7.7.2

search, 7. 7. 12

selection, 7. 7. 13,7. 7. 14
seguence offset, 7. 7. 10

table, 7. 7. 10

view,7.7.10
alignments, 7. 6, 8. 4
alpha, 2. 6. 2
channdl, 3. 7.6
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anaglyph, 5. 6
analysis,2.5.4,7. 3
angle,4.5.7,4.5.8,5.8.5,5. 9,
5.12.6

animate, 2. 5. 3. 15,5.10. 7

view, 5. 10. 7
animation, 5. 10. 7. 1,5.10. 7. 2,
5.10.7.3,5.10.7.4
store, 5. 10. 7. 4
animations, 6
annotate, 3. 6. 21
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annotation, 7. 7. 6 trace, 5. 1. 10

antialias, 2. 5. 1. 15,2.5.3. 10 catrace, 5. 1. 10
lines, 2. 5. 3. 17 cache, 6. 14. 1
lines, 2. 5. 3. 17 galgulitsesequencesmﬂarlty,
apf,4.4.6 cavities, 4. 5
append.rows, 2. 5. 10. 7 closed, 4. 5. 4
aea, 4.5.3,4.5.13,8.3.5 cel,4.3.2
arrange, 3. 1. 13. 1 gen;eér, % 5.3.20,3.1.3,5.12,
window, 3. 1. 13. 1 change selection, 3. 6. 7
as2 graph,3. 6.5 speedrange, 5. 10. 7. 2
: changing font in alignment
assign, 5. 1.3 editor, 7. 7
atom, 3. 7.5 charge, 2. 5. 3.21,5.8.2
atomL abelStyle, 3. 7. 7 check box, 6. 6. 6
atomic property fields, 4. 4. 6 chemhl, 3.2.3,3.2.4
author,3.2.1. 3 chemical spreadshest, 3. 2. 3
play dide, 6. 13 substructure, 3. 2. 1. 1
avi, 5. 16,5. 16. 2 chi,5.8.5
b-factor, 4. 5. 12,8. 3. 10 clash,3.7.5,5.8. 14
backbone, 5. 1. 10 glegr dsls%ay and planes,
background, 5. 4. 2,5. 4. 3 selection, 3. 6. 6
images activeicm, 6. 15 planes, 2. 5. 3. 2
image, 5. 4. 3 click,3.1.12,5.11,5. 12
backup, 2. 5. 2. 11 clip,5.3.10,5.13. 1
ball,3.7.5 clipboard, 5. 15. 3
and stick, 2. 6. 1 clipping planes, 5
basicsdl, 3. 6. 2 tool, 5. 13
binding properties, 5. 3. 1 tools, 5. 13
bioinfo align multiple, 7. 3. 7 clong, 2.5.1.2
two sequences, 7. 3. 5 closg 5. 3.3,5.3. 4
links, 7. 3. 9 cavities, 4. 5. 14
menu, 2. 5. 4 collada, 2. 6. 6,5.3. 7
color,4.5.11,5. 3. 2,5. 3. 3,
secondary structure, 7. 3. 2 5.3.4,5.3.9.4,5.4,5. 4.1,
5.8.2,5.8.3,7.8
trandation, 7. 3. 3 alignment, 7. 7. 9
biological, 4. 3. 3 background, 5. 4. 2
biomolecule, 2. 5. 5, 4. 3. 3, by 5 4
8.3.8,8.3.12 ¥,
blast,3.2.5,7. 4 alignment, 7. 8
search, 3. 2. 5 surface by proximity, 5. 3. 3
bluelines, 7. 2 selection, 5. 3. 4
bond,4.2.3,4.2.3.1,4.2.3.2 background, 2. 5. 3. 18,5. 4. 2
bonding, 5. 1. 8 distance, 5. 8. 10
preferences, 3. 7. 1 mesh,5.3.9.3
?ox73771 7,5.8.15,7.7.7, coloring, 5. 4. 1
alignment, 8. 4. 4 combine, 2. 5. 10. 5
build, 5. 10. 7. 1 display style, 3. 7. 9
buttons, 6. 14 compatible, 2. 5. 1.10
bye, 2.5.1.19 compound, 3. 2. 1. 3
alpha, 5. 1. 10 compress, 3. 7. 6
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object,5.12. 7 distancelabe, 5. 9. 4

construct, 2. 5.1.1,5.10.7.1 label,5. 8.9
molecule, 2. 5. 1. 1 selection, 2. 5. 2. 1
object, 2. 5. 1.1 density, 4. 3.4,4.3.6,4.3.7
contact, 4. 5,4.5.3,8.3.5 depth, 5. 3. 12,5. 10. 5
surface, 5. 3. 2 didog, 6. 6.5
contacts, 5. 3. 3,5. 3. 4 diffuse, 2. 6. 2
contour, 4. 3.6,4.3.7 dihedral,4.5.8,5.8.5
convert,4.1. 2 angle, 4. 5
local database, 2. 5. 1. 6 directories preferences, 3. 7. 2
pdb, 8. 3. 2 directory, 3. 7
display, 3.1.4,3.1.13.1,3. 7,
local.database, 2. 5. 1. 6 4.2.3,4.2.3.1,4.2.3.2,5.8. 14,
5.14
converting pdb, 4. 1. 2 delete distances, 5. 9. 4
cpk,5.1.5 dihedral, 5. 9. 3
crash,2.5.2. 11 distancerestraints, 5. 8. 13
creat, 6. 6. 1 distance2, 5. 9. 1
new objects, 3. 3 angles, 5. 9
cross section, 5. 13 formal charge, 5. 1. 9
crystal, 4. 3. 2 gradient, 5. 8. 16
crystallographic analysis, 4. 3 hydrogen, 5. 1. 7
biomolecule, 4. 3. 3 mesh, 5. 3. 5
contour map, 4. 3. 6 meshes, 5. 3. 8
convert2grid, 4. 3. 7 planar angle, 5. 9. 2
4 grystallographlccell, tab, 2. 6. 1
load eds, 4. 3. 4 tether, 5. 8. 12
mapscell, 4. 3. 5 toggle, 5. 8. 15
symmetry packing,
431 CPK,5.1.5
tools, 8. 3. 8 angle, 5. 9. 2
cdl,2.5.5 dihedral.angle, 5. 9. 3
neigbor, 4. 3. 1 distace, 5. 8. 10
neighbors, 2. 5. 5 distance, 5. 8. 13,5.9. 1
crystallography, 4. 3. 4, 4. 3. 6, dlectrostatic, 2. 5. 3. 21
current.slide, 6. 13 energy.gradient, 5. 8. 16
custom, 5. 12 hydrogen, 5. 1. 7
label, 5. 8.8 polar,5. 1. 7
rotation, 5. 12. 2 macroshape, 5. 3. 6
vertical alignment block,
7 3 11 meshes, 5. 3. 5
and
databese, 7. 4 display.macroshape, 2. 6. 6
seach and alignment, 7. 4 origin, 5. 8. 11
default, 3. 1. 13 potential, 2. 5. 3. 21
delete,2.5.2.1,3.6.6,6.6.8 representations, 2. 6. 1
alignment, 7. 7. 5 restraints, 5. 8. 13
al,2.5.2.2 ribbon, 5. 1. 3
label, 5. 8. 9 skin, 5. 1. 4
alignment, 7. 7. 5 surface, 5. 1. 6,5.3.1
al,2.5.2.2 surfaces, 2. 6. 6
anglelabel, 5. 9. 4 tethers, 5. 8. 12
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xstick, 5. 1. 2 energy,4.5.11,5. 8. 14
distance, 4. 5,4. 5. 6,5. 8. 10,

5 9 exit,2. 5. 1. 19
label, 3. 7.7 export, 4. 5. 10
distances, 2. 6. 3 extrawindows, 5. 2
docking, 4. 5. 13 extract,3.4.2,7.1
document, 6. 6. 4,6. 6. 5 ich,2.5.1.5
navigation, 6. 6. 7 objecticb, 3. 4. 2
documents, 5. 15. 3 sub aignment, 7. 3. 10
envelope, 2. 6. 1 ich,2.5.1.5
surface, 3. 7. 5 fasta, 7. 1. 5
dotted line, 5. 1. 3 file,2.5.1.3
grag, 3“1 % %163. 7.7,5.8.3, dose 2. 5. 1. 13
and drop sequences, 7. 6. 6 compatible, 2. 5. 1. 10
residuelabel, 2. 5. 3. 16 export, 2. 5. 1. 12
draganddrop, 3. 1. 11 high quality image, 5. 15. 1
drop,3.1.11,6.6.4,7.6.6 load, 2. 5. 1.7
drug bank, 3. 2,3.2. 8 menu, 2. 5. 1
dsPocket, 3. 1. 8 password, 2. 5. 1. 11
easy rotate, 2. 5. 3. 12 preferences, 2. 5. 1. 16
edit,4.2.3. 1 quick image, 2. 5. 1. 14
alignment, 7. 7. 1 icb,3. 1. 10
ligand tools, 2. 5. 2. 17 recent,2. 5.1.17
menu, 2. 5. 2 bak,2.5.2.11
molecular document, 6. 6. 1 filter selection, 3. 6. 8
selection, 2. 5. 2. 5 flexibility, 4. 5. 12
dide, 6. 4.1 fog,2.5.3.5,5,5.10.1
: font,3.7,3.7.7,4.2.3.1,
editpdosearch, 2. 5. 2. 12 5.8.2,5.8.3,7.7.7,7.7.7. 1
eds 4.3.4,4.3.6,4.3.7 preferences, 3. 7. 7
electron, 4. 3. 4,4.3.6,4.3. 7 size, 7.7
denisty map, 4. 3. 5 formal charge, 5. 1. 9
densitry map.contour, 2. 5. 5 frame, 7. 3. 3
43 g2 07255 front, 5. 3. 10, 5. 13. 1
glectrosiaic potential, full scene antialias, 2. 5. 3. 10
surface, 5. 3 screen, 2. 5. 3. 8
electrostatics, 5. 3. 1 genera preferences, 3. 7. 5
elegant sketch, 5. 10. 4 generalselecttools, 3. 6. 1
embed browser, 6. 11 generator, 4. 3. 3
powerpoint03, 6. 8 getting started, 3
powerpoint07, 6. 9 glasses, 5. 6
powerpoint10, 6. 10 google, 2. 5. 1.7
activeicm, 6. 13 objects, 5. 3.7
script, 6. 13 3D,2.6.6,5.3.7
browser, 6. 7, 6. 11 graphical display tutorial, 8. 1
- 2D3D labels,
firefox, 6. 7,6. 11 8 1. 4
6 |1n1ternet.explorer, 6.7, annotation, 8. 1. 2
: color
microsoft, 6. 7 representation, 8. 1. 1
powerpoint, 6. 7, 6. 8, 6. 9, labels, 8. 1. 3
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controls, 5
effects, 5. 10

pandl, 5. 2

preferences, 3. 7. 3
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move, 5. 8. 4 example alignment, 7. 3. 14
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Sites, 5. 8. 6 protein structure, 4. 1. 1
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profile, 7. 3. 8
project,2. 5. 1. 5
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rename, 2. 5.1.9
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start move structure, 3. 1. 3
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representation, 3. 1. 6
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easy,2.5.3.12 residue, 3. 6. 13,3. 6. 18
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shing, 2.6.2,3.7.5
shineStyle, 3. 7. 3

show, 6. 3. 1

side by side stereo, 2. 5. 3. 6

sigmalLevel,4.3.6,4.3.7

sites, 4. 4. 6
size,4.2.3.1

sketch accents, 5. 10. 3

accents, 2. 5. 3. 14,5.10. 3

skin,2.6.1,5.1. 4

slab, 5. 3.10,5.13. 1
dice, 5. 13

dide 5. 10. 7. 4,6.2,6. 3. 1,

6.6.1
effects, 6. 5
movie, 5. 16. 1
file, 6. 2
navigation, 6. 3. 2
show, 6. 3
blend, 6. 5
edit, 6. 4. 1
effect, 6. 5
smooth, 6. 5
transition, 6. 5
dlides, 5. 16.1,6,6.1,6. 3
smooth, 5. 3. 9. 3

Index

solid, 5. 3. 9. 3

sort table, 2. 5. 10. 4

spec, 2. 6. 2

speed, 5. 10. 7. 2

squence.amino acid, 7. 3. 4

stereo, 3. 7. 6,5. 6
hardware, 2. 5. 3. 7

side-by-side, 2. 5. 3. 6
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selection, 3. 6. 9
navigation, 3. 6. 10

write, 3. 1. 14,3. 5
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images, 5. 15
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